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Introduction
Accurint for Law Enforcement Plus (Accurint LE PlusTM) provides the capability to powerfully query
multiple data sources and present accurate and thorough results in an interactive, user-friendly fashion.
Accurint LE Plus accesses databases built from public records, commercial data sets, and data provided by
various government agencies. This collection of data is combined into a massive dataset enabling queries on
many disparate databases in one step.

Accurint LE Plus™ Capabilities
Person Search
People at Work Search
Workplace Locator
Law Enforcement Location
Report
ID Verification
Passport Validation Report
People in the News
Batch Person Search
Advanced Person Search
Death Records Search
Deceased Person Batch
Email Search
Virtual Identity Search
Direct-to-Report
Power Search
Business Search
Businesses in the News
Dun & Bradstreet Search
Fictitious Business Names

Corporate Filings Search
Federal Employer ID
Numbers Search & Report
UCC Filings Search
Automated Valuation Models

FAA Aircraft Search
Advanced Motor Vehicles
Search
Property Search
Watercraft Search

Search for a person based on combinations of first name, middle name, last
name, SSN, age range, date of birth, address, city, state, zip.
Search for people based on possible business relationships and places of
employment.
Search for a subject’s possible workplaces.
Provides advanced information prior to responding to a location.
Verify identity data elements and produce a quiz consisting of questions that
only the correct individual should be able to answer properly.
The Passport Validation Report analyzes the composition of passport
information and validates whether it uses a valid number for that country.
Search for news articles based on a person.
Search for current “best” information on a limited list of subjects
Search for a person using advanced criteria such as previous city and state,
relatives’ names, and previous last name.
Search death records nationwide.
Search death records to determine if and when subjects passed away.
Search Email records (including reverse search)
Search for Virtual Identities
Provides a quick path to reports.
Search using people, businesses, and properties using Boolean logic.
Search for business based on combinations of company name, individual
names, TIN, address, city, state, zip, or telephone.
Search for news articles based on a business.
Search Dun & Bradstreet records
Search for "Doing Business As" name filings or assumed business name
filings from all 50 states and the District of Columbia. A report can be
ordered from the FBN search results for more information on the business.
Search for corporate filings based on combinations of company name,
officer names, address, city, state, zip.
Finds businesses using their FEIN registrations.
Search by company name or address to find UCC (Commercial Lien) filings.
Provides a composite report of residential property information, including
three valuation models, to provide the best estimate of the current market
value of the property of interest.
Search for aircraft registrations based on combinations of names, address,
or aircraft number.
Search for motor vehicle registrations based on combinations of first name,
middle name, last name, VIN, driver’s license number, tag number,
company name, SSN, address, city, state, county, zip.
Search by name, company, address, or parcel number for property tax
assessment and/or property deed records.
Search commercial and personal craft by name, company, address, hull ID,
or vessel name.
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Driver’s License Search

Driver’s License Wildcard
Search
Professional Licenses
Search
FAA Certifications Search
Hunting and Fishing
Licenses
Federal Firearms &
Explosives
Concealed Weapon Permit
DEA Controlled Substances
Search
Voter Registration Search
Phones Plus
Directory Assistance
Real-Time Phones
Batch Telephone Search

Federal Criminal Court
Search & Report
Federal Civil Court Search &
Report
Civil Court Records
Bankruptcy & Liens and
Judgments Search
Official Records Search

Search driver’s license registrations based on combinations of first name,
middle name, last name, driver’s license number, SSN, date of birth,
address, city, state, zip.
The DL Wildcard search window allows you to query combinations of
Driver’s License data. Wildcard Search accesses DL data to run matches
on partial license numbers
Search by name, social security number, address or professional license
number to find individuals that have or have had a professional license.
Search by name or address to find individuals that have or have had pilot,
mechanic, trainer, or other FAA certifications.
Search by name, address, or SSN to find individuals that have or have had
hunting or fishing licenses.
Search by name, address, or license number to find individuals or
businesses that have or have had ATF firearms and explosives licenses.
Search by name or address to find individuals that have or have had a
permit to carry a concealed weapon.
Search by name, address, or SSN to find individuals or businesses that
have or have had DEA controlled substances licenses.
Search for Voter Registration records
Search for phone numbers not found in traditional Directory Assistance
searches.
Search listed phone numbers based on combinations of first name, middle
initial, last name, phone number, address, city, state, zip.
Search for phone number records in additional sources beyond traditional
Directory Assistance and Phones Plus
The Batched Directory Assistance Analysis provides the ability to upload a
list of phone numbers into the system and get immediate information about
the name and address on record for each listing.
Find Federal Criminal Court Records
Find Federal Civil Court Records

Foreclosures Search
Jail Booking Search and
Report

Search by name or address to find civil court records.
Search for individuals or businesses that have filed for bankruptcy and/or
tax liens or judgments.
Search by name and location for miscellaneous official court filings and
other documents.
Search marriage and divorce records by name and location.
Search by name, social security number or address to find records in an
integrated database of public sexual offenders.
Search by name, social security number, date of birth, address, or radius,
including unregistered, historical, and associated addresses in addition to
registered addresses. (not available to all users)
Offers a nationwide tracking system on movement and other information
relating to registered and non-compliant sex offenders.
Search government lists provided by a number of organizations, including
the Office of Foreign Assets Control (OFAC), the United Nations Named
Terrorist lists and the US Bureau of Industry and Security Denied Entity and
Person list.
Search Criminal records based on combinations of first name, middle name,
last name, SSN, DOC#, address, city, state, and county.
Search foreclosure records by name, company, or address.
The Jail Booking Search and Report allows you to search for Jail Booking
records from thousands of sources.

National Motor Vehicle
Accidents

Search accident reports by name, company, address, accident number,
license ngumber, VIN, or tag number.

Marriages & Divorces Search
Sexual Offenders Search
Advanced Sexual Offender
Search
Advanced Sexual Offender
Solution
USA PATRIOT Act Search

Criminal Records Search
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Wildcard Search

Relavint PlusTM Link Analysis

Custom Comprehensive
Reports
Comprehensive Reports

Business Reports
Contact Card Report

Business Link Report

CLIA Certificate
NCPDP Search
American Board of Medical
Specialties Search
Provider Report Card
Provider Search
Provider Sanction Search
NPI Data Search
Healthcare Business Report
Healthcare Provider Report
Alerts and Notifications
Online Batch Services

Provides “wildcard” searching of motor vehicle data to generate matches on
partial license plate tags or VINs, as well as car makes, models, colors. For
example, you can run a query to find all red Fords within a State, which
have a ”D” as the second character in the tag.
Presents relationships between individuals, addresses, vehicles, and
corporations. Users expand links dynamically and develop a continuously
evolving network of interrelationships.
Creates a combined, customized, comprehensive report compiled from all
datasets for either a company or a person. See
Custom Comprehensive Reports and Comprehensive Reports on page 207.
Creates a comprehensive report compiled from all datasets for either a
company or a person. See
Custom Comprehensive Reports and Comprehensive Reports on page 207.
Creates a combined, customized, comprehensive report for a company,
including address, contact information, phone, and TIN.
Provides critical location information about key contacts associated with the
consumer, such as relatives, neighbors, and associates as well as a wide
array of phone numbers and other information.
This report links businesses to the subject based on how the subject’s
relatives and associates match up to the relatives and associates of the
business contacts.
Search for Clinical Laboratory Improvement Amendments (CLIA) records
Search National Council for Prescription Drug Programs, (NCPDP) records.
Find American Board of Medical Specialties records
A detailed comparison of input elements to our data sources.
Search for Health Care Providers.
Search for Health Care Provider Sanctions.
Search National Plan and Provider Enumeration System data.
Run a report on a Health Care Business.
Run a report on a Health Care Provider
Establish automatic alerts and receive notifications
Allows you to submit online batch order requests.
Online Batch Services helps you locate subjects, speed workflow, improve
productivity, and increase efficiency by processing multiple records at once.

Accurint for Law Enforcement Plus
User’s Guide | 11
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Additional features
Recent News and
Announcements
Coverage Areas
User Guide
Mapping

Google Maps
Photo Lineup

Dynamic Chain
Searching

Query History
Query List

Results and Reports
Favorites
Start Page
Public Safety Briefing
Room
LexisNexis® University:

School of Law
Enforcement
Feedback
Share your Success
Story

Provides information about new application releases and data now available in
the system. Also available in Announcements from the menu.
Lists the areas where data is reflected in each search. Available in Help menu of
the Accurint LE Plus™ application.
This User Guide is available in the Help menu of the Accurint LE Plus™
application.
Provides a zoomable map of the United States to display geo-spatial
relationships between data. Accurint server-based mapping is available to all
users of the Accurint LE Plus™ application. The application is also compatible
with Microsoft MapPoint 2002, which is not included with Accurint LE Plus and
must be purchased and installed separately to access this feature.
Provides access to Google Maps where you can display geo-spatial
relationships between data. Street View is available for additional insight.
Presents a set of 6 images as a photo line-up. Images can be loaded from local
disk or dragged & dropped from a Criminal Record. Images can be printed with
both indicative and non-indicative information.
Select individual or groups of records from the results of one search and use
them as input records for another query. This enables dynamic chains of
searches. Results are sent to another window using the right-click pop-up menu
or by drag and drop.
When enabled, records all queries run along with their results. Allows user to
organize queries, full or partial results, and other files into cases.
Lists queries run in current session and provides the capability to rerun them.
This is particularly useful for ongoing investigations as queries can be
resubmitted against current data to possibly reveal information previously
unavailable.
Print and/or save results and reports
Create your own “menu” of shortcuts to frequently used searches
A tab page containing all available functions in a menu format.
A new way to share thought leadership with public safety professionals.
An online learning center for law enforcement investigators and analysts.

Provides a means to send feedback regarding the application.
Provides a means to share a success story.
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Accurint LE Plus and LexID®
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Getting Started
Signing In
After installing the software, double-click the Accurint LE Plus™ icon on your computer’s desktop to launch
the application. You can also launch Accurint LE Plus™ from the shortcut on the Start Menu.
When the Sign-In screen displays, type in your user name and password and press the Sign In button (or
press the Enter key).

Note:

Each user is assigned a unique User ID and password by an Accurint LE Plus™ administrator.
Passwords are case sensitive. Access rights to certain data sets and functions are controlled by
your Sign in ID. This maintains the security of the data sources.
You will be required to sign in again after a period of inactivity.

Click here to reset
your password if you
forgot it.

Click on the gear icon for
access to system options.
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Changing Your Password: First Time Use

Your System Administrator created your temporary password in order for you to sign in. The first time you
sign in to the system, you must change your password so that you are the only person who knows it. This
protects you and the system.
Choose your password carefully. In the interest of security, password must meet the requirements established
in your account. The password complexity rules are displayed on the Change Password screen.
Passwords automatically expire after 90 days. You must change your password when prompted to do so.
To change a password:

 Select Administration Console from the View menu, then select the Change
Password tab.
 Type in your old password, your new password, and your new password again to confirm
it.
Your current password must be correct and the two entries of the new password must
match. In addition, your new password must meet the password requirements established
for your account.
 Press the Save button.
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Multi-Factor Authentication
Accurint desktop applications feature multi-factor authentication (MFA) support to enhance security when IP
roaming (signing in to the application from a different IP address.) If you sign in from a roaming location,
you are subject to data restrictions and some capabilities are diminished. However, by using MFA
authentication, you can avoid these limits.
Setting up MFA

The first time you sign in, you are presented with the opportunity to set up MFA.

 Press the Next button

The Choose Delivery Method screen displays.
 Select the method to use to send your one-time passcode. Email supports Send Token.
Telephones support either Send Token (via SMS Test message) or Send Voice.

Note: You cannot change any contact information until after you have established multifactor authentication for the first time.
 Press the Next button.
The Confirmation screen displays
 Check your email, phone text messages, or answer phone to record token, then provide
the 6-digit code you received and press the Next button.
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The final confirmation screen displays to inform you that MFA authentication has been
set up successfully.
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 Press the Finish button to close the wizard.
Now that MFA Authentication is established, anytime you are roaming, a code can be
sent to allow you to bypass roaming restrictions.
If you ever need to change any of the MFA Authentication Security Token values, you can access it
from the Administration Console under Multi-Factor Authentication.
The link ed image cannot be display ed. The file may hav e been mov ed, renamed, or deleted. Verify that the link points to the correct file and location.
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Administration Console
The Administration Console allows you to configure the application and your account. If you are an Account
Administrator, you can also use it to manage other users in your account.
Summary

This tab displays a summary of the current account and the current user.
Change Password

Use this tab to change the current password. Your password should be one that only you know. This protects
you and the system.
Choose your password carefully. In the interest of security, password must meet the requirements established
in your account. The password complexity rules are displayed on the Change Password screen.
Passwords automatically expire after 90 days. You must change your password when prompted to do so.
To change a password:

 Select Administration Console from the View menu, then select the Change
Password tab.
 Type in your old password, your new password, and your new password again to confirm
it.
Your current password must be correct and the two entries of the new password must
match. In addition, your new password must meet the password requirements established
for your account.
 Press the Save button.
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Company Activity

This tab allows you to review your recent activity. Use the From and To dates to set the range visible
(maximum 45 days).
On this tab Account Administrators can view activity for all users in their company. Use the drop list to select
the user and their activity is displayed.
Company Security

This tab shows activity for your account. You can limit the display to show only successful or failed sign ins.
Use the From and To dates to set the range visible (maximum 45 days).
On this tab Account Administrators can view activity for all users in their company. Use the drop list to select
the user and their activity is displayed.
Network Settings and Location Settings

These advanced network settings should generally not be changed without instruction from your local IT
support or LexisNexis Technical Support.
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Application Settings

This tab allows you to specify options for application.

Case Management/Case Folders Location

Specify the folder to use to store Cases you create and use in the Query History.
General

Check the Watch for New Alerts box to monitor for new alerts and pop up a notice when new alerts
arrive.
Check the Sort Addresses by Zip to enable Zip code sorting of results.
Check the Dynamic Reports 2.0 to enable the 2.0 version of dynamic reports. Clear the checkbox to
use the original version of reports.
Check the Advanced Person Search Non-Rollup format to disable the rollup display (card view)
Clear the checkbox to use the rollup view.
Check the Adv Sex Offender Search Non-Rollup format to disable the rollup display (card view)
Clear the checkbox to use the rollup view.
Check the Do Not Display Photos in Adv Person Rollup results to disable display of Images
from DOC, Arrest, and Sex Offender records. Clear the checkbox to display images when found.
Query History

Enable this feature to retain a list of Queries you have performed. These queries display in the Query History
list and can be re-run by double-clicking on an item in that list.
If you are working on a secure machine, or otherwise do not wish for your usage of the system to be logged
on your local PC so that you can rerun queries at a future time or track your search history, you can disable
that feature here.
The Queries Saved field displays the number of queries in your history list. Disk Space used displays the space
needed for that storage.
To reduce the number of queries stored, you can delete them individually from the Query History list or clear
the entire list by pressing the Clear History button.
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Using the Main Toolbar
Click on an icon to show the menu selection of searches for each type.
People

Business

Asset

License

Directory
Searches

Advanced Person Search
Batch Person Search
Death Records Search
Direct-to-Report
Email Search
ID Verification
LE Location Report
Lineup
Montage
Passport Validation Report
People at Work
People in the News
Person Search
Power Search
Real-Time Person Search
Virtual Identity Search
Workplace Search

Health Care

Business Search
Businesses in the News
Corporate Filings Search
Dun & Bradstreet Search
Federal Employee ID Numbers
Fictitious Business Name
National UCC Filings Search
Advanced Motor Vehicles
Automated Valuation Models
FAA Aircraft
MVR Wildcard
Property
Watercraft
Concealed Weapon Permit
DEA Controlled Substances
Drivers License
Drivers License Wildcard
FAA Certifications
Firearms & Explosives
Hunting and Fishing License
Professional License
Voter Registration Search

Analytics

Batch Telephone
Directory Assistance
Phones Plus
Real-Time Phones

Administration

Criminal and
Courts

American Board of Medical Specialties
CLIA Certificate
Healthcare Business Report
Healthcare Provider Report
NCPDP Search
NPI Data Search
Provider Search
Provider Report Card
Provider Sanction
Advanced Sexual Offenders Solution (ASOS)
Advanced Sexual Offenders
Bankruptcy, Liens & Judgments
Civil Courts
Criminal Record
Federal Civil Court Records
Federal Criminal Court Records
Foreclosures
Jail Bookings
Marriage & Divorce
National Motor Vehicle Accidents
Official Records
Sexual Offenders
USA PATRIOT Act
Relavint Plus ™ Link Analysis

Mapping

Accurint Mapping
Google Maps

Network

Public Safety Briefing Room

Feedback

Feedback
Share Success Story
Online Batch Services

Administration Console
Alerts and Notifications
My Account
My Favorites Manager
Your Company Administrator
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Using the Query List
The Query List window displays all queries from the current session. You can save, discard, or clear the
history list. The list can be an effective tool to plot the queries you have run to show how you navigated
from one result to another, or to rerun a query you ran earlier. Saved lists can also be loaded from a file.
To rerun a query from the Query List, double-click the history item. Note that this will result in the current
results for that query, which (if the data has been updated) could differ from the original results for the same
query.
Note:

The history window is cleared each time the program is closed. You can also clear it as you work.
If you want to save the history, press the diskette

button.

The View menu item contains an option to show or hide the Query List.

Using the Query History Window
The Query History list is an effective tool to organize the queries you have run and to preserve information
for yourself or to share it with someone else. If you have the Query History option enabled, the system
automatically logs each query that you run, along with its results. This is stored locally, in the folder you
specify.
This differs from the Query List described above in that all queries that you have ever run under your current
username on that machine with the option enabled are listed, unless you delete them. The View menu item
contains an option to enable Query History.
There are two sections to the Query History – the lower Query History window and the upper Case
Organizer section. All locally-logged queries appear under the Query History section, where they are
organized by date. Queries, partial results, or other files can be stored in the Case Organizer section by case
at your discretion.
To view the results from a historical query in either section, double-click the history item. Note that, in
contrast to double-clicking items in the Query List, this will display the original results for this query. To
view the current results for the same query, simply press the Search button and the query will rerun.
To create a new case, right-click on the Cases folder in the upper section and select New Case. You can
specify information regarding the case, including a name/number, dissemination information, reference
information, and by whom it was opened. This information will not be editable after creating the new case.
The location of your case information can be specified by right-clicking on the Cases folder and selecting
Change Root Folder.
Note:

If you change the location of your root folder, case information stored in the previous location will
not be visible unless you change back to that location.

You can add information to a case in several ways:

 Drag and drop a query from the lower Query History section into a case
 Select one or more results from a search window, and drag into a case (only the selected
records will be stored in this case, rather than all results)
 Right-click on a case and select Add Files from the pop-up menu. Any type of file
(document, spreadsheet, image, etc.) can be added to the case in this manner.
Cases or their contents can be deleted using the right-click popup menu. Also, this menu offers the option to
add comments added to any item.
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Using the Send To Function
The Send To function allows you to send a selected result record to another search window.
The Send Selected Field To… function sends the selected field within a record to a new query.
To use the Send to or Send Selected Field To…functions, highlight the record or bit of information within
a record you wish to send, right click and select either Send to or Send Selected Field To. Choose the
component to which the data will be sent. Searches are organized into the same categories as in the main
toolbar.

Data portions of screens in this manual are intentionally blurred.

For example, the Send selected field to function can be used to send a subject’s address to a driver’s license
search to identify all people who use that address on their driver’s licenses, or to send a list of addresses to the
map to be plotted.
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Dockable Toolbars
The main menu, main toolbar, and Query History window can all be undocked from their default positions
and placed elsewhere on the screen as preferred by the individual user. You can also chose to hide or display
any toolbar using the right-click popup menu from any area on a toolbar.

Drag and Drop Capabilities
Accurint LE Plus allows you to easily continue submitting a string of queries by providing the capability to
drag and drop data from one result window to another open window. When you drop data on a window,
the system automatically runs that query. You can also drag and drop data on a Map function or a photo
lineup.
Select a record by using the checkbox to the left of a record.
To drag, hold down the left mouse key over a record, and drag your mouse to an already open search
window, then release the mouse button. The window will query the data dropped on it.
You can also drag and drop records from search results to other applications such as Microsoft Excel or
Microsoft Word.

Customizable Search Results View
Search results columns can be resized, reordered, and sorted to present the search result information in the
most useful manner.


Click and drag the right edge of a column header to change a column size.



Double-click on an edge to expand the column to the size needed to display the data in the result.



Click and drag the column header to move the column.



Click on the column header to sort by that column, and click again on the same column to reverse
the sort (ascending vs. descending).

The arrow indicates that the data is
sorted by this column in the direction of
the arrow (ascending or descending).

You can restore the default order of column headers by selecting Restore Default Layout from the rt-click
menu.
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Saving and Printing Results
You can save or print selected or complete search results using the rt-click popup menu.

 Select the record or records you are interested in using the checkboxes. Use shift+click to
select a range or ctrl+click to select individual rows.
 Choose either Save List As or Print List from the right-click popup menu.
Saving or Exporting a Result List

Some result lists can be saved as Text, CSV, or XML files. This includes results from Advanced Motor
Vehicles Search, Advanced Person Search, Advanced Sexual Offender Search, Bankruptcy, Liens &
Judgments Search, and Business Search.
CSV or Comma Separated Value format is most compatible with a spreadsheet application such as Microsoft
Excel. An XML file can be opened in any XML viewer or a spreadsheet application. Text format is plain text
without any formatting.

 Right-click on your result list.
 The Select Output Columns option is available only for CSV and Text. Check the
boxes for fields to include.

 Select Save List As -> CSV or Text or XML.

 Provide a name for the file and press the Save button
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To open an XML file in Excel:
 In Excel ,select Open

from the File menu.

 Set the file type to XML Files

 Select the file you just saved, then press the Ok button

Printing

When printing a result list, you can preview the printout to choose options prior to actually printing the
document.
For Rollup searches (such as, Advanced Person; Advanced Sexual Offenders; Advanced Motor Vehicles;
Bankruptcies, Liens & Judgments; or Business), you can choose to print in Grid format or card format. From
Print Preview, you can choose Grid or Card view .
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Saving Graphs
Relavint Graphs can be saved as a Relavint (.REL) document, an Analyst’s Notebook XML document, an
image, or a Comma Separated Value (CSV) file. Use the Save as type droplist to select the type.
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Source Documents
Some searches, such as Person Search, Advanced Person Search, and Business Search provide details about
the sources of certain data elements displayed on rows in the result set.

Select View Sources from the rt-click
pop-up menu or click on a hyperlink to
see a Source Document Summary for
a record.

This feature allows you to see source information about individual columns such as:




Use these
buttons to
Save or
Print the
Source
Listing.

Name
SSN
Date of 
Birth




Address
Phone

Use this button to search
within a Source
Documents Listing.

This displays the number of sources (Occurrences) from which it was compiled and the range of dates where
that information was seen. This helps you to determine which records in a result set have the highest
likelihood of being correct and up-to-date and can be useful in focusing your investigative efforts.
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Using Reference
You can assign a reference number to queries using the entry control at the bottom of the application frame.
Once entered, the code is assigned to all requests until it is cleared or changed.

This Reference supplied will appear at the top of your Custom Comprehensive Report and other types of
reports. It also displays in Company Activity log.

Data portions of screens in this manual are intentionally blurred.
Some accounts require specific values for the Reference Code.
If your account has this requirement, the Select Reference Code window displays after you sign in.
Select the appropriate values from the drop-lists, then press the OK button.
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Snapshots
Snapshots allow you to checkpoint a “moment in time” for a report, map, photo lineup, or Relavint Analysis.
Saving a snapshot allows you to reopen the same item later with identical results.
Since data is continually updated, these items normally result in the most current information. A snapshot
allows you to see the result previously conducted—using the data at the time is was originally conducted.
For example, if you preserve a snapshot of a Custom Comprehensive Report that you run on May 13, 2006,
you can see the same result months later even though the underlying data has changed.
Snapshots are temporarily stored in your Query History list. Optionally, you can drag and drop a snapshot
into a Case in the upper portion of your Query History list. Copying it to a case preserves it in a folder on
your hard drive (as specified in Options).
To preserve a snapshot, click on the

button from the report, lineup, map, or analysis.

Click to save a
snapshot.

Once a snapshot is preserved, you can double-click to rerun the item at any time.
Once an item is
copied to a case,
you can rename it
using the rt-click
popup menu.
The rt-click menu
also allows you to
add comments to an
item.
You can also
drag and
drop disk
files (such as
a PDF
document)
into a Case
to keep
related
details in
one place.

Double-click to
display the item.
Snapshot of a
report.
Drag and drop into a
Case to preserve it.
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Tip:

Since snapshots are stored in your Query History, you should make sure Query History is
enabled. In addition, copying the snapshot to a Case (using drag-and-drop) preserves it beyond
the Query History’s expiration limits.

Reports from Result Sets
There are several reports available from result sets. To view a report, click on the icon.
Custom Comprehensive Report (also
available from rt-click menu)
Other Reports
 Address Report
 Comprehensive Report
 Finder Report
 Relatives/Neighbors/Associates Report
 Asset Report
 Contact Card Report
 Business Link Report
Business Report
Death Report
Motor Vehicle Report
Property Report
Official Records Report
Misc Reports
Bankruptcy Report
Lien and Judgment Report

Not all of these reports are available from every result set.
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Address Report

This report includes the following sections: Neighborhood Profile; Current and Previous Ownership;
Residential and Business Phones at Address; Possible Current and Previous Residents; Current and Previous
Driver Licenses at Address; Current and Previous Vehicles Registered at Address; Neighbors of Address;
Possible Current and Previous Businesses at Address; Bankruptcies; Liens and Judgments. In addition, this
report also includes Criminal Records, Sexual Offender, Concealed Weapons Permits, as well as Hunting and
Fishing Permits records that are associated with an address.
These options are available for Address Reports.

Select the Report
type from the droplist.

Asset Report

This report includes the following information, when available: Property Deeds & Assessments, Vehicle
Registrations, Watercraft, FAA Pilots, FAA Aircraft, and UCC Filings.
Select the Report type from the drop-list.
Business Link Report

This report links businesses to the subject based on how the subject’s relatives and associates match up to the
relatives and associates of the business contacts. Identifying these types of associations is helpful when
investigating fraud rings or collusion
Finder Report

This report includes the following information, when available: Address Summary, Others using SSN,
Date/Location where SSN issued, Phone Summary, Current Listed Phones, Unverified phones with Type
and Date Indicators, Current Neighbor Phones, Possible Relative Phones (2 Degrees), Possible Associate
Phones, Phones at Historical Addresses, Bankruptcy Filings, and Corporate Affiliations.
Select the Report type from the drop-list.

Relatives/Neighbors/Associates report

This report includes information about a subject’s relatives, neighbors, and associates.
Select the Report type from the drop-list.

Accurint for Law Enforcement Plus
User’s Guide | 33
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Indicators in Result Sets and Reports
Result sets can include icons to provide possible related information about a record returned.
Probable Current Address
Deceased
Possible Criminal Record
Address Risk Indicators
Phone Risk Indicators

SSN Padlock Masking
The application masks Social Security numbers (SSN) to prevent needless display. A screen may mask all
digits, the first five, or the last four, as configured in your account settings.
SSNs are masked and padlocked on initial search results pages and on interactive reports. A padlock icon is
displayed next to each SSN.
Click on the padlock icon to display the SSN; click again to mask it.

Click on the padlock
icon to display the SSN.
Click again to mask it.

Data portions of screens in this manual are intentionally blurred.
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Copying Data from Result Set
You can copy data from a single cell the result set by right-clicking on the cell you wish to copy and selecting
“Copy” from the menu. This data will be copied to the clipboard and can be pasted as desired.

Window Cascading
Accurint LE Plus provides the standard Windows cascading window feature to help you to navigate through
multiple open windows. The Windows menu item contains the option to cascade windows on the screen.
This allows you to see the open windows and what queries are displayed. The title bar on a window displays
the search criteria (where applicable).

Back & Forward History Queues
You can return to previous searches by pressing Back button. In any search window, press the Back
button to see searches that you have already done in that window. Pressing the down arrow next to the
button displays a list of prior searches from which to choose.

After going to previous searches, you can move forward in the history list by pressing the Next button.

Start Page
The Start Page provides a quick menu when you start the application. You can close the tab, if you want.
To open it, select Start Page from the View menu.
This page displays all of the searches available to you. You can open any search by clicking on a link.
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Favorites
Favorites allow you to create your own “menu” of hyperlinks to frequently used tasks in a panel on the left
side of the application. Clicking on one of these links, opens a tab for the function.
The picture can't be display ed.

To manage favorites:

 Select My Favorites Manager from the View Menu
or
 Select My Favorites Manager from the

toolbar button.

Use these buttons to
Add or Remove
Favorites

Use these buttons to
Move favorites Up or
Down in the list

You can also add any search to your favorites by rt-clicking on a tab and selecting Add to Favorites.
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My Account
The My Account option displays your account settings.
To access the My Account screen, select the My Account option from the View menu.

Account Credentials
From the Account Credentials tab, you can set your Security Questions or change your password.
Security Questions

This tab displays a list of questions and your answers. These questions are used to reset your account
password if you lose it.
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Retrieving a lost password

Note:

This feature is only available after having established your security questions. We recommend
establishing these questions as soon as possible. To establish your security questions, visit
Accurint.com, sign in, then go to the Account Credentials section. If you have not set up these
questions, you will be prompted when you first sign in.

If you forget your password, you can reset it by clicking on the Forgot Password link on the Sign-In
window.
This link takes you to Accurint.com, where you can follow the prompts, answer your challenge questions, and
to reset your password. If you have not established security questions, see your system administrator to reset
your password.
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Help
The Help menu offers several options to get help:

Contents

Provides access to the latest User’s Guide (this manual).

Your Company Administrator

If enabled, this options lists your company system administrators and contact information.
This should be your first contact if you encounter any difficulties using the application.
Technical Support

Provides contact information for technical support (after you have tried your local
administrator).
LNU School of LE

A link to the LexisNexis® University School of Law Enforcement--a revolutionary eLearning
program. This virtual university offers virtual classrooms where you can earn your Accurint®
degrees at times that are convenient.
Coverage Area Provides details about coverage areas for each search.
Feedback

Provides a means to send feedback to developers, including suggestions, feature requests, or
other comments.

Share Success Stories

Provides a means to share success stories.
About

Provides version details and other information.
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Person Search
The Person Search provides queries for a person by name, social security number, or address. The number of
records returned is shown in the bottom left corner of each window.
Note:

A maximum of 2,000 records are returned per query. If more than 2,000 records match your
query criteria, a message appears in the status bar offering suggestions on ways to narrow your
search.

A Custom Comprehensive Report is available for records displaying the

icon.

Locating People
Finding people is part art, and part science. Accurint LE Plus™ provides the science through data and tools
to help in your searches.
To locate the subject, try using one or more of the following search techniques:








The

If you know the subject's LexID®, no other search criteria is required.
If you know the subject's Social Security Number (SSN) use it alone in your first search.
Search using Last Name, First Name, and State. If too many records are returned, try adding a City
or a partial first name.
Search using a Last Name, First Name, State, and DOB.
Search using a DOB and Last Name.
The query result list can be sorted. Double-click on a column’s title to sort.
To display a list of actions, right-click in the results window.

icon near an address indicates the most probable current address for that person.

The

icon indicates that a person is deceased.

The

icon indicates a possible criminal record.

To print or save your result list from this search, see Saving and Printing Results on page 26.

Helpful Search Tips
Searching by Social Security Number

A Social Security Number, if you have one, should be the first search you try as it yields the best results. Type
the subject's SSN in the SSN field. It is not necessary to type the hyphens.
Even though SSNs are the most reliable identifier for an individual, they are not 100 percent dependable
because some records may not contain a subject's SSN. Therefore, a record for an individual may not appear
when searching using SSN only. Conducting a second search using Name and State provides additional
coverage.
Searching by Last Name

Type the subject's last name in the Last Name field and then click on the SEARCH button. If more records
are returned than are practical to review, refine your search (see Refining a Name Search).
Searching by Address

If you are unsure of the exact city, supply the closest city and specify a radius (no more than 100 miles). This
expands the area considered to a circle extending the specified number of miles from the center of that city.
For an address search, the City and State fields are required, but no name is required. If you do not include a
name, the Radius option is not allowed.
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Searching by DOB and Last Name

Type the subject’s full DOB and Last Name and click on the SEARCH button. If more records are returned
than are practical to review, refine your search by adding a State, City and State, or Zip Code. A radius
search can also be performed when the City and State or Zip Code are used in your search.
Searching using a Partial DOB

The DOB field supports partial dates such as MM/YYYY or YYYY. If you do not know the complete date,
you can search using the known portion. For example, 06/1955 would match subjects born in June of 1955.
You can also provide only the year. If you type the two digit month and four-digit year, you can omit
punctuation (. or /) and it will automatically format for you when you move to the next field.
Refining a name search

Adding criteria not already used, such as first name, middle name or initial, DOB, city, state, zip code, or age
range, refines a search. The more criteria you provide, the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
If you are unsure of a last name’s spelling, try a loose phonetic search by checking the Phonetic Search box.
If you do not know a subject's city but know the general vicinity, you can use the radius option. Enter a zip
code or a nearby city and state and provide a radius (in miles) in the Radius field.

Modifying a list of results
Narrowing your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:
First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few letters
in the First Name field. If you are not sure of the subject’s proper name, try using a variation of the name.
State - Entering a state narrows the results to subjects living in that state.
City - Entering a city, in addition to the state, further narrows the results to subjects living in the specified
city and state.
Middle Name or Initial - If your results return multiple listings with the same first and last name, add the
Subject's middle name or initial. Remember that some records do not contain middle names or initials and
will be excluded.
Expanding a list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial, date of birth, city).
Finding a subject in the displayed list

Identify the number of unique persons by examining the SSNs. For each individual, examine their records to
determine if the displayed age, geographic regions, middle name or initial, or first name fit what is known
about the subject. Double-click on the SSN of an individual you believe to be the subject to get the optimal
set of results including their current most probable address and phone number. The system will rerun the
query based on the SSN you clicked.
No blue check mark is displayed

Blue check marks near an address indicate that it is the probable current address for that person. If a subject
is found but has no blue check mark next to the address, you can try to find a subject through associates,
landlords, relatives, or neighbors from previously known locations.
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Custom Comprehensive Person Report

Run a Custom Comprehensive Report for the subject by clicking on the
Custom Comprehensive Report
icon on the left-hand side and following the prompts. When a report is generated, scroll down to find the
relevant information.
Finding others who may be living with a subject

You can enter a known address in the search fields or double-click on the address in a result list or Custom
Comprehensive Report to display all the people who have lived at an address. This can also help identify
mail drop addresses because it should show the name of a business that provides mailboxes.

Address Risk Indicators

Address Risk indicators are returned in results when an address is found to have a potential for risk. Risk
indicators—in and of themselves—are not necessarily indicators of fraud or of any fraudulent intent. They
are value added attributes that indicate information that may require further attention.
If a Risk Indicator is found for an address, a yellow checkmark displays next to the address (as shown below).
Hovering your mouse cursor over a checkmark, displays the associated description of the Risk Indicator.

Data portions of screens in this manual are intentionally blurred.
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People at Work
Search for records of people connected with businesses to locate your subject. Officers, directors, small
business owners and possible employees are just some of the types of records you will find in the People at
Work search. Using the search results, along with the date range and a confidence level indicator, you may be
able to locate where your subject is working.

Locating People at Work
You can search for worker records using the following criteria:
 LexID®
 Company Name
 Last Name
 First name
 Middle Name
 SSN
Results include:






Street Address
City
State
Zip

Name, Title, SSN, Company, Address, Phone Number, date range, and confidence level.
The

icon indicates a possible criminal record.

To find a corporate record, try using one or more of the following search techniques:






If you know the subject's LexID®, no other search criteria is required.
Search by an individual's Name and State. If too many records are returned, try adding a City.
Search by an individual's SSN.
Search by Company Name and State. If too many records are returned, try adding a City.
Search using an Address or partial Address, City, and State. This may reveal other people
connected to the business.
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Helpful Search Tips
Refine a Name Search

Adding criteria, such as middle initial, city, or state refines a search. The more criteria you provide the more
precise (narrow) the results will be.
Search by SSN

On the People at Work tab, type the individual's SSN in the appropriate field, then click on the Search
button.
Even though SSNs are a reliable identifier for an individual, they are not 100 percent dependable because
some records may not contain a subject's SSN. Therefore, a record for an individual may not appear when
searching using SSN only. Conducting a second search using Name and State provides additional coverage.
Search by Address

On the People at Work tab, type the Address, City, and State in the appropriate fields, then CLICK on the
Search button. If more records are returned than are practical to review, refine your search by adding a last
name.
Expand List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria.
Find a Record in the Displayed List

For each individual, examine records to determine if the displayed company, middle name or initial, or first
name fit what is known about the Subject. The company name, date range and the confidence level helps you
determine if your Subject may be currently working, or may have previously worked, at that company.
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Workplace Locator
Search for a person’s possible workplace. From the search results, you can run a report providing additional
details. Optionally, you can include a spouse’s data in the results.

Locating Workplace records
You can search for workplace records using the following criteria:






Last Name
First name
Middle Name
SSN
LexID®







Phone Number
Street Address
City
State
Zip

Check the Include Spouse Data box to include data about the subject’s spouse.
Check the Include Secretary Of State info box to include that data.
Results include:

This search delivers key contact information such as:


Current Workplace Name and Address



Up to 2 Workplace Phone Numbers



Date last seen in the Workplace



Option for Spouse Workplace Name, Address & Phone Number

The

icon indicates a possible criminal record.

To find a workplace record, try using one or more of the following search techniques:


If you know the subject's LexID®, no other search criteria is required.
 Search by an individual's Name and State. If too many records are returned, try adding a City.
 Search by an individual's SSN.
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Helpful Search Tips
Refine a Name Search

Adding criteria, such as middle initial, city, or state refines a search. The more criteria you provide the more
precise (narrow) the results will be.
Search by SSN

On the Workplace Locator tab, type the individual's SSN in the appropriate field, then click on the Search
button.
Even though SSNs are a reliable identifier for an individual, they are not 100 percent dependable because
some records may not contain a subject's SSN. Therefore, a record for an individual may not appear when
searching using SSN only. Conducting a second search using Name and State provides additional coverage.
Expand List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria.
Find a Record in the Displayed List

For each individual, examine records to determine if the displayed company, middle name or initial, or first
name fit what is known about the Subject. The company name, date range and the confidence level helps you
determine if your Subject may be currently working, or may have previously worked, at that company.
You can run a report that displays additional information by clicking on the

report icon.
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People in the News
This feature allows you to search millions of articles in more than two thousand publications. You can search
for a person, business, keywords, or any combination. You can fine-tune your search using “Words in the
Article” or “Without Words” to exclude articles you are not interested in. In addition, this search supports
Boolean connectors within fields to provide even more precision.

Locating News Articles
You can search for News Articles using the following criteria:





Last Name
First Name
Company Name
Additional search words

Use the drop-down list to select the source from which to search.

Specify a Date Range to limit results to relevant time periods. In addition, you can further limit results using
“Words in the Article” or Without Words”
Search results include: Headline, Publication Date, Source, and Description (a relevant portion of article)
Once you find an article of interest, click on the

icon to retrieve the complete text.
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Helpful Search Tips
Use Boolean search techniques to fine-tune your search using words and connectors to create phrases and
concepts based on specific rules of search logic.
Connectors

Use Boolean Connectors to establish logical relationships between words. You can combine multiple
connectors in a search to produce results including only articles of interest. The following is a list of
supported connectors:
OR

Returns items containing either word. Words entered in entry fields are implicitly joined by the AND connector.
Therefore, to include or exclude a document with either of two words, you must use the OR connector.
Example:
doctor OR physician finds items containing either doctor or physician.

PRE/n

Returns items containing both words where the first word precedes the second word within n number of words.
Use this connector when different word order would change the meaning.
Example:
eastern PRE/2 air or airlines finds items with Eastern Air or Eastern Airlines without including “warm air from
east.”

W/n

Returns items containing both words where two words are within n words of each other regardless of order.
Example:
doctor w/5 malpractice finds items with doctor within five or fewer words of malpractice, regardless of which
word appears first.

W/p

Returns items with both words in the same paragraph.
Example:
doctor W/p malpractice finds doctor in the same paragraph as malpractice.
NOTE: The W/p connector cannot be combined with the W/n connector.

W/s

Returns items with both words in the same sentence.
Example:
doctor w/s malpractice finds doctor in the same sentence as malpractice.
NOTE: The W/s connector cannot be combined with the W/n connector.

AND

Returns items with both words anywhere in the same document. Words entered in entry fields are implicitly
joined by the AND connector. Therefore, to include or exclude a document with either of two words, you must
use the OR connector.
Example:
doctor and malpractice -- finds both doctor and malpractice anywhere in the same document.
Special Characters/Wildcards
The asterisk ( * ) and the exclamation mark ( ! ) are referred to as wildcard characters. Use them to substitute
a letter or letters in words.

*

Replaces a single character. You can use more than one * in a word and you can use it anywhere in a word
except as the first letter.
Example:
analy*e finds both the American spelling analyze or the British spelling analyse

!

Replaces an indefinite number of characters at the end of a word.
Example:
litigat! finds variations of the word: litigate--litigator, litigated, litigation, litigating, etc.
Tip:

Words that work best with ! are those that are unique in their truncated form.
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Power Search
Power Search provides you with an alternate method to locate individuals, businesses, and property. It is
designed to allow you to search even when you only have limited information or fragments of data
Use a combination of Boolean and Natural Language search capabilities to find the entity you are looking for.

Locating People, Businesses, or Properties
You can search for people, businesses, or properties using the following criteria:
Terms & Connectors Search


This variation combines a form and free-form query. Use any combination of the entry fields and the
Additional Search Words box. These terms are used to construct a Boolean search using the AND
connector.
 Name
 Company
 SSN
 DOB
 Address
 City
 State
 ZIP
 Telephone Number
 Additional search words
Quick Search

Quick Search allows you to construct your own Boolean search criteria. Use Boolean search techniques to
fine-tune your search using words and connectors to create phrases and concepts based on specific rules of
search logic.
Connectors

Use Boolean Connectors to establish logical relationships between words. You can combine multiple
connectors in a search to produce results including only articles of interest. The following is a list of
supported connectors
AND

Returns items containing both words. Words entered in entry fields are implicitly joined by the AND connector.
Example:
John AND Mary finds records containing BOTH John and Mary.

OR

Returns items containing either word. Words entered in entry fields are implicitly joined by the AND connector.
Therefore, to include or exclude a record with either of two words, you must use the OR connector.
Example:
John OR Mary finds items containing either John or Mary.

PRE/n

Returns items containing both words where the first word precedes the second word within n number of words.
Use this connector when different word order would change the meaning.
Example:
John PRE/2 James finds items with John James or John Henry James without including “James Johnson.”

W/n

Returns items containing both words where two words are within n words of each other regardless of order.
Example:
Ford w/5 Motors finds items with Ford within five or fewer words of Motors, regardless of which word appears
first.

W/p

Returns items with both words in the same paragraph.
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Example:
doctor W/p malpractice finds doctor in the same paragraph as malpractice.
NOTE: The W/p connector cannot be combined with the W/n connector.
W/s

Returns items with both words in the same sentence.
Example:
doctor w/s malpractice finds doctor in the same sentence as malpractice.
NOTE: The W/s connector cannot be combined with the W/n connector.

Special Characters/Wildcards
The asterisk ( * ) and the exclamation mark ( ! ) are referred to as wildcard characters. Use them to substitute
a letter or letters in words.
*

Replaces a single character. You can use more than one * in a word and you can use it anywhere in a word
except as the first letter.
Example:
analy*e finds both the American spelling analyze or the British spelling analyse

!

Replaces an indefinite number of characters at the end of a word.
Example:
litigat! finds variations of the word: litigate--litigator, litigated, litigation, litigating, etc.
Tip:

Words that work best with ! are those that are unique in their truncated form.
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Helpful Search Tips
Refine a Search

Adding criteria, such as middle initial, city, or state refines a search. The more criteria you provide the more
precise (narrow) the results will be.
Expand List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria.
Find a Record in the Displayed List

For each individual, examine records to determine if the displayed details fit what is known about the Subject.
The results are sorted by relevance to the search terms.

Reports

For person records, you can initiate a Custom Comprehensive Report for the subject by clicking on the
Custom Comprehensive Report icon on the left-hand side and following the prompts.
For business records, you can initiate a Business Report by clicking on the
left-hand side and following the prompts.

business Report icon on the
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Advanced Person Search
The Advanced Person Search is similar to the Person Search, but has some advanced features.
The Person Search works well when specific information is available about a person, such as a full name,
address, or Social Security Number. The Advanced Person Search can help to identify individuals when such
specific information is not available.
This function is intended to return expanded results for the submitted data. It is useful when:





Minimal information is available
Old information is available and you want newer information
Current information is available and you want historical information
Available information may contain errors

A Custom Comprehensive Report is available for records displaying a Custom Comprehensive Report icon.
Click on the
A

icon and follow the prompts to run a report.

icon next to a name indicates a Possible Criminal Record.

If a photo is available from Sex Offender, DOC, or Arrest files, it is displayed at the top of the screen for the
selected record. This feature can be disabled or enabled in the Administration Console > Application
Settings. See Application Settings on page 21 for details.
The Multi Family Dwelling Option (MFD) allows you to search a Multi Family Dwelling (such as an
apartment community) using the address and selecting the MFD search option. Search results are restricted to
current residents only. This is intended to minimize receiving the too many subjects found error message.

Advanced Search Capabilities
In addition to the search capabilities in the Person Search, the Advanced Person Search supports such
searches as:

















Previous state – Where a search on information such as a name and state has returned too
many results, narrow your search by entering on the Advanced tab one or two previous states
where a subject has lived.
Two last names—Allows you to search using two known last names the subject has used. For
example, you can search for an individual when you know both married name and maiden name.
Last Name + partial SSN (last four digits)
Previous city – Where a search has returned too many results, narrow the search by entering a
previous city where a subject has lived.
Previous/alternate last name – Narrow a search to individuals matching other criteria and also
previously or alternately known by another last name.
Street – Search for all people on a street using the street name, city, and state.
Partial address and Other State – Allows you to search for individuals matching the partial
address who have lived in the specified other state. For example, you can search for all
individuals on a given street who once lived in a given other state.
Other City – Allows you to search for individuals who match the specified criteria and have lived
in the specified other city.
First name and street – Search for all by a given first name on a street (including city and state).
Age Range or limit – Refine a search using the lower, upper age limit or both.
First Seen / Last Seen – Refine a search using dates when address records were first seen or
last seen.
Relative first name(s) – Search for an individual query using one or two relative’s first names.
This limits the results to individuals who meet those criteria. For example, you can search for an
individual named “Jack with a relative named “Jill.”
Driver’s License Number and State
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Note:

This query uses an individual’s five “closest” relatives. These closest relatives are determined
by data (such as shared domiciles or shared assets) not by ancestral bloodlines or the
degree of closeness in the familial relationship. It is important to note that minors are not in
public record databases, therefore; using a minor’s information in this context provides no
added value and would probably exclude matches you want.

Options







Nicknames – Select this option to include in the search common variations/nicknames for the first
name you entered
Phonetic search – Select this option to search for phonetic variations on the last name, for
example in cases where you may not be sure of the spelling
Blanks filled in – Select to use advanced logic to enhance results by including the “best”
information that can be determined for each record. For example, a Social Security Number may
not be available in a particular public record, but using advanced matching logic the SSN may be
determined from another source with high probability
To limit results to only those with an exact match on submitted name and/or address, check the
Strict Search box.
Full Address History-- Check this box to include full address history when searching only on
Name and State. Otherwise, results are limited to the current state of residence and addresses
associated with the State submitted.

Searching using a Partial DOB

The DOB field supports partial dates such as MM/YYYY or YYYY. If you do not know the complete date,
you can search using the known portion. For example, 06/1955 would match subjects born in June of 1955.
You can also provide only the year. If you type the two digit month and four-digit year, you can omit
punctuation (. or /) and it will automatically format for you when you move to the next field.
You can also search by birth date when you do not know the birth year. Supply only the month and day
(MM/DD) to search by birthday.
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Finding a Record in the Displayed List

Results are displayed in a rollup or “card” view. Each row is one individual and all associated records are
displayed when the record is selected by clicking on it.
To run a Custom Comprehensive report,
click on the icon.

Right-click and select Collapse All
Rows to close expanded views for
rows. Select Expand All Rows to
see the expanded view for all rows.
Click to expand all rows.
You can also expand
rows from the rt-click
menu

Select a row to expand the record
to card view. Ctrl+click to close the
row.

To run additional searches, click one of the
displayed icons. Only those searches with
associated data appear.

Data portions of screens in this manual are intentionally blurred.

Identify the number of unique records by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
SSN Validity Codes

The results display a letter to the right of the SSN column. This table explains the character codes and their
meanings:
Code
V
R
N
X
M
O
U
S
Z

MEANING
Good
Relative
Typo (Near)
Bad
Manufactured
Old
Unknown
Suppressed
Possible
Different
Owner

Address, SSN, or Phone Indicators

Address Risk indicators, SSN Risk Indicators, and Phone Risk indicators are returned in results when data is
found to have a potential for risk. Risk indicators—in and of themselves—are not necessarily indicators of
fraud or of any fraudulent intent. They are value added attributes that indicate information that may require
further attention. If a Risk Indicator is found , a yellow or red checkmark displays next to the item.
Hovering your mouse cursor over a checkmark, displays the associated description of the Risk Indicator.
A

icon next to a Phone indicates that it is probably an active line.

A

icon next to an address indicates the most probable current address for that person.

The

icon indicates that a person is deceased.

The

icon indicates a possible criminal record.
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Passport Validation Report
The Passport Validation Report analyzes the composition of passport information and validates whether it
uses a valid number for that country.
Passport forgery is often linked to organized crime, terrorism, trafficking and other criminal activity. The
desire for fake passports remains high in criminal circles because if undetected, can lay the ground work for a
host of secondary identifying documents which in turn may go undetected. It is therefore critical to take
precautionary steps to identify forged passports to protect your organization from becoming unwittingly
involved in criminal activity.
The following fields are required:





Passport (upper line)
Passport (lower line)
Date of Birth
Gender

The generated report displays a Passport Validity Result.
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Batch Person Search
The Batch Person Search allows you to load a list of a limited number of subjects (up to 25) and retrieve their
best known information, including addresses, SSNs, and DOBs.
The input file can be in delimited (such as csv) or fixed-length formats, and can include names (first, last, and
middle names must be in separate fields), addresses (street address, city, state, and zip must be in separate
fields), social security number, date of birth, and phone number. If a unique individual can be identified based
on the input data, the best known information for the subject will be returned, along with a high/low
confidence rating. Data returned can be printed or saved to a file.

 Select the Batch Person Search from the People toolbar menu.
The Batch Person Search Wizard displays.

 Press the Next button.
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 On the next screen, press the lookup button to select a file.
Files may contain either fixed length fields or separated values (such as .CSV).
A maximum of 25 records can be imported at a time.

 Press the Next button.
 On the next screen, provide details about the file.
o

Choose either Delimited or Fixed Length.

o

Specify the File Type.

o

If you want to skip rows, specify the number of rows to skip.

o

If Delimited, select the character used to contain text.

o

If the first row contains field labels, check the First Row has column names
box .
A preview of the data displays to assist you

Accurint for Law Enforcement Plus
User’s Guide | 57
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

 Press the Next button.
 On the next screen, provide details about the delimiter. (This screen does not appear with
fixed length field data files.)
o

Choose Comma, Tab, Semi-colon, or Other.

o

If you select Other, specify the character.

A preview of the data displays to assist you.

 Press the Next button.
 On the next screen, select the field mapping. This allows you to specify which fields
contain the name, address, and other serch criteria data.
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 Press the Next button.
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The next screen displays while queries are performed

 Press the Next button.
 The next screen displays the results of your batch query, including the number of
successes and failures and confidence levels.
This allows you to analyze any failures, fix the data file, and re-run the batch query, if
needed.

 Press the Next button.
The results display.
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Death Records Search
This allows you to search death records nationwide, and where available, conduct a report to get additional
information pertaining to a death, such as cause, condition, location, time of death and autopsy details.
This search returns national records from the Social Security Administration (SSA) plus data repositories
from participating states. Use this search to verify death, identify benefits received, search death details for
insurance or collection purposes, or to verify improper uses of a Social Security Number.

The D icon
indicates a
Death Report is
available

Click on the
icon and follow
the prompts to run a Custom
Comprehensive Report.

Data and Photo portions of screens in this manual are intentionally blurred.
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Death Report

Use these
buttons to
Save or Print
the report.

Use this button to search
within a report
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Deceased Person Batch Search
The Deceased Person Batch Search allows you to search for a set of subjects by LexId®, name, address,
and/or SSN to determine if and when they passed away as well as verify subject’s name, SSN, date of birth,
and last known address.
The input file can be in delimited (such as csv) or fixed-length formats, and can include LexId, full name,
parsed names (first, last, and middle names in separate fields), addresses (street address, city, state, and zip
must be in separate fields), social security number, date of birth.

 Select the Deceased Person Batch Search from the Batch toolbar menu.
The Deceased Person Batch Wizard displays.
 Complete the following:
o File Reference Name: The reference name for this request.
o Upload File: Press the Browse button to select a file from your file system.

o File Type: Specify the File Type (Fixed Width or Delimited). If Delimited, select
the delimiter from the drop list.
o Email Address: Specify the email address where you wish to be notified when
the result is ready.
o Confirm Email Address: Confirm the email address.
 Press the Next button
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The Define Field Labels page displays.

 Complete the following:
o If the first row in your file contains titles or field labels, check the box.
o If you have a previously defined template, select if from the list or assign each
field a label using the droplist above each column.
o If you want to save the layout to a new template, provide a name in the Template
File Layout box.
 Press the Next button.
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The Permitted Use Certification page displays

 Select your permitted use.

The DPPA Compliance page displays

 Select your DPPA use.

The Secondary DPPA Compliance page displays
 Select your Secondary DPPA use.

The DMF Compliance page displays

 Select your DMF use.
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The Order Confirmation Summary displays

 Review the summary information and, if it is correct, press the Authorize Order to
complete the order.
If you need to adjust anything, press the Back button to return to the appropriate page.
When you order has been processed, you will receive an email with instructions to retrieve your results.
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Email Search
The Email search allows you to find subject’s email address or perform a reverse lookup by searching by email address.

Locating Email Records
You can search for Email records using the following criteria:







Last Name
First Name
Middle Name
SSN
DOB
LexID®







Street Address
City
State
ZIP
Email Address

Results include: Name, LexID®, SSN, DOB, Email address, and Address.
To find an Email record, try using one or more of the following search techniques:


Search by Name and State. If too many records are returned, try adding a City.



Search by Last Name, First Name, and State. Records will be returned matching the name.



Search by Email Address to perform a reverse lookup

Helpful Search Tips
Searching by Last Name

Type the Last Name in the Last Name field, then click on the SEARCH button. If more records are
returned than are practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as first name, middle name or initial, city, state, or zip code, refines a search. The more
criteria you provide, the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
Searching using a Partial DOB

The DOB field supports partial dates such as MM/YYYY or YYYY. If you do not know the complete date,
you can search using the known portion. For example, 06/1955 would match subjects born in June of 1955.
You can also provide only the year. If you type the two digit month and four-digit year, you can omit
punctuation (. or /) and it will automatically format for you when you move to the next field.

Accurint for Law Enforcement Plus
User’s Guide | 67
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Modifying the List of Results
Narrowing Your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



State - Entering a state narrows the results to records from that state.



City - Entering a city, in addition to the state, further narrows the results to records from the specified
city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add
the subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.

Expanding the list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial or city).

Finding a record in the displayed list

Identify the number of unique companies by examining the information displayed. Examine the records to
determine if the displayed information fits what is known about the Subject.

Accurint for Law Enforcement Plus
User’s Guide | 68
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

ID Verification
ID Verification increases assurance that an identity presented exists – name, address, SSN, etc. and is in fact
the identity of the subject.
The subject provides several key pieces of information as part of a verification request.






Last Name (required)
First Name (required)
Middle Name or Middle Initial
Date of Birth
SSN







Street Address (required)
City (required)
State (required)
ZIP (required)

ID Verification uses these identity data elements to verify that this identity exists. It then produces an
Authentication quiz consisting of questions that only the correct individual should be able to answer properly.
The Authentication quiz answers are then given a pass or fail response.
ID Verification works best if you enter as much information about the individual as possible. Last Name,
First Name, Address, City, State, and Zip are required.
This search verifies the input information using sophisticated multi-source data comparisons to maximize
accuracy. Providing data in more fields increases the reliability of your verification.

ID Verification Result
The ID Verification step returns a pass/fail determination along with portions that did not match. If a field is not
supplied, it returns as a non-match. For example, is no SSN is supplied, it will report that it does not match, but there
could be sufficient information to allow verification to pass, as shown below..

Data portions of screens in this manual are intentionally blurred.

The next example result shows a failed verification because the wrong address was supplied.

Data portions of screens in this manual are intentionally blurred.

Accurint for Law Enforcement Plus
User’s Guide | 69
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

ID Authentication
The Authentication phase returns a series of questions that only the correct person should be able to answer. Below are
some sample questions:

Data portions of screens in this manual are intentionally blurred.

Results
The final screen shows both ID Verification and ID Authentication results:

Data portions of screens in this manual are intentionally blurred.
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Law Enforcement Location Report
Situational awareness is important for the safety of personnel in the field, and having up-to-date information
about an address can alert law enforcement to changes in a location.
This feature can help your agency give personnel advanced information prior to responding to a location,
whether it is for an investigation, canvass, response to a 911 call, execution of a warrant, health care visit,
parolee visit, etc.
Search by:





Street Address
City
State
Zip

To run a report, click on the icon next to a returned record. The report can include the following
information about an address:








Owner of the address
All occupants
Immediate neighbors
Relatives
Associates
Criminal filings








Sex offenses
Phone numbers
Businesses
Concealed weapons permits
Hunting and fishing licenses
Vehicles.
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Virtual Identity Search
Virtual Identity Search provides an alternate view of an entity—their virtual presence.
With this enhanced search functionality, you can determine if a virtual identity or web footprint exists for
your person of interest within seconds, without having to access multiple sites—saving you and your agency
significant time and effort.
Investigators and researchers can now query a subject's email address and determine if that email address is
linked to any social networking sites (such as Facebook, MySpace, or LinkedIn).
Additionally, when you request a Virtual Identity Report, you will receive a list of all matching social network
and/or virtual identity public-facing pages (URLs) when a match is found between the search subject's email
and a site's “registered” email address.

Locating Virtual Identity Records
You can search for Virtual Identity records using the following criteria:







Last Name
First Name
Middle Name
SSN
DOB
LexID®







Street Address
City
State
ZIP
Email Address

Results include: Name, LexID®, SSN, DOB, and Address.
To find a Virtual Identity record, try using one or more of the following search techniques:


Search by Name and State. If too many records are returned, try adding a City.



Search by Last Name, First Name, and State. Records will be returned matching the name and state.



Search by Email Address to perform a reverse lookup

Helpful Search Tips
Searching by Last Name

Type the Last Name in the Last Name field, then click on the SEARCH button. If more records are
returned than are practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as first name, middle name or initial, city, state, or zip code, refines a search. The more
criteria you provide, the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
Searching using a Partial DOB

The DOB field supports partial dates such as MM/YYYY or YYYY. If you do not know the complete date,
you can search using the known portion. For example, 06/1955 would match subjects born in June of 1955.
You can also provide only the year. If you type the two digit month and four-digit year, you can omit
punctuation (. or /) and it will automatically format for you when you move to the next field.
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Modifying the List of Results
Narrowing Your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



State - Entering a state narrows the results to records from that state.



City - Entering a city, in addition to the state, further narrows the results to records from the specified
city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add
the subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.

Expanding the list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial or city).

Finding a record in the displayed list

Identify the subject by examining the information displayed. Examine the records to determine if the
displayed information fits what is known about the subject.
You can run a Virtual Identity Report that includes all the available details by clicking the
record’s row.

icon on a
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Direct-to-Report
This allows you to quickly run a report on an individual. You can run a Direct-to-report using the following
criteria:






LexID®
Last Name
First name
Middle Name
SSN







DOB
Street Address
City
State
Zip

Select the
desired report
from the droplist.

If you know the subject's Lex ID®, no other search criteria is required.
Search by an individual's Last Name, First Name and SSN
Search by an individual's Last Name, First Name, Street Address, and ZIP
Search by an individual's Last Name, First Name, Street Address, City, and State
Search by Address, City, State, and ZIP (Address Report)
Search by Lex ID®, Address, City, State, and ZIP (Relatives/Neighbors/Associates Report)








The Report Preferences window lets you to select the details you want to appear in the report. Options
that you select to include in a report are remembered for the next report that you run.
The options for a Comprehensive Report are shown below:

Data portions of screens in this manual are intentionally blurred.


Select the report type:
Interactive Web Page, Plain Text Web Page, Microsoft Word Document, or PDF.

 Check the boxes for Basic Options want to include
 Specify Neighbor and Relative options.
 Press the OK button.
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Searching using a Partial DOB

The DOB field supports partial dates such as MM/YYYY or YYYY. If you do not know the complete date,
you can search using the known portion. For example, 06/1955 would match subjects born in June of 1955.
You can also provide only the year. If you type the two digit month and four-digit year, you can omit
punctuation (. or /) and it will automatically format for you when you move to the next field.

Tip:

For reports on persons, holding the mouse cursor over the Supplemental Data Sources field
shows a list of all sources included for this option.

Note: Some data is only available to users with appropriate permissions levels. For more details, see
Custom Comprehensive Reports on page 207.
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Business Search
The Business search queries for a business by the business name, an associated individual’s name, an address,
or the TIN.

Locating Business Records
You can search for business records using the following criteria:
 Company Name
 Last Name
 First Name
 Middle Initial
 SSN
 Tax Identification Number (TIN)
 Street Address
 City
 State
 Zip
 Phone
Results include: Company Name, Address, Contact, SSN, Title, Phone, Date Last Seen, and TIN.
To find a business record, try using one or more of the following search techniques:



Search by Company Name and State. If too many records are returned, try adding a City.



If you know an officer, owner, or other contact for a business or if an individual is the subject of your
research, search using Last Name, First Name, and State. If too many records are returned, try adding a City.
You can also use a partial first name.



Search by Address, City, and State. Keep in mind that some corporate records use the Registered Agent's
address so it may not be 100% reliable.

Helpful Search Tips
Searching by Company Name
Type the company's name (or the first portion of a company name) in the Company Name field, then click on the
SEARCH button. If more records are returned than are practical to review, refine your search by adding a State or a
City and State.
Searching by Last Name
Type the Last Name of a corporate officer in the Last Name field, then click on the SEARCH button. If more records
are returned than are practical to review, refine your search as described below.
Refining a Name Search
Adding criteria, such as first name, middle name or initial, city, state, or zip code, refines a search. The more criteria you
provide, the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate records you
may want included.
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Modifying the List of Results
Narrowing Your Search
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:



First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



State - Entering a state narrows the results to records from that state.



City - Entering a city, in addition to the state, further narrows the results to records from the specified
city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add
the subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.

Expanding the list of results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
name or initial or city).

Finding a record in the displayed list
Identify the number of unique companies by examining the information displayed. Examine the records to determine if
the displayed information fits what is known about the Subject.
To run a Business report, click on the icon.

Select a row to expand the record
to card view. Ctrl+click to close the
row.
Click to expand all rows.
You can also expand
rows from the rt-click
menu

Right-click and select Collapse All
Rows to close expanded views for
rows. Select Expand All Rows to
see the expanded view for all rows.

Data portions of screens in this manual are intentionally blurred.
To print or save your result list from this search, see Saving and Printing Results on page 26.
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Reports

A Business Report is available for records displaying a
prompts to run a report.

report icon. Click on the icon to and follow the

A Report Preferences window displays, enabling you to select the details you want to appear in the report.
Options that you select to include in a report will be remembered for the next report that you run.

Other reports are available by clicking on the

Other Reports icon.
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Businesses in the News
This feature allows you to search millions of articles in more than two thousand publications. You can search
for a person, business, keywords, or any combination. You can fine-tune your search using “Words in the
Article” or “Without Words” to exclude articles you are not interested in. In addition, this search supports
Boolean connectors within fields to provide even more precision.

Locating News Articles
You can search for News Articles using the following criteria:





Company Name
Last Name
First Name
Additional search words

Use the drop-down list to select the source from which to search.

Specify a Date Range to limit results to relevant time periods. In addition, you can further limit results using
“Words in the Article” or Without Words”
Search results include: Headline, Publication Date, Source, and Description (a relevant portion of article)
Once you find an article of interest, click on the

icon to retrieve the complete text.
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Helpful Search Tips
Use Boolean search techniques to fine-tune your search using words and connectors to create phrases and
concepts based on specific rules of search logic.
Connectors

Use Boolean Connectors to establish logical relationships between words. You can combine multiple
connectors in a search to produce results including only articles of interest. The following is a list of
supported connectors:
OR

Returns items containing either word. Words entered in entry fields are implicitly joined by the AND connector.
Therefore, to include or exclude a document with either of two words, you must use the OR connector.
Example:
doctor OR physician finds items containing either doctor or physician.

PRE/n

Returns items containing both words where the first word precedes the second word within n number of words.
Use this connector when different word order would change the meaning.
Example:
eastern PRE/2 air or airlines finds items with Eastern Air or Eastern Airlines without including “warm air from
east.”

W/n

Returns items containing both words where two words are within n words of each other regardless of order.
Example:
doctor w/5 malpractice finds items with doctor within five or fewer words of malpractice, regardless of which
word appears first.

W/p

Returns items with both words in the same paragraph.
Example:
doctor W/p malpractice finds doctor in the same paragraph as malpractice.
NOTE: The W/p connector cannot be combined with the W/n connector.

W/s

Returns items with both words in the same sentence.
Example:
doctor w/s malpractice finds doctor in the same sentence as malpractice.
NOTE: The W/s connector cannot be combined with the W/n connector.

AND

Returns items with both words anywhere in the same document. Words entered in entry fields are implicitly
joined by the AND connector. Therefore, to include or exclude a document with either of two words, you must
use the OR connector.
Example:
doctor and malpractice -- finds both doctor and malpractice anywhere in the same document.
Special Characters/Wildcards
The asterisk ( * ) and the exclamation mark ( ! ) are referred to as wildcard characters. Use them to substitute
a letter or letters in words.

*

Replaces a single character. You can use more than one * in a word and you can use it anywhere in a word
except as the first letter.
Example:
analy*e finds both the American spelling analyze or the British spelling analyse

!

Replaces an indefinite number of characters at the end of a word.
Example:
litigat! finds variations of the word: litigate--litigator, litigated, litigation, litigating, etc.
Tip:

Words that work best with ! are those that are unique in their truncated form.
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Dun & Bradstreet Search
Dun & Bradstreet Records contain an overview about a businesses or government agency.
You can search for Dun & Bradstreet records using the following search criteria:





Company Name
DUNS Number
Street Address
City





State
Zip
Phone Number

Results may include: Company Name, Trade Name, Address, and Phone.
You can run a report that displays additional information by clicking on the

report icon.

A Dun & Bradstreet Report may include: Company Name, DUNS Number, Address, Phone Number, Year
Started, Date of Incorporation, Incorporation State, Annual Sales, Sales Revision Date, Employees Total,
Employees Here, Net Worth, Line of Business, Primary SIC, Secondary SIC Code, Establishment Type,
Structure Type, Facility, Small Business Flag, Minority Owned, Foreign Owned, Public, and Executives.

Helpful Search Tips
First, try to find a Dun & Bradstreet record using one or more of the following search techniques:
1. Search by Company Name and State. If too many records are returned, try adding a City.
2. Search by DUNS Number
3. Search using the Company Address, City, and State. This can reveal other companies connected to
the business.
4. Search by Phone.
Search by Company Name

Provide the Company name (or the first portion of a Company name) in the Company Name field, then click
on the Search button. If more records are returned than are practical to review, refine your search by adding a
State or a City and State.
Search by Address

Provide the Company address, then click on the Search button. If more records are returned than are
practical to review, refine your search by adding criteria. This can also reveal other companies that may be
associated with the business.
Search by Phone

Provide the Phone Number, then click on the Search button. If more records are returned than are practical
to review, refine your search by adding criteria.
Expanding the list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria.
Finding a record in the displayed list

Identify the number of unique companies by examining the information displayed. Examine the records to
determine if the displayed information fits what is known about the entity.
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Corporate Filings Search
The Corporate Filings search queries corporation information by a business name or the business officers’
names.
To run a Corporate Filings Report, click on the

icon next to a returned record.

A Comprehensive Business Report is available for records displaying a report icon . Double-click on the icon
to and follow the prompts to run a report.

Locating Corporate Records
You can search for corporate records using the following criteria:












Company Name
Last Name
First Name
Middle Initial
Street Address
Federal Employer Identification Number (FEIN)
City
State
Zip
Filing State
Charter Number

Results include: Company Name, Address, Address Type, FEIN, Charter Number, State of Origin, Record Date, and
Status. If you search by a person's name and that person is an officer in a corporation, the Officer Title is also returned.
You can run a report that displays additional information, including: Filing Date, Terms, Type of Corporation,
Registered Agent information, and a list of Corporate Officers and Directors.
Click on the Coverage Area option in the Help Menu to see a list of areas covered by the search.
To find a corporate record, try using one or more of the following search techniques:



Search by Company Name and State. If too many records are returned, try adding a City.



If you know an Officer of a Corporation or if an individual is the subject of your research, search using
Last Name, First Name, and State. If too many records are returned, try adding a City. You can also use a partial
first name.



Search by Address, City, and State. Keep in mind that some corporate records use the Registered Agent's
address so an address may not be 100% reliable.



To limit results to only those with an exact match on submitted name and/or address, check the Strict
Search box.
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Helpful Search Tips
Searching by Company Name
Type the company's name (or the first portion of a company name) in the Company Name field, then click on the
SEARCH button. If more records are returned than are practical to review, refine your search by adding a State or a
City and State.

Searching by Last Name
Type the Last Name of a corporate officer in the Last Name field, then click on the SEARCH button. If more records
are returned than are practical to review, refine your search as described below.

Refining a Name Search
Adding criteria, such as first name, middle name or initial, city, state, or zip code, refines a search. The more criteria you
provide, the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate records you
may want included.

Modifying the List of Results
Narrowing Your Search
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:



First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



State - Entering a state narrows the results to records from that state.



City - Entering a city, in addition to the state, further narrows the results to records from the specified
city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add
the subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.

Expanding the list of results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
name or initial or city).

Finding a record in the displayed list
Identify the number of unique companies by examining the information displayed. Examine the records to determine if
the displayed information fits what is known about the Subject.
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Fictitious Business Name Search
The Fictitious Business Names (FBN) search provides access to "Doing Business As" name filings or
assumed business name filings from all 50 states and the District of Columbia that are collected from the
Secretary of State, County Courthouses, Departments of Revenue, Departments of Taxation, local businesses
and legal journals.
For more information on the business, you can run an FBN report, by clicking on the
returned record.

icon next to a

Locating FBN Records
You can search for FBN records using the following criteria:










Company Name
Last Name
First Name
Street Address
City
State
Zip
Phone Number
Filing Number

Results include: Company Name, Address, Owners, Filing Type, Filing Number, Filing Date, and Filing State.
Click on the Coverage Area option in the Help Menu to see a list of areas covered by the search.
To find an FBN record, try using one or more of the following search techniques:


Search by Company Name and State. If too many records are returned, try adding a City.



If you know a principal of a company, search using Last Name, First Name, and State. If too many
records are returned, try adding a City.



Search by Address, City, and State. Keep in mind that some companies use multiple addresses so an
address may not be 100% reliable.

Finding a record in the displayed list

Identify the number of unique companies by examining the information displayed. Examine the records to
determine if the displayed information fits what is known about the Subject.
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Federal Employer ID Numbers (FEIN) Search
The Federal Employer ID Numbers (FEIN) search finds businesses using their FEIN registrations.
To run a Federal Employer ID Numbers (FEIN) Report, click on the

icon next to a returned record.

Locating Federal Employer ID Numbers (FEIN) Records
You can search for corporate records using the following criteria:







Company Name
Federal Employer Identification Number (FEIN)
Address
City
State
Zip

Results include: Company Name, Address, and FEIN. You can run a report that displays additional information.
Click on the Coverage Area option in the Help Menu to see a list of areas covered by the search.
To find a Federal Employer ID Numbers (FEIN) record, try using one or more of the following search techniques:



Search by Company Name and State. If too many records are returned, try adding a City.



Search by FEIN.
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UCC Filings Search
The UCC Filings search queries business lien information by a business name or address.
To run a UCC Report, double-click on the icon in a returned record. On the top of the report-viewing
window are buttons that allow you to save, print, or view a larger image of the report in its own window.
A Comprehensive Business Report is available for records displaying a report icon . Double-click on the icon
to and follow the prompts to run a report.

Locating UCC Records
You can search for UCC filings using the following criteria:
 Company Name
 Last Name
 First Name
 Middle Name
 Street Address
 City
 State
 Zip
Results include: Debtor Name and Address, Secured Name and Address, Original Date, Date Filed, and State.

You can run a report that displays additional information, including Filing Number, Collateral Code, and
Events by double-clicking on the icon in a record.
Click on the Coverage Area option in the Help Menu to see a list of areas covered by the search.
To find a UCC record, try using one or more of the following search techniques:



Search by Company Name and State. If too many records are returned, try adding a City.



Search by Last Name, First Name, and State.



Search by Address, City, and State. Keep in mind that some corporate records use various addresses and
may not be 100% reliable.

Helpful Search Tips
Searching by Company Name
Type the company's name (or the first portion of a company name) in the Company Name field, then click on the
SEARCH button. If more records are returned than are practical to review, refine your search by adding a State or a
City and State.
Searching by Last Name
Type the Last Name in the Last Name field, then click on the SEARCH button. If more records are returned than are
practical to review, refine your search as described below.
Refining a Name Search
Adding criteria, such as first name, middle name or initial, city, state, or zip code, refines a search. The more criteria you
provide, the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate records you
may want included.
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Modifying the List of Results
Narrowing Your Search
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:



First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



State - Entering a state narrows the results to records from that state.



City - Entering a city, in addition to the state, further narrows the results to records from the specified
city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add
the subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.

Expanding the list of results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
name or initial or city).

Finding a record in the displayed list
Identify the number of unique companies by examining the information displayed. Examine the records to determine if
the displayed information fits what is known about the Subject.
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Automated Valuation Model
This report provides a composite report of residential property information, including three valuation models,
to provide the best estimate of the current market value of the property of interest.
You can search for property records using either:


Street Address and City + State, or Zip
Or



Assessor’s Parcel Number (APN)

Click the Coverage Area option in the Help Menu to see a list of areas covered by the search.
To retrieve an AVM report, try using one or more of the following techniques:



Search by Address, City, and State.



Search by Address, and Zip.



Search by Parcel Number.

Note: The availability of property records for a given state and county does not ensure the return of an
AVM value. Not all properties will receive an AVM value, comparable property information, or
nearby property information. AVM values are only calculated for properties that are designated as
single family or condominium. An AVM value will be provided for residential properties whenever
at least one of the component models (Price Index, Taxed Assessed Value, Hedonic comparison)
has sufficient data.
Price Index requires a recorded sale of the subject property in the last ten years.
Tax Assessed Value requires a tax assessment record recorded in the past three years.
Hedonic comparison requires a minimum number of property records within ten miles of the
subject property that have similar characteristics and a recorded sale within the past twelve months.
If no such comparable property transactions are found, then no comparable properties will be
reported.
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Reading the Report
The report contains:






Historical Data (back to 2004)
Comparable Sales (Comps)
Nearby Sales
Transaction History
Property Summary.

From that data, the following valuation sections are calculated


AVM Results

Price Index Valuation
Using the prior sales price and the prior sales date, this index estimates the current property value by
appreciating the historical sales price to current based on a measure of property value appreciation
over time. LexisNexis considers the quarterly historical property appreciation rates for each state and
county. Those historical appreciation rates are used to "inflate" a prior sales price to an estimated
current market value. If a subject property has no recorded sales information since 1995, then the
Sales Price Index model will not provide an estimate.

Tax Assessor Valuation
This index estimates the market value of a property from its tax assessed value. For each county,
LexisNexis analyzes the relationship of recent property sales to their tax assessed value in order to
understand the relationship of tax value to market value in that locality. This is done at the county
level to control for differences in valuation methods and policy rules imposed by local taxing
authorities. In addition, separate tax-value to market-value ratios are calculated for different property
classes and segments. The Tax Assessor Index estimate is calculated by determining a subject
property's county, property class, and tax value, and adjusting the tax value to market value based
upon observed recent property sales in that county and property class. If a subject property has no
Tax Assessor record available, then the Tax Assessor Index will not provide an estimate.

Hedonic Valuation
The Hedonic property value model estimates the property value based on the actual sales price of
similar, nearby properties that sold in the past year. Comparable properties are selected based on their
property characteristics (bedrooms, baths, year built, size, etc.) and the physical distance from the
subject property. A minimum number of comparable sales (comps) are required to estimate the
hedonic model. If not enough recently sold comps can be found within ten miles of the subject
property, or if property characteristics are not available, then no hedonic estimate is returned.

Combined Valuation
This provides the best estimate of the current market value of the subject property, based on the three
component models (Price Index, Tax Assessment, and Hedonic).

Confidence Score
The Confidence Score indicates the relative accuracy of that estimate, based on the availability and
quality of data going into each method and the relative accuracy of each method for the subject's local
geography. Confidence values range from 0 to 100, with higher values reflecting a higher probability
of accuracy
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FAA Aircraft Search
Using the FAA Aircraft Search, you can search by name, company, address, or aircraft identification number
to locate aircraft and the owner(s) associated with them. Results include the full name of the individual or
company, address, aircraft number, record type, and description.

Locating Aircraft Records
You can search for Aircraft records using the following criteria:






Last Name
Middle Name
Street Address
State
Aircraft Number






First Name
Company Name
City
Zip



Results include: Full Name, Address, Serial Number, Aircraft Number, Record Type, and Description.
To find an FAA Aircraft, try using one or more of the following search techniques:




Search by Name and State or Company Name and State. If too many records are returned, try
adding a City or Zip Code. You can also use a partial first name.
Search by Address, City, and State. You can also search by partial address or just Zip Code.
Search by Aircraft Number if known. You can search on a partial aircraft number provided that
you have the first few characters of that number. Wildcard searches are not permitted.

Helpful Search Tips
Searching By Last Name

Type the subject's Last Name, then click on the SEARCH button. If more records are returned than are
practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as First Name, Middle Name or initial, City, State, or ZIP code, refines a search. The
more criteria you provide the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
Searching By Company Name

Type the Company Name, then click on the SEARCH button. If more records are returned than are
practical to review, refine your search as described below.
Searching By Address

Type the Address, City, and State in the appropriate fields, then click on the SEARCH button. This returns
records using that address. If more records are returned than are practical to review, refine your search as
described below.

Accurint for Law Enforcement Plus
User’s Guide | 90
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Modifying the List of Results
Narrowing List of Results

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:
First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few letters
in the First Name field.
State - Entering a state narrows the results to subjects living in that state.
City or Zip Code - Entering a city or zip code, in addition to the state, further narrows the results to
subjects living in the specified city and state.
Middle Name or Initial - If your results return multiple listings with the same first and last name, add the
subject's middle name or initial. Remember that some records do not contain middle names or initials and
will be excluded.

Expanding List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial or city).
Finding a Record in the Displayed List

Identify the number of unique records by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
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Advanced Motor Vehicles Search
The Advanced Motor Vehicles Search provides information regarding vehicles, registrants, owners and lien
holders of a vehicle. Since vehicle registrations are renewed each year, address information is often more
current than other sources, such as driver license records.
The vehicle data returned from this query includes both current information and historical records.
You can search Motor Vehicle Records using any combination of the following criteria:







Last Name
First Name
Middle Name
Company
LexID®
SSN







Street Address
City
State
County
Zip








Vehicle Identification Number (VIN)
Driver’s License Number
Tag Number
Tag Type (Select from drop-list)
Title Number
Year, make, and Model

Note: The Make drop-list is not available until you enter a Year and the Model drop-list is
not available until you select a Make.

Right-click and select Collapse All
Rows to close expanded views for
rows. Select Expand All Rows to
see the expanded view for all rows.
The search results are not limited to automobiles. Motor Vehicle records typically
include trailers, RVs, and other assets registered with the Department of Motor
Vehicles.

To print or save your result list from this search, see Saving and Printing Results on page 26.
The Phonetic Search option allows you to search for phonetic variations on the last name (useful in
cases where you may not be sure of the spelling).
The Include Non-Governmental Sources option allows you to include data from additional nongovernmental sources.
Check the Strict Search checkbox to filter the results to return only exact matches when searching by the
name or street address fields.
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Results vary from state to state, but may return the following Registrant information:




Registrant Name
Registrant SSN
Registrant LexID®










Issuing State
Tag Number
Tag Type
Description
VIN
Earliest Registration Date
Latest Registration Date
Expiration Date

 Registrant Address
 Registrant DL Number
 Registrant DOB
 Sex
Results may also return the following Vehicle Information:







Title Number
Title Issue Date
Name Source
Date First Seen
Date Last Seen
Indicator if Registration is current

Additional details may be included on the card view:






State of Origin
Data Source
Record Type
Previous tag Number
Previous Issue State
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Helpful Search Tips
Search using a VIN
The Vehicle Identification Number generally consists of seventeen characters that are used to uniquely identify a motor
vehicle.
Searching by Last Name

Type the Subject's Last Name in the Last Name field, then click on the Search button. If more records are
returned than are practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as first name, middle name or initial, city, state, or zip code, refines a search. The more
criteria you provide the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
Searching by Address

Type the Address, City, and State in the appropriate fields, then click on the Search button. This returns
records using that address. If more records are returned than are practical to review, refine your search as
described below.
Searching by Vehicle Tag Number

Type the Tag Number in the appropriate field, then click on the Search button. This returns records using
that tag number. If more records are returned than are practical to review, refine your search as described
below.
Searching using a Driver’s License Number

Type the DL Number of a registrant, then click on the Search button. This return records associated with the
Driver’s License submitted.
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Modifying the List of Results
Narrowing Your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



State - Entering a state narrows the results to subjects living in that state.



City - Entering a city, in addition to the state, further narrows the results to subjects living in the
specified city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add
the Subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.

Expanding the list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial or city).
Finding a record in the displayed list

Identify the number of unique vehicles by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.

Accurint for Law Enforcement Plus
User’s Guide | 95
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Property Search
The Property search queries property tax assessment and/or deed records by a name, address, or parcel
number.
To run a Property Report, click on the

icon next to a returned record.

Locating Property Records
You can search for property records using the following criteria:











LexID®
Last Name
First Name
Middle Initial
Company Name
Street Address
City
State
Zip
Parcel Number

Results include: Type, Owner Names, Owner Address, Property Address, Seller Name, Land Usage, Sale
Amount, Sales Dates, Tax Year, Assessed Value, and Parcel Number.
You can run a report that displays additional information, including:
Owner 2, County, Type, Subdivision Name, Land Usage, Year Built, Book, Page, Sale Price, Sale Date,
Recording Date, Seller Name, Land Value, Improvement Value, Total Value, Assessed Value, Tax Amount,
Loan Amount, Terms, Market Land Value, Market Improvement Value, Total Market Value, Assessed Year,
Living Size, Land Size, Number of Stories, Number of Bedrooms, Number of Bathrooms, Number of Half
Baths, Foundation, Legal Description, Document Type, Loan Amount, Terms, Document Type, Transaction
Type, Loan Type, Lender Name, Title Company, and Document Number.
.Click the Coverage Area option in the Help Menu to see a list of areas covered by the search.
To find a Property record, try using one or more of the following search techniques:



Search by Last Name, First Name, and State.



Search by Company Name and State. If too many records are returned, try adding a City.



Search by Address, City, and State.



Search by Parcel Number.

Specify the types of records to search using the Source droplist:

Choose Assessments, Deeds, or All Property from the list.
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Helpful Search Tips
Searching by Last Name

Type the Last Name of an Owner in the Last Name field, then click on the SEARCH button. If more
records are returned than are practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as first name, middle name or initial, city, state, or zip code, refines a search. The more
criteria you provide the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
Searching by Company Name

Type the company's name (or the first portion of a company name) in the Last Name field, then click on
the SEARCH button. If more records are returned than are practical to review, refine your search by adding
a State or a City and State.

Modifying the List of Results
Narrowing Your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



State - Entering a state narrows the results to records from that state.



City - Entering a city, in addition to the state, further narrows the results to records from the specified
city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add
the subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.

Expanding the list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial or city).

Finding a record in the displayed list

Identify the number of unique records by examining the information displayed. Examine the records to
determine if the displayed information fits what is known about the Subject.
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Watercraft Search
The Watercraft Search provides the ability to search by name, address, company, hull identification number,
or vessel name to find merchant vessels and other watercraft.
To run a Watercraft Report, click on the

icon next to a returned record.

Locating Watercraft Records
You can search Watercraft records using the following criteria:







LexID®
Last Name
First Name
Middle Name
Company
Street Address







City
State
Zip
Hull Identification Number
Vessel Name

The Include Non-Governmental Sources option allows you to include data from additional nongovernmental sources.
The search returns:
Owner, Address, Vessel Name, Hull ID, and Date Last Seen.
Click on the icon next to a returned record to run a watercraft report that may display additional
information, including:
Description, Owner Date of Birth, Registration Number, Status, Expiration Date, and Issue Date, Title State,
Number, Status, Issue Date, and Type, and Vessel Name, Number, Make, Use, Year, Type, Length, Breadth,
Depth, Gross Tons, Net Tons, Propulsion Type, and Fuel Type. Results vary from state to state and all items
may not be present in data for a given state.
To find a watercraft record, try using one or more of the following search techniques:



Search by Name and State. If too many records are returned, try adding a City. You can also use a partial
first name.



Search by Address, City, and State to return records using that address.
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Helpful Search Tips
Searching by Last Name

Type the Subject's Last Name in the Last Name field, then click on the SEARCH button. If more records
are returned than are practical to review, refine your search as described below.

Refining a Name Search

Adding criteria, such as first name, middle name or initial, city, state, or zip code, refines a search. The more
criteria you provide, the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.

Searching by Address

Type the Address, City, and State in the appropriate fields, then click on the SEARCH button. This returns
records using that address. If more records are returned than are practical to review, refine your search as
described below.

Searching by Hull ID Number

Type the Hull ID in the appropriate field, then click on the SEARCH button. This returns records using that
number.

Modifying the List of Results
Narrowing Your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



State - Entering a state narrows the results to subjects living in that state.



City - Entering a city, in addition to the state, further narrows the results to subjects living in the
specified city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add
the Subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.

Expanding the list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial or city).

Finding a record in the displayed list

Identify the number of unique vehicles by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
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Wildcard Search
The Wildcard search window allows you to query combinations of motor vehicle data. Wildcard Search
accesses motor vehicle data to run matches on partial license plate tags as well as car makes, models, colors.
For example, you can run a query to find all red Fords within a State, which have a ”D” as the second
character in the tag.

Locating Motor Vehicle Records
Wildcard Search enables you to search on the following criteria:













License Tag (or partial tag)
Tag Type (Select from drop-list)
Vehicle Make
Vehicle Model
City
State
County
Zip Code
Radius
Registration Type
Major Color
Minor Color









Vehicle Identification Number (VIN) or
partial VIN
Model Years
Owner Gender
Last Name
First Name
Middle Name
Age Range

Click on the Coverage Area option in the Help Menu to see a list of areas covered by the search.
The Include Non-Governmental Sources option allows you to include data from additional nongovernmental sources.
Results vary from state to state but may return the following information: Name, Company, address, SSN ,
Last Seen Date, tag number, tag type, and description.
The

icon near an address indicates the most probable current address for that person.

The

icon indicates that a person is deceased.

The

icon indicates a possible criminal record.

To find a Motor Vehicle record, try using one of the following search techniques:







Search by Tag. You can also search using a partial Tag. This can be accomplished by using the
Contains checkbox or by using wildcard characters. (See Searching by Tag.)
Search by VIN. You can also search using a partial VIN by using wildcard characters. (See
Searching by VIN.)
Search by Name. You can also use a partial first name.
Search by Name and Age Range. This returns records for the listed name whose age falls within
the specified Age Range.
Search by Vehicle Make and Major Color. This returns records for the listed vehicle matching the
Major Color specified.
Select the Registration type from the drop list to limit results to a type (Current, Expired, or Current
and Expired)

Remember that data is not always complete. If the raw data does not contain a value specified in your search,
you will not get a hit. It is sometimes more useful to expand your search by limiting the criteria and then
narrowing it from there if necessary.
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Helpful Search Tips
Searching by Last Name
Type the subject's Last Name in the Last Name field, then click on the SEARCH button. If more records are returned
than are practical to review, refine your search as described below.

Refining a Name Search
Adding criteria, such as first name, middle name, or middle initial, refines a search. However, searches in some states will
not produce the information you are seeking if the search criteria you have entered is not a recognized field.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate records you
may want included.
Searching by Tag
The following wildcard characters are available for use in the Tag field:
 * is used to designate any number of characters
 ? is used to designate a placeholder for one single character
Entering *ann* in the Tag field returns all vehicle tags that contain “ann” in that order anywhere in the tag. Example:
‘Anne1’, ‘Vann1’, or ‘32ann’
Entering a*t returns tags that begin with the letter “a” and end with the letter “t”.
Entering ?a* returns all tags whose second letter is “a”.

Ex: ‘ABC32T’

Ex: ‘1abc’, ‘car1’

Checking the Contains box will query for any combination of the entered information in the Tag field. When using

Contains do not use any wildcard characters.
Searching by VIN

The following wildcard characters are available for use in the VIN field:



* is used to designate any number of characters
? is used to designate a placeholder for one single character

Searching by City or ZIP

Enter a City or a Zip code. Optionally, you can enter a mile radius around a Zip or City & State to search the
surrounding area.
The following wildcard characters are available for use in the Zip field:



* is used to designate any number of characters
? is used to designate a placeholder for one single character

The Vehicle Major Color and Minor Color fields
Press the lookup (…) button next to the Color fields to display a color palette. Mouse-over colors in the palette to see
the names of the colors. Choose the color(s) you want and press the OK button.

The Result Limit field
Specify a limit for the number of records to be returned, up to 2,000 (the default is 500).
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Modifying the List of Results
Narrowing Your Search
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order
(remember that some records may not contain some or all of this information, so providing any of these items may
eliminate records you may want included):
First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few letters
in the First Name field.
Middle Name or Initial - If your results return multiple listings with the same first and last name, add the
subject's middle name or initial. Remember that some records do not contain middle names or initials and
will be excluded.
ZIP – Add a zip code or a zip code and a radius (in miles) to find records within a specified area.
Color – Add either/both a Major Color or Minor Color. Simply, click on the lookup button and select the
required color or a selection of possible colors from the palette.
Description – To add a vehicle description, you must also have selected a Vehicle Make. Add a vehicle
Description from the drop down list. Check as many items as are relevant to your search. However, your
search will not produce the records you require if the Description criteria you select are not an exact
match for the vehicle.

Expanding the list of results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
name or initial).

Finding a record in the displayed list
Identify the number of unique individuals by examining the information listed. Examine the records to determine if the
displayed information fits what is known about the subject.
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Driver’s License Search
The Driver’s License Search provides the ability to search by name, address, and license number or social
security number to find a person’s driver’s license information. Only data integrated in the system is available
for queries.
Note:

To print all or part of the records in the result window, select the records to print, right click and
choose Print List.

Locating Driver’s License Records
You can search driver’s license records using the following criteria:













LexID®
Last Name
First Name
Middle Name
License Number
Date of Birth
Gender
Street Address
City
State
Zip
SSN

Results may include:
Name, Address, Issuing County, Issuing State, SSN, Date of Birth, Sex, Race, Attention Flag, Restrictions,
Expiration Date, Issue Date, Endorsements, Motorcycle Code, License Type, and License Number.
The

icon indicates a possible criminal record.

To find a driver’s license record, try using one or more of the following search techniques:


If you know the subject's LexID®, no other search criteria is required.



Search by Name and State. If too many records are returned, try adding a City. You can also use a partial
first name.



Search by Address, City, and State. This returns records using that address.



Search by SSN.

The Include Non-Governmental Sources option allows you to include data from additional nongovernmental sources.
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Helpful Search Tips
Searching by Last Name

Type the subjects Last Name in the Last Name field, then click on the SEARCH button. If more records are
returned than are practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as first name, middle name or initial, city, state, or zip code, refines a search. The more
criteria you provide, the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
Searching by Address

Type the Address, City, and State in the appropriate fields, then click on the SEARCH button. This returns
records using that address. If more records are returned than are practical to review, refine your search as
described below.

Modifying the List of Results
Narrowing your Search
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:



First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



State - Entering a state narrows the results to subjects living in that state.



City - Entering a city, in addition to the state, further narrows the results to subjects living in the specified
city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add the
subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.

Expanding the list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial, date of birth, city).

Finding a record in the displayed list

Identify the number of unique records by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
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Driver’s License Wildcard Search
The DL Wildcard search window allows you to query combinations of Driver’s License data. Wildcard Search
accesses DL data to run matches on partial license numbers
The Include Non-Governmental Sources option allows you to include data from additional nongovernmental sources.

Locating Driver’s License Records
You can search driver’s license records using the following criteria:





License Number (with wildcard support)
State
Gender
Age Range

Click on the Coverage Area option in the Help Menu to see a list of areas covered by the search. Results vary
from state to state but may return the following information: Name, address, SSN , tag number and
description.
The

icon indicates a possible criminal record.

To find driver’s license records, try using one of the following search techniques:


Search by License Number. You can also search using a partial number. This can be
accomplished by using wildcard characters( * or ?). (See Searching by License Number)

Remember that data is not always complete. If the raw data does not contain a value specified in your search,
you will not get a hit. It is sometimes more useful to expand your search by limiting the criteria and then
narrowing it from there if necessary.
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Helpful Search Tips
Searching by License Number
The following wildcard characters a re available for use in the License Number field:
 * is used to designate any number of characters
 ? is used to designate a placeholder for one single character
Entering *ann* in the License Number field returns all licenses that contain “ann” in that order anywhere in the tag.
Example: ‘Anne1’, ‘Vann1’, or ‘32ann’
Entering a*t returns License Numbers that begin with the letter “a” and end with the letter “t”.
Entering ?a* returns all tags whose second letter is “a”.

Ex: ‘abc32t’

Ex: ‘1abc7777’, ‘car17777’

Modifying the List of Results
Narrowing Your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order (remember that some records may not contain some or all of this information, so providing any of
these items may eliminate records you may want included):


Age Range - If you are not sure of the entire first name, type an initial or the first few letters in the
field.



Gender - If your results return multiple listings, add the subject's gender.

Expanding the list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial).
Finding a record in the displayed list

Identify the number of unique individuals by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
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Professional Licenses Search
Using the Professional Licenses search, you can search by name, social security number, address, or license
number to find individuals that have or had professional licenses. Examples of professional licenses included
in the search are doctors, psychologists, dentists, hygienists, registered nurses, barbers, real estate brokers,
corporate broker, physical therapist, electrical contractors, and many more.

Locating Professional License Records
You can search Professional License records using the following criteria:







LexID®
Company Name
Last Name
First Name
Middle Name
SSN







Street Address
City
State
Zip
License Number

Results include:
Full Name, Address, SSN, Gender, License State, License Number, Profession/Board, Status, Issue Date,
Expiration Date, Last Renewal Date, Obtained By.
To find a Professional License record, try using one or more of the following search techniques:




Search by Name and State or Company Name and State. If too many records are returned, try adding a City or
Zip Code. You can also use a partial first name.
Search by Address, City, and State. You can also search by partial address or just Zip Code.
Search by Social Security Number.

Helpful Search Tips
Searching By Last Name

Type the subject's Last Name, then click on the SEARCH button. If more records are returned than are
practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as First Name, Middle Name or initial, City, State, or ZIP code, refines a search. The
more criteria you provide the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
Searching By Company Name

Type the Company Name in the Last Name field, then click on the SEARCH button. If more records are
returned than are practical to review, refine your search as described below.
Searching By Address

Type the Address, City, and State in the appropriate fields, then click on the SEARCH button. This returns
records using that address. If more records are returned than are practical to review, refine your search as
described below.
Searching By Social Security Number

Type the Social Security Number in the appropriate field, then click on the SEARCH button. This returns
records using that SSN.
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Searching By License Number

Type in the License Number, then click on the SEARCH button. This will return results for the specified
license number in any of the states covered in the system. If more records are returned than are practical to
review, refine your search as described below.

Modifying the List of Results
Narrowing List of Results

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the
first few letters in the First Name field.



State - Entering a state narrows the results to subjects living in that state.



City or Zip Code - Entering a city or zip code, in addition to the state, further narrows the
results to subjects living in the specified city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last
name, add the subject's middle name or initial. Remember that some records do not contain
middle names or initials and will be excluded.

Expanding List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial or city).
Finding a Record in the Displayed List

Identify the number of unique records by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
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FAA Certifications Search
Using the FAA Certifications search, you can search by name or address to find individuals that have or have
had a FAA certification, such as pilots, mechanics, instructors, etc. Results include the full name, address,
record type, medical certification type and expiration. Only data integrated into the system is available for
queries.

Locating FAA Certification Records
You can search FAA Certification records using the following criteria:








Last Name
First Name
Middle Name
Street Address
City
State
Zip

Results include: Full Name, Address, Status, Class, Certification Date, and Expiration Date.
To find an FAA Certification record, try using one or more of the following search techniques:


Search by Name and State. If too many records are returned, try adding a City or Zip Code. You can
also use a partial first name.



Search by Address, City, and State. You can also search by partial address or just Zip Code.

Helpful Search Tips
Searching By Last Name

Type the subject's Last Name, then click on the SEARCH button. If more records are returned than are
practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as First Name, Middle Name or initial, City, State, or ZIP code, refines a search. The
more criteria you provide the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
Searching By Address

Type the Address, City, and State in the appropriate fields and then click on the SEARCH button. This
returns records using that address. If more records are returned than are practical to review, refine your
search as described below.
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Modifying the List of Results
Narrowing List of Results

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the
first few letters in the First Name field.



State - Entering a state narrows the results to subjects living in that state.



City or Zip Code - Entering a city or zip code, in addition to the state, further narrows the
results to subjects living in the specified city and state.



Middle Name or Initial - If your results return multiple listings with the same first and last
name, add the subject's middle name or initial. Remember that some records do not contain
middle names or initials and will be excluded.

Expanding List of Results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
name or initial or city).
Finding a Record in the Displayed List
Identify the number of unique records by examining the information listed. Examine the records to determine if the
displayed information fits what is known about the subject.
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Hunting & Fishing License Search
Using the Hunting & Fishing License search, you can search by name or address to find individuals that have
or have had hunting or fishing licenses. Results include the full name, address, SSN, Date of Birth, and
license details. Only data integrated into the system is available for queries.

Locating Hunting & Fishing License Records
You can search hunting and fishing license records using the following criteria:









Last Name
First Name
Middle Initial
SSN
Street Address
City
State
Zip

Results include: Full Name, Address, SSN, Date of Birth, Sex, License Date, License Number, License Type,
Home State, and License State.
To find a Hunting & Fishing License record, try using one or more of the following search techniques:




Search by Name and State. If too many records are returned, try adding a City or Zip Code. You can also use a
partial first name.
Search by Address, City, and State. You can also search by partial address or just Zip Code.
Search by SSN.

Helpful Search Tips
Searching By Last Name
Type the subject's Last Name, then click on the SEARCH button. If more records are returned than are practical to
review, refine your search as described below.
Refining a Name Search
Adding criteria, such as First Name, Middle Name or initial, City, State, or ZIP code, refines a search. The more
criteria you provide the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate records you
may want included.
Searching By Address
Type the Address, City, and State in the appropriate fields and then click on the SEARCH button. This returns records
using that address. If more records are returned than are practical to review, refine your search as described below.
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Modifying the List of Results
Narrowing List of Results
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:
First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few letters
in the First Name field.
State - Entering a state narrows the results to subjects living in that state.
City or Zip Code - Entering a city or zip code, in addition to the state, further narrows the results to
subjects living in the specified city and state.
Middle Initial - If your results return multiple listings with the same first and last name, add the subject's
middle initial. Remember that some records do not contain middle names or initials and will be excluded.

Expanding List of Results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
initial or city).
Finding a Record in the Displayed List
Identify the number of unique records by examining the information listed. Examine the records to determine if the
displayed information fits what is known about the subject.
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Federal Firearms & Explosives License Search
Using the Firearms & Explosives License search, you can search by name or address to find individuals that
have or have had Federal Firearms or Explosives licenses. Results include names, addresses, and license
details. Only data integrated into the system is available for queries.

Locating Firearms & Explosives Records
You can search Firearms and Explosives license records using the following criteria:






Last Name
First Name
Middle Initial
SSN
Trade Name







Street Address
City
State
Zip
License Number

Results include: License Name, Trade Name, SSN, Mailing Address, Premises Address, Business Phone, License
Number, License Type, Expiration, County, and IRS Region.

The

icon indicates a possible criminal record.

To find a Firearms & Explosives record, try using one or more of the following search techniques:



Search by Name and State. If too many records are returned, try adding a City or Zip Code. You can
also use a partial first name.



Search by Trade Name and State. If too many records are returned, try adding a City or Zip Code.



Search by Address, City, and State. You can also search by partial address or just Zip Code.
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Helpful Search Tips
Searching By Last Name
Type the subject's Last Name, then click on the SEARCH button. If more records are returned than are practical to
review, refine your search as described below.
Refining a Name Search
Adding criteria, such as First Name, Middle Initial, City, State, or ZIP code, refines a search. The more criteria you
provide the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate records you
may want included.
Searching By Address
Type the Address, City, and State in the appropriate fields and then click on the SEARCH button. This returns records
using that address. If more records are returned than are practical to review, refine your search as described below.

Modifying the List of Results
Narrowing List of Results
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:
First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few letters
in the First Name field.
State - Entering a state narrows the results to subjects living in that state.
City or Zip Code - Entering a city or zip code, in addition to the state, further narrows the results to
subjects living in the specified city and state.
Middle Initial - If your results return multiple listings with the same first and last name, add the subject's
middle initial. Remember that some records do not contain middle names or initials and will be excluded.

Expanding List of Results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
initial or city).
Finding a Record in the Displayed List
Identify the number of unique records by examining the information listed. Examine the records to determine if the
displayed information fits what is known about the subject.
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DEA Controlled Substances License Search
Using the DEA Controlled Substances License search, you can search by name or address to find individuals
that have or have had Controlled Substances licenses. Results include names, addresses, and license details.
Only data integrated into the system is available for queries.

Locating Controlled Substance Records
You can search Controlled Substance license records using the following criteria:











LexID®
Last Name
First Name
Middle Initial
Company Name
SSN
Street Address
City
State
Zip

Results include: Name, Address, Company Name, Business Type, SSN, Drug Schedules, Expiration Date,
and Registration Number.
To find a Controlled Substances record, try using one or more of the following search techniques:





Search by Name and State. If too many records are returned, try adding a City or Zip Code. You can also use a
partial first name.
Search by Company and State. If too many records are returned, try adding a City or Zip Code.
Search by Address, City, and State. You can also search by partial address or just Zip Code.
Search by SSN.

Helpful Search Tips
Searching By Last Name
Type the subject's Last Name, then click on the SEARCH button. If more records are returned than are practical to
review, refine your search as described below.
Refining a Name Search
Adding criteria, such as First Name, Middle Initial, City, State, or ZIP code, refines a search. The more criteria you
provide the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate records you
may want included.
Searching By Address
Type the Address, City, and State in the appropriate fields and then click on the SEARCH button. This returns records
using that address. If more records are returned than are practical to review, refine your search as described below.
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Modifying the List of Results
Narrowing List of Results
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:



First Name or First Initial - If you are not sure of the entire first name, type an initial or the
first few letters in the First Name field.



State - Entering a state narrows the results to subjects living in that state.



City or Zip Code - Entering a city or zip code, in addition to the state, further narrows the
results to subjects living in the specified city and state.



Middle Initial - If your results return multiple listings with the same first and last name, add
the subject's middle initial. Remember that some records do not contain middle names or
initials and will be excluded.

Expanding List of Results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
initial or city).
Finding a Record in the Displayed List
Identify the number of unique records by examining the information listed. Examine the records to determine if the
displayed information fits what is known about the subject.
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Voter Registration Search
Using the Voter Registration search, you can search for Voter Registration records by name, address, or SSN.

Locating Voter Registration Records
You can search Voter Registration records using the following criteria:









Last Name
First Name
Middle Initial
SSN
Street Address
City
State
Zip

Results include: Name, Address, SSN, Gender, DOB, Occupation, Ethnicity, Date of last vote, Registration
date, Party affiliation, Registration State, and status.
To find a Voter Registration record, try using one or more of the following search techniques:


Search by Name and State. If too many records are returned, try adding a City or Zip Code. You can
also use a partial first name.



Search by Name, Address, City, and State. You can also search by partial address or just Zip Code.



Search by SSN.

Helpful Search Tips
Searching By Last Name

Type the subject's Last Name, then click on the SEARCH button. If more records are returned than are
practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as First Name, Middle Initial, City, State, or ZIP code, refines a search. The more
criteria you provide the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
Searching By Address

Type the Address, City, and State in the appropriate fields and then click on the SEARCH button. This
returns records using that address. If more records are returned than are practical to review, refine your
search as described below.

Accurint for Law Enforcement Plus
User’s Guide | 117
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Modifying the List of Results
Narrowing List of Results

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:
First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few letters
in the First Name field.
State - Entering a state narrows the results to subjects living in that state.
City or Zip Code - Entering a city or zip code, in addition to the state, further narrows the results to
subjects living in the specified city and state.
Middle Initial - If your results return multiple listings with the same first and last name, add the subject's
middle initial. Remember that some records do not contain middle names or initials and will be excluded.

Expanding List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle initial or city).
Finding a Record in the Displayed List

Identify the number of unique records by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
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Directory Assistance
Directory Assistance provides a search for phone numbers by name and/or address. Additionally, it can
perform a reverse lookup using a directory listing to find associated names and/or addresses.

Locating Directory Listings
Search for telephone numbers using the following criteria:










Last Name/Company
First Name
Middle Initial
Street Address
City
County
State
Radius around City
Business or Residential listing

NOTE: You may also run a Reverse Directory Search by searching on Phone Number – either ten digits
or seven digits.

Names are assumed to be abbreviated; no wild card character is required. If you are unsure of a name's
spelling, enter only the beginning letters of which you are sure. If you want only exact matches to a name, add
a period (.) at the end.
First names are automatically matched to common nicknames, as well as entries which contain only initials.
For example, a search for "JOSEPH" returns information for both "JOE" and "J." For businesses, common
abbreviations are searched automatically. For example, a search for "UNITED STATES" will return all
listings containing "US" or "USA."
Nationwide and statewide searches by name are permitted, but including a city and state is usually more
effective.
If you are unsure of the exact city, supply the closest city and specify a radius (no more than 100 miles). This
expands the search to include areas within the specified number of miles from the center of the given city. If
you do not include a city, the radius option is not allowed.
Results include: Name, Address, and Phone Number.
To find a directory listing, try using one or more of the following search techniques:



Search by Last Name (or Company Name) and State. If too many listings are returned, try adding a City.
If too few are returned, try adding the Find Similar Sounding Names option.



Search by Address, City, and State.

Results returned reflect current subscriber information only.
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Helpful Search Tips
Searching by Last Name

Type the subject's last name (or a company's name) in the Last Name/Company field, then click on the
SEARCH button. If more listings are returned than are practical to review, refine your search by adding a
State or a City and State.

Searching by Address, City and State

Type the subject's address, city and state in the appropriate fields, then click the SEARCH button. If more
listings are returned than are practical to review, refine your search by adding a Last Name.

Refining a Name Search

Adding criteria, such as first name, middle initial, city, state, or county, refines a search. The more criteria you
provide, the more precise (narrow) the results will be.
Keep in mind that some listings may not contain a middle initial, so providing one could eliminate listings you
may want included.

Modifying the List of Results
Narrowing Your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:
First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.
State - Entering a state narrows the results to subjects living in that state.
City - Entering a city, in addition to the state, further narrows the results to subjects living in the
specified city and state.
Middle Initial - If results return multiple listings with the same first and last name, add the Subject's
middle initial. Some listings do not contain middle initials and could be excluded.






Expanding the list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle initial or city).
Finding a listing in the displayed list

Identify the number of unique listings by examining the information displayed. Examine the listings to
determine if the displayed information fits what is known about the subject.
Using Reverse Lookup

For a reverse lookup on a phone number, provide:




10-digit phone number (including area code),
7-digit phone number (without area code) PLUS state, OR
7-digit phone number (without state or area code)
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Phones Plus
Phones Plus provides the ability to search for additional telephone records (records not found in a traditional
directory assistance search).

Locating Phone Numbers
Search for telephone numbers using the following criteria:




Tip:

LexID®
Last Name
First Name
Middle Initial






Street Address
City
County
State

You can run a Reverse Search by searching on Phone Number only – either ten digits or seven
digits.

Names are assumed to be abbreviated; no wild card character is required. If you are unsure of a name's
spelling, enter only the beginning letters of which you are sure. If you want only exact matches to a name, add
a period (.) at the end.
First names are automatically matched to common nicknames, as well as entries that contain only initials. For
example, a search for "JOSEPH" returns information for both "JOE" and "J."
Icons display to the left of the phone number to indicate the type of phone (Residential, Business, Cellular,
Landline, or Pager).
A blue checkmark icon displays next to records that are verified phones.
Nationwide and statewide searches by name are permitted, but including a city and state is usually more
effective.
To find a directory listing, try using one or more of the following search techniques:


If you know the subject's LexID®, no other search criteria is required.



Search by Last Name and State. If too many listings are returned, try adding a City.



Search by Address, City, and State.
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Helpful Search Tips
Searching by Last Name

Type the subject's last name in the Last Name field, then click on the SEARCH button. If more listings are
returned than are practical to review, refine your search by adding a State or a City and State.
Searching by Address, City and State

Type the subject's address, city and state in the appropriate fields, then click the SEARCH button. If more
listings are returned than are practical to review, refine your search by adding a Last Name.
Refining a Name Search

Adding criteria, such as first name, middle initial, city, state, or county, refines a search. The more criteria you
provide, the more precise (narrow) the results will be.
Keep in mind that some listings may not contain a middle initial, so providing one could eliminate listings you
may want included.

Modifying the List of Results
Narrowing Your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



State - Entering a state narrows the results to subjects living in that state.



City - Entering a city, in addition to the state, further narrows the results to subjects living in the
specified city and state.



Middle Initial - If results return multiple listings with the same first and last name, add the Subject's
middle initial. Some listings do not contain middle initials and could be excluded.

Expanding the list of results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle initial or city).
Finding a listing in the displayed list

Identify the number of unique listings by examining the information displayed. Examine the listings to
determine if the displayed information fits what is known about the subject.
Using Reverse Lookup

For a reverse lookup on a phone number, provide:




10-digit phone number (including area code),
7-digit phone number (without area code) PLUS state, OR
7-digit phone number (without state or area code)
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Real-Time Phones Search
Real-Time Phones Search provides the ability to search additional data sources for telephone records and
optionally request detailed information about a specific telephone including ported indicators and carrier
details.
This function provides search capabilities beyond traditional Directory Assistance and Phones Plus searches.
It can help determine who a phone is associated with or find a phone associated with a person or address.
Additionally, the returned phone type, phone status, phone carrier details, and ported indicators can allow for
contact to be made with operating companies for case investigations, including issuing subpoenas when
necessary.
Locating Phone records
Search for telephone records using combinations of the following criteria:







Last Name
First Name
Middle Name
Company Name
10-digit or 7-digit phone number
9-digit SSN







Street Address
City
State
ZIP
LexId

Use the following minimum criteria to search the Real-Time Phones:





10-digit or 7-digit phone number
Name, City, and State
9-digit Social Security Number
LexId

First Names are automatically matched to common nicknames, as well as entries that contain only initials. For
example, a search for JOSEPH returns information matches to Joseph, Joe, Jo, and J.
You can run a Reverse Search by searching on a 7-digit or 10-digit Phone
Number.
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Indicates Deceased individual.
Click on the icon for a Report.

Checkmarks in this column indicate
some form of Risk Indicator. A red
checkmark indicates possible high
risk, yellow checkmark indicates
possible medium risk, and green
checkmark indicates possible low
risk. Hover your mouse over it to
see the description of the risk
indicator(s) found.

Helpful Search Tips
To find a phone record, try using one or more of the following search techniques:





If you know the subject's LexID®, no other search criteria is required.
Search by Last Name, City, and State. If too many listings are returned, try adding a First Name.
If you are not certain about the spelling of a name, try the Phonetic Search checkbox.
Search by Phone number.

Searching by Last Name, City, and State

Type the subject's Last Name in the Last Name field, City in the City field, and the State in the State field,
then click on the SEARCH button. If more listings are returned than are practical to review, refine your
search by adding a ZIP code.
Searching by Address, City and State

Type the subject's Address, City, and State in the appropriate fields, then click the SEARCH button. If more
listings are returned than are practical to review, refine your search by adding a Last Name.
Refining a Name Search

Adding criteria, such as First Name, Middle Name, City, State, or ZIP, refines a search. The more criteria
provided, the more precise the results will be.
Keep in mind that some listings may not contain a Middle Name, so providing one could eliminate listings
you want included.
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Phone Detail Report
A Phone Detail Report (PDR) provides all of the details previously listed plus additional information about a
telephone record found using the Real-Time Phones Search. It can also provide a Possible Historical Phone
Records section.
Listing details and phone type can provide insight about the telephone subscriber. The Phone Detail Report
can also facilitate making contact with operating companies for case investigations and in preparing requests
for subpoenas.
The top section of the report displays basic information about the phone subscriber and carrier, such as:








Name
Address
LexID®
Telephone Number
Telephone Number
Carrier information
Deceased Indicator

The second section provides additional details, such as:
Name:

The individual or business name associated with the phone record.

Caller Id Name:

Generic name, calling party name, or Caller ID name associated with the record.

Address:

Street address associated with the record.

Listing Creation Date:
The oldest available listing date found.
Address Type:

Type of address associated with the record. Possible values are:

Phone Line Status:

Firm
 Post Office Box
General Delivery
 Rural Route
Multi-Dwelling
 Street Address
Military
 Unknown or Blank
Possible phone status. Possible values are:





Active-Landline
 Inactive-Landline
Active-Wireless
 Inactive-Wireless
Active-VOIP
 Inactive-VOIP
Active-Unknown Line Type  Inactive-Unknown Line Type
Active-Landline
 Unknown Line Type
Active-Wireless
 Blank
Active-VOIP
Phone Listing Type: Type of phone listing associated with the record. Possible values are:








Residential
Business or Government
Business, Government or Residential
Blank
Indicates (Y/N) if the listing associated with the record is published or Nonpublished.





Non-Published:
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Ported:

Indicates (Y/N) if the number associated with the record has been ported.

Operating Company Name:
Name of the Operating Company for the associated phone record.
Operating Company Affiliated To:
Name of Affiliated Company working in conjunction with the Operating
Company
Operating Company Address:
Address of the Operating Company for the associated phone record.
Operating Company Phone:
Operating Company Telephone Number.
Operating Company Fax:
Operating Company FAX Number.
Operating Company Contact:
Full name of Operating Company Contact
Company Contact Email:
Email Address of Operating Company Contact
Company Contact Address:
Address associated with the Operating Company Contact
Latitude:

Standardized latitude of the Address associated with the record.

Longitude:

Standardized longitude of the Address associated with the number.

Congressional District:
Federal Congressional District code (2 characters).
Carrier Route:

USPS standardized Carrier Route (4 characters).

Sort Zone:

USPS standardized carrier Sort Zone (1 character).

FIPS:

Federal Information Processing Standards Code (two-digit numeric codes and a
set of two-letter alphabetic codes representing the 50 states, the District of
Columbia, and the outlying areas of the United States.)

MSA:

Metropolitan Statistical Area.

CMSA:

Consolidated Metropolitan Statistical Area.

Real-Time Phone Detail section:
Time With Primary Phone, Time Since Last Seen With Primary Phone, Porting
Count, Disconnect Date, Spoof Spoofed Count, Destination Spoofed Count,
Source Spoofed Count, Phone Risk Indicator, Call Forwarding Indicator
Possible Historical Phone Records section:
Spoofing History Phone Origin, Spoofing History Event Date
Due to disparate data sources, some records have more information than others. In
general, if a report field is blank, then that information is not available for the
selected record. Any fields that are returned as blank will not display.

Accurint for Law Enforcement Plus
User’s Guide | 126
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Batch Telephone Search
The Batch Telephone provides the ability to upload a list of phone numbers into the system and get
immediate information about the name and address on record for each phone number. This is a useful
feature when you need to research a large volume of phone numbers, or create and save a list of phone
numbers, names, and addresses.
To use Batch Telephone, you must import a file into the system. The import file requirements are as follows:





Phone numbers must contain 10 digits. Phone numbers can be formatted or unformatted.
Records can contain more than one number, but only one phone number will be analyzed per record.
Delimiters (tab, comma, space, semi-colon and others) may be used to separate fields within each record but
each record must end with a carriage return.
Imported files can contain any number of records; however, the search only analyzes the first 500. If you need
to lookup more than 500 numbers, split the file and conduct multiple batch processes.

Using Batch Telephone Search

 Press the

button.

The Phone List window displays.

 Press the Browse button to select the file.
 Select the file to import and press Open. The list of records displays.

 Choose the delimiter (character that separates each field).
 If there is extra header information in the file, check the Ignore First Line box.
 Use the Phone Column option to choose the column containing phone numbers.
 Press the OK button to import the list into Batch Phone.
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 After importing the file for analysis, press the Search button.
This runs the batch phone lookup on all phone numbers in your list
The progress bar advises you when the lookups are complete. The name and address on record for a phone
number will display next to the phone number. Icons display to the left of the phone number to indicate the
type of phone (Residential or Business).
Sending to Relavint
Phone numbers loaded from a file can be sent to Relavint, before or after a Batch Telephone Search. To do so, enter a
Central Phone in the box provided, select all records, and press the Send to Relavint button.
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CLIA Certificate Search
This search provides a means to locate a Clinical Laboratory Improvement Amendments (CLIA) records.
Once you find a provider, you can run a Health Care Business Report to get additional details.

Locating CLIA records
You can search for Clinical Laboratory Improvement Amendments (CLIA) records using the following
criteria:




Company Name
CLIA #
Street Address





City
State
Zip

Results include:

Company Name, Address, Phone, Lab Type, CLIA Number, Certificate Type, Termination Code,
Termination Description, and Expiration Date.
You can run a report that displays additional information by clicking on the

report icon.

To find a record, try using one or more of the following search techniques:



Search by a Company’s Name and State. If too many records are returned, try adding a City.
Search by a CLIA Number.

Helpful Search Tips
Refine a Search

Adding criteria, such as Address, city, or state refines a search. The more criteria you provide the more
precise (narrow) the results will be.
Search by CLIA

Type the CLIA Number in the appropriate field, then click on the Search button.
Expand List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria.
Find a Record in the Displayed List

For each individual, examine records to determine if the displayed company, middle name or initial, or first
name fit what is known about the Subject.
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Provider Search
This search provides a means to locate a health care provider. Once you find a provider, you can run a
Provider License Report to get additional details.

Locating Provider records
You can search for Provider records using the following criteria:










Last Name
First name
Middle Name
SSN
DOB
Company
Tax ID (FEIN)
License
License State







Street Address
City
State
Zip
NPI Number

Results include:
Name, Address, Phone, DOB, and License.
You can run a Provider License report that displays additional information by clicking on the
icon. Select the Report type from the drop-list.

report

To find a record, try using one or more of the following search techniques:



Search by an individual's Name and State. If too many records are returned, try adding a City.
Search by an individual's SSN or Tax ID.

Helpful Search Tips
Refine a Name Search

Adding criteria, such as middle initial, city, or state refines a search. The more criteria you provide the more
precise (narrow) the results will be.
Search by SSN

Type the individual's SSN in the appropriate field, then click on the Search button.
Even though SSNs are a reliable identifier for an individual, they are not 100 percent dependable because
some records may not contain a subject's SSN. Therefore, a record for an individual may not appear when
searching using SSN only. Conducting a second search using Name and State provides additional coverage.
Expand List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria.
Find a Record in the Displayed List

For each individual, examine records to determine if the displayed company, middle name or initial, or first
name fit what is known about the Subject.
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Provider Sanction Search
This search provides a means to locate a health care provider’s sanctions. Once you find a provider, you can
run a Provider Sanction Report to get additional details.

Locating Provider Sanction records
You can search for Provider Sanction records using the following criteria:





Last Name
First name
Middle Name
SSN






Company Name;
Tax ID (FEIN);
License Number;
License State;



NPI Number







Street Address
City
State
Zip
DOB

Results include:
Name, Address, Phone, DOB, and License(s).
You can run a Provider Sanction report that displays additional information by clicking on the
icon. Select the Report type from the drop-list.

report

To find a record, try using one or more of the following search techniques:




If searching by Last Name or Company Name, the State is required.
Search by an individual's Name and State. If too many records are returned, try adding a City.
Search by an individual's SSN.

Helpful Search Tips
Refine a Name Search

Adding criteria, such as middle initial, city, or state refines a search. The more criteria you provide the more
precise (narrow) the results will be.
Search by SSN

Type the individual's SSN in the appropriate field, then click on the Search button.
Even though SSNs are a reliable identifier for an individual, they are not 100 percent dependable because
some records may not contain a subject's SSN. Therefore, a record for an individual may not appear when
searching using SSN only. Conducting a second search using Name and State provides additional coverage.
Expand List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria.
Find a Record in the Displayed List

For each individual, examine records to determine if the displayed company, middle name or initial, or first
name fit what is known about the Subject.
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Healthcare Business Report
This function allows you to run a report about a Health Care Provider.

Running a Report about a Health Care Business
You can use the following search criteria:




Company Name
TIN
Phone Number






Street Address
City
State
Zip

You can run a report that displays additional information by clicking on either
displays the type of report.

report icon. The tooltip

The Business Report Options window lets you to select the details you want to appear in the report.
Options that you select to include in a report are remembered for the next report that you run.

Data and Photo portions of screens in this manual are intentionally blurred.






Check the boxes for portions you want to include.
Clear the checkboxes for options you do not want included.
Select the Report type from the drop list.
Press the OK button.
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Healthcare Provider Report
This function allows you to run a report about a Health Care Provider.

Running a Report about a Health Care Provider
You can use the following criteria:







Last Name
First name
Middle Name
SSN
NPI Number
Phone







DOB
Street Address
City
State
Zip

The Comprehensive Health Care Provider Report Options window lets you to select the
details you want to appear in the report. Options that you select to include in a report are remembered for the
next report that you run.

Data and Photo portions of screens in this manual are intentionally blurred.






Check the boxes for portions you want to include.
Clear the checkboxes for options you do not want included.
Select the Report type from the drop list.
Press the OK button.
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NPI Data Search
This search provides a means to search National Plan and Provider Enumeration System data. Once you find
a provider, you can run an NPI Data Report to get additional details.

Locating NPI records
You can search for NPI data records using the following criteria:






Last Name
First name
Middle Name
NPI Number
Company Name






Street Address
City
State
Zip

Results include:
Name, Company Name, Address, Phone, State, and NPI Number.
You can run an NPI Report that displays additional information by clicking on the
Report type from the drop-list.

report icon. Select the

To find a record, try using one or more of the following search techniques:



Search by an individual's Name and State. If too many records are returned, try adding a City.
Search by an individual's NPI Number.

Helpful Search Tips
Refine a Name Search

Adding criteria, such as middle initial, city, or state refines a search. The more criteria you provide the more
precise (narrow) the results will be.
Search by NPI

Type the individual's NPI Number in the appropriate field, then click on the Search button.
Expand List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria.
Find a Record in the Displayed List

For each individual, examine records to determine if the displayed company, middle name or initial, or first
name fit what is known about the Subject.
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NCPDP Search
The National Council for Prescription Drug Programs (NCPDP) search allows you to search NCPDP
records to find entities in that data. Our NCPDP contains nationwide coverage of pharmacies and nonpharmacy dispensing locations with in-depth information about the entity including licensing, contact
information, services available, and more.

Locating NCPDP records
You can search using the following criteria:



Company/Organization
Name
NCPDP ID Number






Street Address
City
State
Zip

Helpful Search Tips
First, try to find a NCPDP record using one or more of the following search techniques:
1. Search by Business Name and State. If too many records are returned, try adding a City.
2. Search by Address, City, and State.
3. Search by NCPDP ID Number.
Search by Business Name and Address
Provide the Business Name, Address, City, and State in the appropriate fields, then click on the Search button. This
returns records using that address. To loosen the search use less of the address. Name and zip code, name and city and
state and name and state each return broader results.
Search by NCPDP ID Number
Provide the NCPDP ID Number in the appropriate field, then click on the Search button.
Expand List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria.
Find a Record in the Displayed List

For each row, examine records to determine if the displayed information fits what is known about the entity.
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American Board of Medical Specialties Search
The American Board of Medical Specialties (ABMS) search allows you to find a provider in ABMS records.
Once you find a provider, you can run an ABMS Report to get additional details.

Locating ABMS records
You can search using the following criteria:




Last Name
First name
Middle Name







Street Address
City
State
Zip
NPI Number

Use the Specialties drop list to limit your search to one specialty.
You must enter search criteria in at least one field. Searching by multiple fields increases your search
precision, but results in fewer results. To search more broadly, use fewer fields.
When searching on common names, complete as many fields as you can to avoid large result sets.
Results include:

Name, Address, Phone, NPI Number, and Specialties
You can run a report that displays additional information by clicking on the

report icon.
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Provider Report Card
The Provider Report Card displays a detailed comparison of input elements to our data sources.
Input data is displayed in the response along with either a green “Yes" indicating the input information is
verified, or a red “No" indicating the input information does not match our information.
In addition, input elements that have an expiration date will be checked for expiration date validity with the
green “Yes" used for licenses that are non-expired, and the red “No" to indicate the expiration date is in the
past.
Also included are indicators for potential issues. Y/N flags are retuned for possible deceased, exclusion, or
sanction information linked to the input subject.
If a sanction and/or exclusion is found, a link to run a sanction report appears. The sanction report will have
details on the exclusions or sanctions.
In addition to verifying the input information, the Provider Report Card appends additional information
found for the subject provider that was not included in the search input. Information that can be found in
this section may include licenses, taxonomies, or identifiers that were not included in the input, as well as
gender & degree type.
You can search using the following criteria:










Last Name
First name
Middle Name
SSN
DOB
Company/Organization
Tax ID (FEIN)
License
License State










Street Address
City
State
Zip
NPI Number
CLIA
DEA Number
Taxonomy

Note: You must provide at least:
Company Name or First and Last Name, Full Address, and either SSN or NPI.
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Bankruptcy, Liens & Judgments Search
This search combines the Bankruptcy search with the Liens and Judgments search. You can search by name
or address.
Results include names, addresses, and case details. Only data integrated into the system is available for
queries.
Select the type of search from the drop list:

Locating Records
You can search using the following criteria:






LexID®
Last Name/Company
First Name
Middle Initial
SSN







Street Address
City
State
Zip
Case/Filing Number

Results include: Debtor Name, Address, SSN, Case Number, Location, and Date Filed.
The

icon indicates a possible criminal record.

To print or save your result list from this search, see Saving and Printing Results on page 26.

To find a record, try using one or more of the following search techniques:


If you know the subject's LexID®, no other search criteria is required.



Search by Name and State. If too many records are returned, try adding a City or Zip Code. You can
also use a partial first name.



Search by Address, City, and State. You can also search by partial address.



Search by State and case number.
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Helpful Search Tips
Searching By Last Name

Type the subject's Last Name, then click on the SEARCH button. If more records are returned than are
practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as First Name, Middle Initial, City, State, or ZIP code, refines a search. The more
criteria you provide the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
Searching By Address

Type the Address, City, and State in the appropriate fields and then click on the SEARCH button. This
returns records using that address. If more records are returned than are practical to review, refine your
search as described below.

Modifying the List of Results
Narrowing List of Results

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the
first few letters in the First Name field.



State - Entering a state narrows the results to subjects living in that state.



City or Zip Code - Entering a city or zip code, in addition to the state, further narrows the
results to subjects living in the specified city and state.



Middle Initial - If your results return multiple listings with the same first and last name, add
the subject's middle initial. Remember that some records do not contain middle names or
initials and will be excluded.
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Finding a Record in the Displayed List

If you search for both Bankruptcy and Liens and Judgments, each row contains only one record type. The
Report icon in the first column indicates which type of record it is.

To run a Bankruptcy report, click on the icon.

Select a row to expand the record
to card view
Right-click and select Collapse All
Rows to close expanded views for
all rows. Select Expand All Rows to
see the expanded view for all rows.
Click to expand all rows. You
can also expand rows from the
rt-click menu

To run a Lien and Judgment report, click on the icon.

Data portions of screens in this manual are intentionally blurred.

Identify the number of unique records by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
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Civil Courts Search
Using the Civil Courts search, you can query whether a person or company has been involved in any civil court matter.
Results include both party names and whether the search subject is the plaintiff or defendant, the type of case, and the
government jurisdiction.

Locating Civil Court Records
You can search for civil court records using the following criteria:
 Last Name
 First Name
 Middle Name
 Company
 City
 State
 Jurisdiction

Click on the

icon next to a returned record to run a report that displays additional information, including:

Case Number, Court, Plaintiff, Defendant, Attorney of Record for the Plaintiff and Address, Attorney of
Record for the Defendant, Appearance Justice(s), Ruling, Filing Date, Judgment Date, Judgment Type,
Disposition Date, Ruling For, Cause, Manner of Filing, Manner of Judgment, Judgment Disposition,
Disposition, Suit Amount, Award Amount, and Case Activity.

Helpful Search Tips
Searching by Last Name

Type the Last Name in the Last Name field, then click on the SEARCH button. If more records are
returned than are practical to review, refine your search as described below. Alternatively, type Company
Name in the Last Name field.
Refining a Name Search

Adding criteria, such as first name, middle name or initial, city, state, zip code, or jurisdiction, refines a search.
The more criteria you provide, the more precise (narrow) the results will be.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate
records you may want included.
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Modifying the List of Results
Narrowing Your Search
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:
 First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few letters
in the First Name field.
 State - Entering a state narrows the results to records from that state.
 City - Entering a city, in addition to the state, further narrows the results to records from the specified city and
state.
 Jurisdiction - Entering a jurisdiction, in addition to the state, further narrows the results to records from the
specified court jurisdiction.
 Middle Name or Initial - If your results return multiple listings with the same first and last name, add the
subject's middle name or initial. Remember that some records do not contain middle names or initials and will
be excluded.
Expanding the list of results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
name or initial, city, or jurisdiction).

Finding a record in the displayed list
Identify the number of unique records by examining the information displayed. Examine the records to determine if the
displayed information fits what is known about the Subject.
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Federal Civil Courts Search
Using the Federal Civil Courts search, you can query whether a person or company has been involved in a
federal civil court matter. Results include both party names and whether the search subject is the plaintiff or
defendant, the type of case, and the jurisdiction.
This search supports Boolean connectors within fields to provide even more precision.

Locating Federal Civil Court Records
You can search for civil court records using the following criteria:
Last Name
State
First Name
Additional Terms
Company
Case Number
Case Name
Use the Date drop-list to select a date range to search or provide a range in the From and To fields.

Helpful Search Tips
Searching by Last Name or Company Name

Type the Last Name in the Last Name field, then click on the SEARCH button. If more records are
returned than are practical to review, refine your search by adding more criteria. If you are unsure of the
spelling, you can use the Boolean connector OR. For example, SMITH OR SMYTHE.
Refining a Search by date

Adding a date range refines a search. The smaller the date range you provide, the more precise (narrow) the
results will be.
Expanding the list of results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., State).

Finding a record in the displayed list
Identify the number of unique records by examining the information displayed. Examine the records to determine if the
displayed information fits what is known about the Subject.

Once you locate a record of interest, click on the
additional information.

icon next to the record to run a report that displays
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Using Boolean Connectors
Use Boolean search techniques to fine-tune your search using words and connectors to create phrases and
concepts based on specific rules of search logic.
Use Boolean Connectors to establish logical relationships between words. You can combine multiple
connectors in a search to produce results including only articles of interest. The following is a list of
supported connectors:
OR

Returns items containing either word. Words entered in entry fields are implicitly joined by the AND connector.
Therefore, to include or exclude a document with either of two words, you must use the OR connector.
Example:
doctor OR physician finds items containing either doctor or physician.

PRE/n

Returns items containing both words where the first word precedes the second word within n number of words.
Use this connector when different word order would change the meaning.
Example:
eastern PRE/2 air or airlines finds items with Eastern Air or Eastern Airlines without including “warm air from
east.”

W/n

Returns items containing both words where two words are within n words of each other regardless of order.
Example:
doctor w/5 malpractice finds items with doctor within five or fewer words of malpractice, regardless of which
word appears first.

W/p

Returns items with both words in the same paragraph.
Example:
doctor W/p malpractice finds doctor in the same paragraph as malpractice.
NOTE: The W/p connector cannot be combined with the W/n connector.

W/s

Returns items with both words in the same sentence.
Example:
doctor w/s malpractice finds doctor in the same sentence as malpractice.
NOTE: The W/s connector cannot be combined with the W/n connector.

AND

Returns items with both words anywhere in the same document. Words entered in entry fields are implicitly
joined by the AND connector. Therefore, to include or exclude a document with either of two words, you must
use the OR connector.
Example:
doctor and malpractice -- finds both doctor and malpractice anywhere in the same document.

Special Characters/Wildcards
The asterisk ( * ) and the exclamation mark ( ! ) are referred to as wildcard characters. Use them to substitute
a letter or letters in words.
*

Replaces a single character. You can use more than one * in a word and you can use it anywhere in a word
except as the first letter.
Example:
analy*e finds both the American spelling analyze or the British spelling analyse

!

Replaces an indefinite number of characters at the end of a word.
Example:
litigat! finds variations of the word: litigate--litigator, litigated, litigation, litigating, etc.
Tip:

Words that work best with ! are those that are unique in their truncated form.
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Federal Criminal Courts Search
Using the Federal Criminal Courts search, you can query whether a person or company has been involved in
a federal criminal court matter. Results include both party names and whether the search subject is the
plaintiff or defendant, the type of case, and the jurisdiction.
This search supports Boolean connectors within fields to provide even more precision.

Locating Federal Criminal Court Records
You can search for criminal court records using the following criteria:
Last Name
State
First Name
Additional Terms
Company
Case Number
Case Name
Use the Date drop-list to select a date range to search or provide a range in the From and To fields.

Helpful Search Tips
Searching by Last Name or Company Name

Type the Last Name in the Last Name field, then click on the SEARCH button. If more records are
returned than are practical to review, refine your search by adding more criteria. If you are unsure of the
spelling, you can use the Boolean connector OR. For example, SMITH OR SMYTHE.
Refining a Search by date

Adding a date range refines a search. The smaller the date range you provide, the more precise (narrow) the
results will be.
Expanding the list of results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., State).

Finding a record in the displayed list
Identify the number of unique records by examining the information displayed. Examine the records to determine if the
displayed information fits what is known about the Subject.

Once you locate a record of interest, click on the
additional information.

icon next to the record to run a report that displays
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Using Boolean Connectors
Use Boolean search techniques to fine-tune your search using words and connectors to create phrases and
concepts based on specific rules of search logic.
Use Boolean Connectors to establish logical relationships between words. You can combine multiple
connectors in a search to produce results including only articles of interest. The following is a list of
supported connectors:
OR

Returns items containing either word. Words entered in entry fields are implicitly joined by the AND connector.
Therefore, to include or exclude a document with either of two words, you must use the OR connector.
Example:
doctor OR physician finds items containing either doctor or physician.

PRE/n

Returns items containing both words where the first word precedes the second word within n number of words.
Use this connector when different word order would change the meaning.
Example:
eastern PRE/2 air or airlines finds items with Eastern Air or Eastern Airlines without including “warm air from
east.”

W/n

Returns items containing both words where two words are within n words of each other regardless of order.
Example:
doctor w/5 malpractice finds items with doctor within five or fewer words of malpractice, regardless of which
word appears first.

W/p

Returns items with both words in the same paragraph.
Example:
doctor W/p malpractice finds doctor in the same paragraph as malpractice.
NOTE: The W/p connector cannot be combined with the W/n connector.

W/s

Returns items with both words in the same sentence.
Example:
doctor w/s malpractice finds doctor in the same sentence as malpractice.
NOTE: The W/s connector cannot be combined with the W/n connector.

AND

Returns items with both words anywhere in the same document. Words entered in entry fields are implicitly
joined by the AND connector. Therefore, to include or exclude a document with either of two words, you must
use the OR connector.
Example:
doctor and malpractice -- finds both doctor and malpractice anywhere in the same document.

Special Characters/Wildcards
The asterisk ( * ) and the exclamation mark ( ! ) are referred to as wildcard characters. Use them to substitute
a letter or letters in words.
*

Replaces a single character. You can use more than one * in a word and you can use it anywhere in a word
except as the first letter.
Example:
analy*e finds both the American spelling analyze or the British spelling analyse

!

Replaces an indefinite number of characters at the end of a word.
Example:
litigat! finds variations of the word: litigate--litigator, litigated, litigation, litigating, etc.
Tip:

Words that work best with ! are those that are unique in their truncated form.
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Official Records Search
Official Records can be several different types of documents but are generally defined as those instruments required or
authorized to be recorded at the county level.
Document types you might find in an Official Records Search may include, but are not limited to:
Affidavits
Bonds
Declaration of Condominium
Deed
Judgment
Marriage Record
Mortgage
Orders
Power of Attorney
Restrictions

Agreements
Certificates
Court Paper
Easement
Lien
Military Discharge
Notices
Partial Releases
Probate Documents
Satisfactions

Assignments
Copies of Court Judgments
Death Certificate
Financing Statement
Lis Pendens
Modifications
Plat Related
Releases
Terminations
Transfers

Locating Official Records
You can search for Official Records using the following criteria:








Last Name
First Name
Middle Name
Company Name
County
State
Filing Date Range

Helpful Search Tips
Searching by Last Name

On the Official Records tab, type the Subject's Last Name in the Last Name field, then CLICK on the
Search button. If more records are returned than are practical to review, refine your search as described
below.
Refining a Name Search
Adding criteria, such as first name, middle name, or middle initial refines a search. Keep in mind that some records may
not contain a middle name or initial, so providing one could eliminate records you may want included.
Search by Company

On the Official Records tab, type the name of the Company in the Company Name field, and then CLICK
on the Search button. You may also type any part of the Company’s name, and all records containing that
information will be produced. This returns records belonging to that Company. If more records are returned
than practical to review, refine your search as described below.
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Modifying the List of Results
Narrowing Your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add
the Subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.



State - If your results return multiple listings with the same first and last name from multiple states, add
the state in which you believe the Official Record was filed.



County - If your results return multiple listings with the same first and last name within a single state,
add the County.



Filing Date Range – If your results return multiple listings with the same first and last name

Expand List of Results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
name or initial).

Find a Record in the Displayed List
Identify the number of unique individuals by examining the information listed. Examine the records to determine if the
displayed information fits what is known about the Subject. CLICK on the icon on the right to display the complete
record on the selected individual.
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Marriages & Divorces Search
Marriage and Divorce Records are available for the jurisdictions and year ranges listed in the Coverage Areas,
and can be searched by name, name and location, or filing number.

Locating Marriage and Divorce Records
You can search for Marriage and Divorce Records using the following criteria:







LexID® (If you know the subject's LexID®, no other search criteria is required.)
Last Name
First Name
Filing Number
County
State

Helpful Search Tips
Searching by Last Name

On the Marriage and Divorce tab, type the Subject's Last Name in the Last Name field, then CLICK on the
Search button. If more records are returned than are practical to review, refine your search as described
below.
Refining a Name Search

Adding criteria, such as first name, middle name, or middle initial refines a search. Keep in mind that some
records may not contain a middle name or initial, so providing one could eliminate records you may want
included.

Modifying the List of Results
Narrowing Your Search

If your search returns a long list of results, we recommend adding the following criteria, if known, in this
order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.



Middle Name or Initial - If your results return multiple listings with the same first and last name, add
the Subject's middle name or initial. Remember that some records do not contain middle names or initials
and will be excluded.



State - If your results return multiple listings with the same first and last name from multiple states, add
the state in which you believe the Marriage or Divorce was filed.



County - If your results return multiple listings with the same first and last name within a single state,
add the County.

Expand List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial).
Find a Record in the Displayed List

Identify the number of unique individuals by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the Subject.


Click on the
icon or the link on the corresponding line and follow the prompts to run a Custom
Comprehensive Report.
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USA PATRIOT Act Search
It is common practice for institutions and government agencies around the country to match their existing
and potential clientele against the Office of Foreign Asset Control's (OFAC) list of known and suspected
terrorists and other "watch lists." The USA PATRIOT Act Search allows you to search the OFAC list, the
United Nations Named Terrorist list, the US Bureau of Industry and Security Denied Entity and Person lists,
and several others.

Locating USA PATRIOT Act List Records
You can search for records within the various Identity Validation data sources using the following criteria:




Last Name / Company /Vessel (or partial name)
First Name
Middle Initial

Click on the Coverage Area option in the Help menu to see a list of data sources included within the search.
Results may include: Full Name, Address, Source, and Remarks (e.g., Date of Birth, Expiration Date, Place of
Birth, Vessel Owner, and Vessel Type).
To find a record within the Watch List data sources, try using the following techniques:


Search by Name, Vessel name, or Company. You can also use a partial name.



Select Type: Individual, Non-individual, or Both



Check the OFAC Only checkbox to only search Office of Foreign Asset Control records.



Set threshold. This determines how exact a match must be found to be included in results. 1.00 limits to
an exact match. The default is .80 (80%).

Helpful Search Tips
Searching By Last Name

Type the subject's Last Name in the Last Name/Company field, then click on the SEARCH button. You
may also type any part of the subject’s name, and all records containing that information will be produced. If
more records are returned than are practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as First Name, Middle Name, or Middle Initial refines a search. Keep in mind that
some records may not contain a middle name or initial, so providing one could eliminate records you may
want included.
Searching By Company

Type the name of the Company in the Last Name/Company field, then click on the SEARCH button.
You may also type any part of the company’s name, and all records containing that information will be
produced. This returns records belonging to that company. If more records are returned than are practical to
review, refine your search as described below.
Searching By Vessel

Type the Vessel Name in the appropriate field, then click on the SEARCH button. If more records are
returned than are practical to review, refine your search as described below.
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Modifying the List of Results
Narrowing List of Results

If a list of results is displayed but more records were returned than are practical to review, try narrowing the
list of results by adding search criteria. We recommend adding the following criteria, if known, in this order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the
first few letters in the First Name field.



Middle Name or Initial - If your results return multiple listings with the same first and last
name, add the subject's middle name or initial. Remember that some records do not contain
middle names or initials and will be excluded.

Expanding List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial).
Finding Records in the Display List

Identify the number of unique individuals by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
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Sexual Offenders Search
The Sexual Offender Search allows a user to search by name, social security number, or address to find
records in an integrated database of sexual offenders. This information comes from the Sexual Offender
Registries maintained by certain states.
When available, a person’s Sexual Offender image will display in the corresponding Sexual Offender report.
Since this is publicly available information, all users have access to view Sexual Offender images.

Locating Sexual Offender Records
You can search for Sexual Offender records using the following criteria:
 LexID®
 State
 Last Name
 Zip
 First Name
 Radius around Zip
 Middle Name
 Scars/Marks/Tattoos (this input only
affects the sort order of subjects returned)
 SSN
 Offenses
 DOB
(select from list)
 Street Address
 City

Results returned on the Sexual Offender Search vary from state to state, but may include: Name, Address,
Alternate Address, SSN, LexID®, Address Verification Date, and Date Last Seen., Height; Weight; Race;
Offenses; and Scars/Marks/Tattoos.
Click on the Coverage Area option in the Help menu to see a list of areas covered by the search.

 To run a Sexual Offender report, double-click on the

Report icon.

Single character values returned in Data Source field of a Sexual Offender Report are:
F
G
H
P
R
S
blank

Firm
General Delivery
High-rise apartment or office building
Post Office Box
Rural Route or highway contract
Street
Unassigned

To find a Sexual Offender record, try using one or more of the following search techniques:


Search by Name. You can also use a partial first name.



Search by SSN.



Search by Address. This returns all records for the specified address.



Search by City and State only. This returns all records for the specified city and state.



Search by Zip code only. This returns all records for the specified zip code.



Search by Name and Address. This returns records for the listed name at the specified address.



Search by Name, City, and State. This returns records for the listed name in the specified city and state.



Search by Name and Zip code. This returns records for the listed name within the specified zip code.



Search by Name and DOB. This returns records for the listed name with the specified DOB.
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Helpful Search Tips
Searching By Last Name

Type the subject's Last Name in the Last Name field, then click on the SEARCH button. If more records
are returned than are practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as First Name, Middle Name, or Middle Initial refines a search. Keep in mind that
some records may not contain a middle name or initial, so providing one could eliminate records you may
want included.
Searching By Address

Type the Address, City, and State in the appropriate fields, then click on the SEARCH button. This returns
records using that address. If more records are returned than are practical to review, refine your search as
described below. To view results for an entire city, only put in the city and state. If you are unsure of the
exact city, supply the closest city and specify a radius (no more than 100 miles). This expands the area
considered to a circle extending the specified number of miles from the center of that city. If you do not
include a city name, the radius option is not allowed. To view results for an entire zip code, only put in the zip
code.
Searching using a Partial DOB

The DOB field supports partial dates such as MM/YYYY or YYYY. If you do not know the complete date,
you can search using the known portion. For example, 06/1955 would match subjects born in June of 1955.
You can also provide only the year. If you type the two digit month and four-digit year, you can omit
punctuation (. or /) and it will automatically format for you when you move to the next field.

Modifying the List of Results
Narrowing List of Results

If a list of results is displayed but more records were returned than are practical to review, try narrowing the
list of results by adding search criteria. We recommend adding the following criteria, if known, in this order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the
first few letters in the First Name field.



Middle Name or Initial - If your results return multiple listings with the same first and last
name, add the subject's middle name or initial. Remember that some records do not contain
middle names or initials and will be excluded.



City and State or Zip Code and/or Radius - If your results return multiple listings with the
same first and last name, add the City and State or the Zip Code and/or zip code Radius.

Expanding List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial).
Finding Records in the Display List

Identify the number of unique individuals by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
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Advanced Sexual Offender Search
The Advance Sexual Offender Search allows a user to search by name, social security number, date of birth or
address to find records for registered sex offenders.
In addition, you can run a radius around a city or zip code. In addition to Registered addresses that appear in
the regular Sexual Offender Search, this search can also return Unregistered, Historical, and Associated
addresses. This search is not available to all users.
Click on the

icon next to a returned record to return a Sexual Offender Report on any individual.

Locating Sexual Offender Records
You can search for Sexual Offender records using the following criteria:











LexID®
Last Name
First Name
Middle Name
SSN
Date of Birth
Street Address
City
State
Zip








Radius around Zip
Radius around an address
Age Range
Scars/Marks/Tattoos (this input only
affects the sort order of subjects
returned)
Offenses
(select from list)

Results returned on the Advanced Sexual Offender Search vary from state to state, but may include: Name,
Address, Source, DOB, AKAs, SSN, LexID®,Date Last Seen, Height; Weight; Race; Offenses; and
Scars/Marks/Tattoos.
Click on the Coverage Area option in the Help menu to see a list of areas covered by the search.

 To run a Sexual Offender report, double-click on the

Report icon.

Single character values returned in Data Source field of a Sexual Offender Report are:
F
G
H
P
R
S
blank

Firm
General Delivery
High-rise apartment or office building
Post Office Box
Rural Route or highway contract
Street
Unassigned
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To find a Sexual Offender record, try using one or more of the following search techniques:


Search by Name. You can also use a partial first name.



Search by SSN.



Search by Address. This returns all records for the specified address.



Search by City and State only. This returns all records for the specified city and state.



Search by Zip code only. This returns all records for the specified zip code.



Search by Name and Address. This returns records for the listed name at the specified address.



Search by Name, City, and State. This returns records for the listed name in the specified city and state.



Search by Name and Zip code. This returns records for the listed name within the specified zip code.



Search by Zip Code and Radius. This returns all records within the specified radius around the
geographical center of that zip code.



Add an Age Range to limit results to subjects within a certain range of ages.



Search by Address and Radius. This returns all records within the specified radius around the address.



The Restrict to Zip checkbox filters out Registered records from outside the submitted Zip Code.
(Only available in the non-rollup view.)

Finding a Record in the Displayed List

Results are displayed in a rollup or “card” view. Each row is one individual and all associated records are
displayed when the record is selected by clicking on it.
To run a Custom Comprehensive report,
click on the icon.

Select a row to expand the record
to card view. Ctrl+click to close the
row.

Click to expand all rows. You
can also expand rows from the
rt-click menu.
Right-click and select Collapse All
Rows to close expanded views for
all rows. Select Expand All Rows to
see the expanded view for all rows.
Data portions of screens in this manual are intentionally blurred.

Identify the number of unique records by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the subject.
To print or save your result list from this search, see Saving and Printing Results on page 26.
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Mapping Results

As with most searches, you can map the results of this search. This is of particular value in this search when
attempting to determine addresses of interest relative to the address of a victim . To send the results to a
map, select part or all of the results and send or drag the results to Accurint Mapping or Google Maps.
Icons will appear showing the addresses as R, U, H or A depending upon whether the addresses are
Registered, Unregistered, Historical, or Associated.
By mapping the victim’s address or crime scene locations in the same window, it is clear which addresses are
in closest proximity. Right-clicking on any icons will show the name and address of the associated subject.
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Exporting a Result List

You can save the list of results to an XML file. This can be opened in any XML viewer or a spreadsheet
application such as Excel. To open an XML file in Excel:

 Rt-click on your result list.
 Select Save List As -> XML.
 Provide a name for the file and press the Save button

 In Excel ,select Open from the File menu.
 Set the file type to XML Files

 Select the file you just saved, then press the Ok button
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Advanced Sex Offender Solution (ASOS)
The LexisNexis Advanced Sex Offender Solution (ASOS) offers a nationwide tracking system on movement
and other information relating to registered and non-compliant sex offenders.
This feature provides weekly comprehensive reporting for sex offenders in counties you are monitoring –
providing information about where they have moved from and to along with best known contact
information.

Select the File to Download
Use the drop list to select the state file to download or find the file you want in the list. Select All States
and press the Find button to redisplay the full list.

 Click on the name of the desired file.
 In the File Download window, press the Save button.

 In the Save As window, select a location for the file, press the Save button.
Note: The files on this screen can be downloaded as many times as needed.
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Criminal Records Search
The Criminal records search provides the ability to search by name or social security number to find a
person’s criminal record information. Only data integrated into the system is available for queries.
When available, a person’s DOC picture will display in the square on the right side of the query window (if
you have system privileges to view images).

Locating Criminal Records
You can search Criminal records using the following criteria:








LexID®
Last Name
First Name
Middle Name
SSN
Street Address
City









State
Zip
County
DOB
DOC Number
Group (multiselect available)
Category (multiselect available)

Results vary from state to state but may return the following information:
Name, Address, County, Date of Birth, Place of Birth, SSN, DOC Number, Offense State, Data Source, Last
Seen Date, and Digital DOC image.
Click on the Coverage Area option in the Help Menu to see a list of areas covered by the search.
To find a criminal convictions record, try using one or more of the following search techniques:


Search by Name. You can also use a partial first name.



Search by Name and DOB. This returns records for the listed name with the specified date of birth.



Search by DOC Number, if known.



Search by Name, State. This returns Court Records information for the listed name within the County
and State requested.



Search by Address, City and State. This returns records containing the requested address.

You can run a report that includes all the available Criminal data by clicking the

icon on a record’s row.
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Helpful Search Tips
Searching by Last Name
Type the Subject's Last Name in the Last Name field, then click on the SEARCH button. If more records are returned
than are practical to review, refine your search as described below.

Refining a Name Search
Adding criteria, such as first name, middle name, or middle initial, refines a search. However, searches in some states will
not produce the information you are seeking if the search criteria you have entered is not a recognized field.
Keep in mind that some records may not contain a middle name or initial, so providing one could eliminate records you
may want included.

Filter by Offense Group or Category
Use the Group and/or Category drop lists to filter results to only include records for offenses that match the selected
Groups and/or Categories. Use the checkboxes in the drop list to multiselect.
To return all records, clear all the checkboxes in the Group and Category drop lists.
Searching by DOC Number
Type the subject's DOC number in the appropriate field, then click on the SEARCH button. This returns records for
the subject with the specified DOC Number.

Searching by Address
Type the Address, City, and State in the appropriate fields, then click on the SEARCH button. This returns records
using that address. If more records are returned than are practical to review, refine your search as described below.

Modifying the List of Results
Narrowing Your Search
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:


First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few
letters in the First Name field.

Middle Name or Initial - If your results return multiple listings with the same first and last name, add the
subject's middle name or initial. Remember that some records do not contain middle names or initials and
will be excluded.

Expanding the list of results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
name or initial).

Finding a record in the displayed list
Identify the number of unique individuals by examining the information listed. Examine the records to determine if the
displayed information fits what is known about the subject.
.
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Jail Booking Search
The Jail Booking Search and Report allows you to search for Jail Booking records from thousands of sources.
Search for an individual based on SSN, Driver’s License Number, or Full Name and complete Date of Birth,
and it returns matching records, if any are found.
You can then select an individual and request a Jail Booking Report, which provides details of each arrest for
that individual.
The Jail Booking Report includes detailed information about the arrest, incarceration, release, and charges
when available.
Locating Jail Booking
Search for Jail Bookings records using combinations of the following criteria:





Last Name
First Name
Middle Name
Date of Birth






SSN
Driver’s License Number
State
Zip

Use the following minimum criteria to search for Jail Booking records:
 Last Name, First Name, and full DOB
 9-digit Social Security Number
 Driver’s License Number

To run a Jail Booking report, click on the

Report icon.

Helpful Search Tips
If you know the subject's SSN or Driver’s License number, no other search criteria are required.


Jail Booking Report
A Jail Booking Report provides details for each arrest for an individual. The information returned varies
based upon the arrest and source of the data, but could include:







Subject Details (such as, Name(s), telephone number(s), and Addresses)
Arrest Details (such as, Arrest Date, Booking Date, Arresting Agency information, etc.)
Incarceration Details
Release Details
Other Details
Charges
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Foreclosures Search
Foreclosure Records are available for the locations listed in the Coverage Areas, and can be searched by
name, company, and/or address.

Locating Foreclosure Records
You can search for Foreclosure Records using the following criteria:











LexID®
Last Name
First Name
Middle Name
SSN
Company Name
Street Address
City
State
Zip

Click on the

icon next to a returned record to run a report that displays additional information.

Helpful Search Tips
Searching by Last Name

On the Foreclosure tab, type the Subject's Last Name in the Last Name field, then CLICK on the Search
button. If more records are returned than are practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as first name, middle name, or middle initial refines a search. Keep in mind that some
records may not contain a middle name or initial, so providing one could eliminate records you may want
included.

Modifying the List of Results
Narrowing Your Search
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:
 First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few letters
in the First Name field.
 Middle Name or Initial - If your results return multiple listings with the same first and last name, add the
Subject's middle name or initial. Remember that some records do not contain middle names or initials and will
be excluded.
 City - If your results return multiple listings with the same first and last name from multiple cities within a
state, add the city in which you believe the subject lived.
 State - If your results return multiple listings with the same first and last name from multiple states, add the
state in which you believe the subject lived.
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Expand List of Results

If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria
(e.g., middle name or initial, or street address or city).
Find a Record in the Displayed List

Identify the number of unique individuals by examining the information listed. Examine the records to
determine if the displayed information fits what is known about the Subject. CLICK on the icon on the right
to display the complete record on the selected individual.

Accurint for Law Enforcement Plus
User’s Guide | 163
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

National Motor Vehicle Accidents Search
Accident Records can be searched by name, SSN, company, address, and/or other information.

Locating Accident Records
You can search for Accident Records using the following criteria:










LexID®
Last Name
First Name
Middle Name
Company Name
Street Address
City
State
Zip







Accident Number
Accident State
License Number
VIN
Tag Number

You can run a report that displays additional information by clicking on the

report icon.

Helpful Search Tips
Searching by Last Name

Type the Subject's Last Name in the Last Name field, then CLICK on the Search button. If more records are
returned than are practical to review, refine your search as described below.
Refining a Name Search

Adding criteria, such as first name, middle name, or middle initial refines a search. Keep in mind that some
records may not contain a middle name or initial, so providing one could eliminate records you may want
included.
Accident or Vehicle Information

If information specific to the accident is known, such as the Accident Number, DL Number, VIN, or Tag
Number, add this with limited name/address information.

Modifying the List of Results
Narrowing Your Search
If your search returns a long list of results, we recommend adding the following criteria, if known, in this order:
 First Name or First Initial - If you are not sure of the entire first name, type an initial or the first few letters
in the First Name field.
 Middle Name or Initial - If your results return multiple listings with the same first and last name, add the
Subject's middle name or initial. Remember that some records do not contain middle names or initials and will
be excluded.
 City - If your results return multiple listings with the same first and last name from multiple cities within a
state, add the city in which you believe the subject lived.
 State - If your results return multiple listings with the same first and last name from multiple states, add the
state in which you believe the subject lived.
Expand List of Results
If too few or no results are returned, loosen the criteria by removing the most precise or uncertain criteria (e.g., middle
name or initial, or street address or city).
Find a Record in the Displayed List
Identify the number of unique individuals by examining the information listed. Examine the records to determine if the
displayed information fits what is known about the Subject. CLICK on the icon on the right to display the complete
record on the selected individual.
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Advanced Person Search Batch
The Advanced Person Search Batch service allows you upload a file (with a maximum of 200,000 records) of
subject information and retrieve the best known information for each subject including: full name, social
security number, date of birth, up to three addresses with phone numbers, and deceased information.
The input file can be in delimited, such as comma separated (csv), or fixed-length format, and can include
LexIDs, Full Name, First Name, Middle Name, Last Name, Generational Suffix, DOB, SSN, Address, City,
State, ZIP, Phone Numbers, Driver’s License Number, Driver’s License States. If a unique individual can be
identified based on the input data, the best known information for the subject is returned.
Select the File to Upload

The first step allows you to select the batch file for processing.

 Provide an alphanumeric string in the File Reference Name field (required).
This is displayed later as the Job Name on the Batch Confirmation page and later in the
list of results.
 Press the Browse... button for the Upload Path/Filename field (required).
The Choose file dialog box displays.
 Locate and select the batch file to submit and press the Open button.
The file path displays in the Upload Path/Filename field.
The file cannot contain more than 200,000 records. The number of records in the file is
used to calculate the cost of batch processing (shown on the Batch Confirmation
screen).
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 Check the appropriate radio button for File Type.
o

ASCII Fixed Width if the file contains simple text using fixed width fields.
Fixed width files are those in which each column (or field) of data is a fixed
number of characters wide. In a fixed width file, delimiters are not used to
separate columns.

o

ASCII Delimited if the file is delimited.


Comma if the fields are separated by commas (usually has a .csv
extension)



Tab if the input fields are separated by tabs



Pipe if the input fields are separated by the pipe character (|).

 Enter the Email Address for Batch Notification (required).
An email is sent to this address when the batch processing is complete.
Note:

The system does not check if the email address is valid and working.
Please be careful when you enter this email address.

 Re-enter the email address to Confirm Email Address.
 Press the Next button.
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Define Field Labels

In this step, you map your file’s columns to the batch process input.

For Fixed Length Text File:

In this type of file, each record has exactly the same length.
If you select ASCII Fixed Width for file type, the Define Field Labels screen shows the beginning and
ending positions (represented by numbers) of each field.


Check the box YES if the first row of the batch file is a title row that contains the text
descriptions of the corresponding fields.
The service calculates the charge by deducting one from the row number. Ignore this box
if the first row contains data.

 If you have a saved layout, select one from the Select Template from List droplist. You
are prompted to confirm.
 Use the down arrow in each column to display a list of pre-defined data types, select one
that matches the data for each column.
For example, if the data in a column is the last names, you should select Last Name. If
none of the labels in the list applies to the data in a column, select Not Applicable. This
allows the system ignore it.
 Use the down arrow by Start to select the beginning position of the field.
 Use the down arrow by End to select the ending position of the field.
Note: You need to count in all the reserved spaces for a field. For example, if the
reserved spaces for the Last Name is 15, even though in the actual file the longest last
names takes only 12 spaces, you still set the Start as 1 and End as 15.
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Click on Add New Field and follow the same steps for the next column. Repeat for all
columns.

 To save this field mapping as a template you can use later, provide an alphanumeric
string in the Save This Template File Layout (Optional) field.
 Press the Next button to proceed to the next step.
For ASCII Delimited File
If your file type is ASCII Delimited:

Check the box YES if the first row of the batch file is a title row that contains the text
descriptions of the corresponding fields.
 The service calculates the charge by deducting one from the row number. Ignore this box
if the first row contains data.



 If you have a saved layout, select one from the Select Template from List droplist. You
are prompted to confirm.
 Use the down arrow in each column to display a list of pre-defined data types, select one
that matches the data for each column.
For example, if the data in a column is the last names, you should select Last Name. If
none of the labels in the list applies to the data in a column, select Not Applicable. This
allows the system ignore it.
 Repeat the steps above for the remaining columns.
 To save this field mapping as a template you can use later, provide an alphanumeric
string in the Save This Template File Layout (Optional) field.
 Press the Next button to proceed to the next step.
Permitted Use Certification, DPPA Compliance, and dmf compliance
On the next few screens, you must select the proper




Permitted Use Certification (also referred to as GLB Purpose)
DPPA Compliance and Secondary DPPA Purpose (also referred to as DPPA Purpose)
DMF Compliance to proceed.
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Order Confirmation Summary

This step allows you to confirm your order (including the estimated cost) before submitting. If you want to
change anything, you can press the Back button.

 Press the Authorize Order button to complete the order.
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Retrieving Results

After you receive email notification that your results are ready, you can retrieve the results from the Report
Manager section of My Account.

 Click on the View Batch Results link under Report Manager in My Account.
You may be prompted to Verify Password if this is the first time you try to access My
Account in this session.

 Select your job from the list of Batch Results.


Click the

icon next to the job you want under Download Results.

The File Download dialog displays.
 To view, click Open. To save it, click Save.
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Real-Time Phones Batch
The Real-time Phones Batch service allows you upload a file (with a maximum of 200,000 records) of subject
information and search data that will help determine subjects' names and location based on phone number
and person queries including phone type, phone status, carrier details, and porting information.
The input file can be in delimited, such as comma separated (csv), or fixed-length format, and can include
LexIDs, Full Names, First Names, Middle Names, Last Names, Generational Suffixes, DOBs, SSNs,
Addresses, City, State, ZIP, Phone Numbers, Driver’s License Numbers, Driver’s License States. If a unique
individual can be identified based on the input data, the best known information for the subject is returned.
Select the File to Upload

The first step allows you to select the batch file for processing.

 Provide an alphanumeric string in the File Reference Name field (required).
This is displayed later as the Job Name on the Batch Confirmation page and later in the
list of results.
 Press the Browse... button for the Upload Path/Filename field (required).
The Choose file dialog box displays.
 Locate and select the batch file to submit and press the Open button.
The file path displays in the Upload Path/Filename field.
The file cannot contain more than 200,000 records. The number of records in the file is
used to calculate the cost of batch processing (shown on the Batch Confirmation
screen).
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 Check the appropriate radio button for File Type.
o ASCII Fixed Width if the file contains simple text using fixed width fields.
Fixed width files are those in which each column (or field) of data is a fixed
number of characters wide. In a fixed width file, delimiters are not used to
separate columns.
o ASCII Delimited if the file is delimited.


Comma if the fields are separated by commas (usually has a .csv
extension)



Tab if the input fields are separated by tabs



Pipe if the input fields are separated by the pipe character (|).

 Enter the Email Address for Batch Notification (required).
An email is sent to this address when the batch processing is complete.
Note:

The system does not check if the email address is valid and working.
Please be careful when you enter this email address.

 Re-enter the email address to Confirm Email Address.
 Press the Next button.
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Define Field Labels

In this step, you map your file’s columns to the batch process input.

For Fixed Length Text File:

In this type of file, each record has exactly the same length.
If you select ASCII Fixed Width for file type, the Define Field Labels screen shows the beginning and
ending positions (represented by numbers) of each field.


Check the box YES if the first row of the batch file is a title row that contains the text
descriptions of the corresponding fields.
The service calculates the charge by deducting one from the row number. Ignore this box
if the first row contains data.

 If you have a saved layout, select one from the Select Template from List droplist. You
are prompted to confirm.
 Use the down arrow in each column to display a list of pre-defined data types, select one
that matches the data for each column.
For example, if the data in a column is the last names, you should select Last Name. If
none of the labels in the list applies to the data in a column, select Not Applicable. This
allows the system ignore it.
 Use the down arrow by Start to select the beginning position of the field.
 Use the down arrow by End to select the ending position of the field.
Note: You need to count in all the reserved spaces for a field. For example, if the
reserved spaces for the Last Name is 15, even though in the actual file the longest last
names takes only 12 spaces, you still set the Start as 1 and End as 15.


Click on Add New Field and follow the same steps for the next column. Repeat for all
columns.
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 To save this field mapping as a template you can use later, provide an alphanumeric
string in the Save This Template File Layout (Optional) field.
 Press the Next button to proceed to the next step.
For ASCII Delimited File
If your file type is ASCII Delimited:

Check the box YES if the first row of the batch file is a title row that contains the text
descriptions of the corresponding fields.
 The service calculates the charge by deducting one from the row number. Ignore this box
if the first row contains data.



 If you have a saved layout, select one from the Select Template from List droplist. You
are prompted to confirm.
 Use the down arrow in each column to display a list of pre-defined data types, select one
that matches the data for each column.
For example, if the data in a column is the last names, you should select Last Name. If
none of the labels in the list applies to the data in a column, select Not Applicable. This
allows the system ignore it.
 Repeat the steps above for the remaining columns.
 To save this field mapping as a template you can use later, provide an alphanumeric
string in the Save This Template File Layout (Optional) field.
 Press the Next button to proceed to the next step.
Permitted Use Certification, DPPA Compliance, and dmf compliance
On the next few screens, you must select the proper




Permitted Use Certification (also referred to as GLB Purpose)
DPPA Compliance and Secondary DPPA Purpose (also referred to as DPPA Purpose)
DMF Compliance to proceed.

Accurint for Law Enforcement Plus
User’s Guide | 174
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Order Confirmation Summary

This step allows you to confirm your order (including the estimated cost) before submitting. If you want to
change anything, you can press the Back button.

 Press the Authorize Order button to complete the order.
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Retrieving Results

After you receive email notification that your results are ready, you can retrieve the results from the Report
Manager section of My Account.

 Click on the View Batch Results link under Report Manager in My Account.
You may be prompted to Verify Password if this is the first time you try to access My
Account in this session.

 Select your job from the list of Batch Results.


Click the

icon next to the job you want under Download Results.

The File Download dialog displays.
 To view, click Open. To save it, click Save.
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Online Batch Services
The Online Batch Services feature allows you to submit online batch order requests. Once the batch process
completes, you are notified and can download your results.
Online Batch Services helps you locate subjects, speed workflow, improve productivity ,and increase
efficiency by processing multiple records at once. Flexible search options and multi-sourced data help you to
research people, phones, and addresses quickly and cost-effectively.

Common Steps
This section describes the steps that apply to all online batch services.
Select the Batch Service(s)

 Check the box(es) for one or more of the batch services you wish to run.
The available products vary based on your account settings.
 Press the Next Button.
Enter Job Details

This allows you to select the batch file for processing and specify job-specific information. cd

 Enter a name in the Job Name field.
This is required. The Job Name is later referenced on the Confirmation page and will also
help you identify results.
 Enter a Notification Email Address.
An email is sent to this address when the batch processing is complete. This is required.
 Re-enter the email address in the Confirm Email Address text box.
 Select the Input File Type.


Fixed Width--The file contains simple text using a fixed column width.



Comma Delimited--The file contains fields separated by a comma.



Tab Delimited-- The file contains fields separated by tabs



Pipe Delimited-- The file contains fields separated by pipe character (|)

 Press the Choose File button to select the file for the File to Process field.
The File Upload/Open dialog box displays.
 Locate the batch file to submit and press the Open button.
The file path displays in the Input File field.
The number of records in the file is used to calculate the cost estimate of batch
processing, which is shown in Batch Confirmation.
NOTE: The file cannot contain more than 200,000 records.
 Press the Next button to proceed to the next step.
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Define Field Labels

In this step, you define the data type for each of the columns in the batch file. This is also known as field
mapping.
Fixed Length Text File

 If you select Fixed Width for file type, the Define Field Labels screen shows the
beginning and ending positions (represented by numbers) of each field.
 Use the down arrow to display a list in the Choose a Template field.
This is applicable only if you have saved layouts (entered a template name in a previous
job). If this is your first time processing a batch file, or if you never saved any layout
from the previous jobs, the list will be empty.
If you select a template from the saved list, you are prompted for confirmation.
 Press the OK button to confirm the selection.
Note: To delete a template that is no longer needed, press the Delete Selected Template
button.

 Enter a Template Name if you want to save the Field labels for future use.
 Select the YES radio button if the first row of the batch file is a title row that contains the
text descriptions of the corresponding fields. Select NO if the first row contains data.
 Use the down arrow in Column 1 to display a list of pre-defined data types and select one
that is proper for the data in this column.
For example, if the data in this column is the last names, you should select Last Name.
 Use the down arrow by Start to select the beginning position of the field.
 Use the down arrow by End to select the ending position of the field.
Note: You need to count in all the reserved spaces for a field.
 Press the Add New Field button.
Column 2 appears below Column 1.
 Use the down arrow by Column 2 to select the data type for the second field.
If none of the labels in the list applies to the data in a column, select Not Applicable.
This allows the system to return this data field but ignore it to locate your subjects.
 Repeat the previous steps to set the Start and End positions for the second field.
 Repeat the steps above until you are done with all the fields in the file.
 Press the Next button to proceed to the next step.
For Delimited File

 Check the box YES if the first row of the batch file is a title row that contains the text
descriptions of the corresponding fields. Check No if the first row contains data.
 Use the down arrow to display a list in the Select Template from List field.
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This is applicable only if you have saved layouts (entered a template name in a previous
job). If this is your first time processing a batch file, or if you never saved any layout
from the previous jobs, the list will be empty.
If you select a template from the saved list, you will be prompted for confirmation.
 Select the OK button to confirm the selection.
Note: To delete a template that is no longer needed, press the Delete Selected Template
button.

 Use the down arrow in Column 1 to display a list of pre-defined data types and select one
that matches the data in this column.
For example, if the data in this column is the last names, you should select Last Name.
These differ with each batch service.
 Repeat the last step for the remaining columns.
If none of the labels in the list applies to the data in a column, select Not Applicable.
This allows the system to return the data field but ignore it to locate your subjects.
 Enter a name in the Template Name field to save the template.
Once you save a template, the data types defined are saved for future use.
 Press the Next button to proceed to the next step.
Permitted Use Certification, DPPA Compliance, and DMF Compliance

You must confirm the proper Permissible Use Certifications are correct by selecting Yes or No.
If you select No, click on the Edit Permissible Use link and declare the appropriate GLB, DPPA,
Secondary DPPA, and DMF Purpose to use for the batch query.

Batch Confirmation
This page allows you review the batch settings and options, input file name and format, email address for
notification, and the approximate cost of this job. If any information needs to be edited, you can press the
Back button until you reach the desired page.

 Once the information is correct, press the Authorize Order button.
A summary page with your batch job confirmation number and other batch output details
displays.
 To print the information on the screen, press the Print Order Confirmation button.
 To run another batch job, press the Run Another Batch button to return to the main
Batch Services page.

View and Download the Output File
Batch output files are stored in the Report Manager tab of My Account.

 Click the Batch Output link under My Account.
 If prompted, enter your password and press the Continue button.
The Batch Results page of the Report Manager displays. All of your batch results are
listed.
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 Select the result you want and click on the Download Results icon.
The File Download dialog box displays
 To view the file, press the Open button. To save it to your local hard drive, press the
Save button.
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Photo Lineups
You can create photo lineups using Department of Corrections or Sexual Offender photos or any JPEG (*.JPE, *.JPG,
or *.JPEG) files available on your hard drive or disk.

Adding Images
From the Search window, drag a record from the results window to the position on the lineup where the image is to be
placed. Releasing the mouse button drops the picture in that position.
To add a jpeg image from a file,

 Drag the image from your computer’s file explorer (Windows Explorer) to a space in the
LineUp.
Press the Photos+ button to open a side panel. You can drop any number of images into this panel and scroll through
them for review, then choose an image from this panel and drag it to any lineup position. The images in the Photo+
slot do not appear when a lineup is printed.

Saving and Loading LineUps
 Press the

button to open a saved lineup.

 Press the

button to save a lineup for future use.

 Press the

button to clear all images from the current lineup.

 To preserve a snapshot, click on the
details.

button. See Snapshots on page 31 for more

Click to save a
snapshot.

Printing a LineUp
 Press the Print button to print a paper copy of the lineup screen.
Note:

When printing a Photo Lineup, you have the option to remove identifiers (i.e., substituting
numbers corresponding to the image location on the page) by clearing the ‘Print Names’ option in
the Print Preview window.
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Montage
The Montage Window provides another method of viewing photos. Drag-and-drop or send multiple images
to the montage window from Sex Offender, Advanced Sex Offender, or Criminal Records searches. You can
also drag-and-drop records from Advanced Person Search if image display is enabled and an image is found
for the subject.
To populate a Montage from search results:

 Open the Montage window
 Open a search window and conduct the search.
 From the result set, select the records you want to send to the montage, then drag them to
the Montage Tab.
The images automatically load into the montage.
To add an image to a Montage from a file on disk:

 rt-click on the Montage window and select Load from Disk from the pop-up menu.
or
 Drag-and-drop image file(s) from Windows Explorer.
Use the Next and Back buttons at the bottom of the window to scroll through the images. Press the
button to print a copy of the Montage. If you have more than 10 photos, multiple pages print.

Data and Photo portions of screens in this manual are intentionally blurred.
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Mapping
The Mapping window presents a zoom-able map of the United States to present geo-spatial relationships
between data.
Accurint server-based mapping is available to all users of the Accurint LE Plus™ application. The
application is also compatible with Microsoft MapPoint 2002, which is not included with Accurint LE Plus
and must be purchased and installed separately to access this feature.
To map addresses, you must either have a result set displayed in a search window or a data file with addresses
(see Importing Addresses to a map below).

Mapping addresses from Search Results
 Select the records you want to map
 Right-click and select Send to Map (or drag and drop the records onto a Map.)
 The Map window opens and displays the addresses mapped. Each result type mapped
will display a different icon shape and color.
Note:

Mapping software may not be able to map every address. When you run Accurint Mapping, it will
not notify you if an address cannot be mapped.

Importing Addresses to a Map
The Accurint Mapping function provides the ability to batch import addresses from a data file. This allows
you to add locations to a map. Combining locations with other map points can reveal patterns that might
otherwise go unnoticed.
To Import Addresses to a Map

 Press the

button on the Mapping toolbar.

The Accurint Mapping Import Wizard appears

 Press the Next button.
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 On the next screen, press the lookup button to select a file.
Files may contain either fixed length fields or separated values (such as .CSV).

 Press the Next button.
 On the next screen, provide details about the file.
o

Choose either Delimited or Fixed Length.

o

Specify the File Type.

o

If you want to skip rows, specify the number of rows to skip.

o

If Delimited, select the character used to contain text.

o

If the first row contains field labels, check the First Row has column names
box .
A preview of the data displays to assist you.
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 Press the Next button.
 On the next screen, provide details about the delimiter. (This screen does not appear with
fixed length field data files.)
o

Choose Comma, Tab, Semi-colon, or Other. If you select Other, specify the
character.

A preview of the data displays to assist you.

 Press the Next button.
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 On the next screen, select the field mapping. This allows you to specify which fields
contain the address data and also include some fields to be used as labels for the map
pins.
In order for locations to be mapped, addresses must be mapped to appropriate the
address fields (Address to address, city to city, etc.).
Tip:

You can import locations using Latitude and Longitude instead of addresses.

 Optionally, select the style of the map pins. This is the icon that will display on your map.
If you are importing multiple files containing different types of data, this selection can
help differentiate locations on the resulting map.

 Press the Next button.
 The next screen displays while queries are performed and locations are geocoded.
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 Press the Next button.
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 The next screen displays the results of your import, including the number of successes
and failures. This allows you to analyze any failures, fix the data file, and re-import if
important locations did not import properly.

 Press the Finish button.
The Map displays.
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Mapping MainToolbar
The Main toolbar on a Mapping window provides the following functionality:
Open

Allows you to open a saved map. Once open, you can add map points or draw regions on it.

Save

Allows you to save the current map.

Print

Allows you to print the current map.

Copy

Copies the current map to the Windows clipboard.

Clear

Clears all ins and drawn objects on the current map.

Snapshot Preserves a snapshot of the map in your Query History list.

Zooming Toolbar
Zoom out

When selected, drawing a rectangle on the map zooms out to that level

Zoom In

When selected, drawing a rectangle on the map zooms in to that level

Increase Zoom

Click on this button to zoom in.
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Zoom Level
Displays the level of zoom.
Decrease Zoom
Zoom to Pins

Click on this button to zoom out.
Click on this button to zoom to the level that displays all pins on a map.

Accurint for Law Enforcement Plus
User’s Guide | 190
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Data Layers
Data Layers allows you to add map points of locations based on Industry SIC codes. For example, you can
add locations of all Elementary schools within the visible area by selecting that industry code and adding the
matching addresses. This feature is not available to all users.
Note:

You should zoom in to a small region before adding addresses. If the number of addresses is
unreasonably large, it could take a long time to add to your map. In addition, it will produce more
data that you probably want.

To add data:

 Press the


button on the toolbar.

The Address Type palette displays.

 Check the boxes for the address type(s) you want to add to the map.

 Press the Add button
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Drawing Tools in Mapping
The drawing tools in Accurint Mapping allow you to create measured regions on a map. This can aid in
depicting areas of interest and help identify addresses within that region.
For example, you could map the address of a crime scene, draw a one-mile radius circle around it, then map a
list of the addresses of persons of interest. The resulting map would allow you to see at-a-glance which
individuals live within the circle. Of course, the size of the radius depends on the circumstances of your
investigation. The tool affords you the flexibility to define the region you are most interested in and helps you
see geo-spatial relationships between items on your map.
There are four types of shapes you can draw: Circle, Line, Rectangle, and Ellipse.
A line allows you to measure the distance between any two points. A circle allows you to define an area using
a measured radius in miles or feet. A rectangle or ellipse is measured in square miles (or square feet).
To draw a straight line

 In the toolbox, click the Line button
 Drag the pointer to draw the line.
The length of the line is displayed beside the line.
Tip: Use the line tool to measure the distance between two points.
To draw an ellipse

 In the toolbox, click the Ellipse button.
 Drag the pointer to draw the ellipse.
The area of the region is displayed beside the ellipse.
To draw a circle

 In the toolbox, click the Circle button.
 Drag the pointer to draw the ellipse.
The radius of the region is displayed beside the circle.
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To draw a rectangle (or square)

 In the toolbox, click the Rectangle button.
 Drag the pointer diagonally in the direction you want.
The area of the region is displayed beside the rectangle.
Resizing a shape

 Select the region on the map by clicking on it.
 Handles are displayed when an object is selected.
 Grab a handle and drag in the direction you want.

Click and drag a handle to
resize

Viewing Contained Locations

Regions allow you to display a list of addresses contained within it. To see a list of contained locations:

 Select the region on the map by clicking on it.
 Select Contained Locations from the popup menu.
From the resulting list, you can perform actions (such as, Send To) in a similar manner
as any result list.
Line Color

To change the line color of any region:

 Select the region on the map by clicking on it.
 Click on the drop arrow on the

button

 Select the color from the palette.
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Line Thickness

To change the line thickness of any region:

 Select the region on the map by clicking on it.
 Click on the drop arrow on the

button

 Select the width from the drop menu.
Fill Color

To change the fill color of any region:

 Select the region on the map by clicking on it.
 Click on the drop arrow on the

button

 Select the color from the palette.
Opacity

To change the opacity of any region:

 Select the region on the map by clicking on it.
 Click on the drop arrow on the

button.

 Use the slider to adjust opacity.
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Google Maps
Google Maps displays a zoom-able map of the United States to present geo-spatial relationships between
data.
To map addresses, you must have a result set displayed in a search window. Or a data file suitable for import.

Mapping addresses from Search Results
 Select the records you want to map
 Right-click and select Send to ► Mapping ► Google Maps (or drag and drop the
records onto a Map.)
The Map window opens and displays the addresses mapped.

Sending results to an Open Google Map
 Make sure you have a Google map open.
 Select the records you want to map
 Right-click and select Send to ► Open Searches ► Google Maps (or drag and drop the
records onto a Map.)
The open map displays the addresses mapped.
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Google Maps Street View
You can drag the

icon to use street view. You can drop the icon on any street outlined in blue.

The Street View displays.

See http://maps.google.com/help/maps/streetview/learn/using-street-view.html for more details on using
Google Maps street view.
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Google Maps Satellite View
You can toggle between Map view and Satellite view by clicking on the selector in the upper left corner of a
map.
You can tilt the image using the tilt icon

on the lower right.

Once tilted, you can rotate the image using the rotate icon

on the lower right.

Note: These features are not available for all addresses.

Click to select
the view.

Rotate
Tilt
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Google Maps Toolbar
The Google Maps toolbar provides the following functionality:
Open

Allows you to open a saved map. Once opened, you can add map points or draw
regions on it.

Save

Allows you to save the current map.

Print

Allows you to print the current map.

Clear

Clears all ins and drawn objects on the current map.

Import Addresses

Batch import addresses from a data file

Data Layer

Add map points of locations based on Industry SIC codes.

Zoom to Pins

Zoom to the level that displays all pins on a map.

Divide into Quadrants Splits the map into quadrants. . Once divided, right-click to view a list of the
contained locations.
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Drawing Tools in Google Maps
The drawing tools allow you to create regions on a map. This can aid in depicting areas of interest and help
identify addresses or subjects within that region.
For example, you could map the address of a crime scene, draw a circle around it, and map a list of the
addresses of persons of interest. The resulting map would allow you to see at-a-glance which individuals live
within the circle. Of course, the size of the radius depends on the circumstances of your investigation. The
tool affords you the flexibility to define the region you are most interested in and helps you see geo-spatial
relationships between items on your map. There are three types of shapes you can draw: Circle, Rectangle,
and Polygon.
To draw a circle

 In the toolbox, click the Circle

icon.

 Drag the pointer to draw the circle.
To draw a rectangle

 In the toolbox, click the Rectangle

icon.

 Drag the pointer diagonally in the direction you want.
To draw a polygon

 In the toolbox, click the Polygon

icon.

 Drag the pointer diagonally in the direction you want.
 Click to create a corner, then continue dragging the next line.
Fill Color

 Select a region on the map by clicking on it.
 Click the Fill Color icon

.

 Select a color from the palette displayed.
Line Thickness

 Select a region on the map by clicking on it.
 Click the Line Thickness icon

.

 Select a thickness from the list.
Fill Opacity

 Select a region on the map by clicking on it.
 Click the Opacity icon

.

 Adjust the opacity using the slider.
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Line Color

 Select a region on the map by clicking on it.
 Click the Line Color icon

.

 Select a color from the palette displayed.

Resizing a shape

 Select the region on the map by clicking on it.
 Handles are displayed when an object is selected.
 Grab a handle and drag in the direction you want.

Click and drag a handle to
resize
Hover the mouse over a
handle to see size of a shape.
A circle displays the radius in
miles. A polygon or rectangle
displays the area in square
miles.

Viewing Contained Locations

Regions allow you to display a list of addresses contained within it. To see a list of contained locations:

 Select the region on the map by clicking on it.
 Right-click and select Contained Items from the popup menu.
From the resulting list, you can perform actions (such as, Send To) in a similar manner as any result list.

Accurint for Law Enforcement Plus
User’s Guide | 200
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Data Layers
Data Layers allows you to add map points of locations based on Industry SIC codes. For example, you can
add locations of all Elementary schools within the visible area by selecting that industry code and adding the
matching addresses. This feature is not available to all users.
Note:

You should zoom in to a small region before adding addresses. If the number of addresses is
unreasonably large, it could take a long time to add to your map. In addition, it will produce more
data that you probably want.

To add data:

 Press the


button on the toolbar.

The Address Type palette displays.

 Check the boxes for the address type(s) you want to add to the map.
 Press the Add button
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Importing Addresses to a Google Map
The Google Maps function provides the ability to import addresses from a data file to a map. This allows you
to add locations to a map. Combining locations with other map points can reveal patterns that might
otherwise go unnoticed.
To Import Addresses to a Map

 Press the

button on the Google Maps toolbar.

The Mapping Import Wizard displays.

 Press the Next button.

 On the next screen, press the lookup button to select a file.
Files may contain either fixed length fields or separated values (such as .CSV).

 Press the Next button.
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 On the next screen, provide details about the file.
o

Choose either Delimited or Fixed Length.

o

Specify the File Type.

o

If you want to skip rows, specify the number of rows to skip.

o

If Delimited, select the character used to contain text.

o

If the first row contains field labels, check the First Row has column names
box .
A preview of the data displays to assist you.

 Press the Next button.
 On the next screen, provide details about the delimiter. (This screen does not appear with
fixed length field data files.)
Choose Comma, Tab, Semi-colon, or Other. If you select Other, specify the character.


A preview of the data displays to assist you.

Accurint for Law Enforcement Plus
User’s Guide | 203
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

 Press the Next button.
 On the next screen, select the field mapping. This allows you to specify which fields
contain the address data and also include some fields to be used as labels for the map
pins.
In order for locations to be mapped, addresses must be mapped to appropriate the
address fields (Address to address, city to city, etc).
Tip:

You can import locations using Latitude and Longitude instead of addresses.

 Press the Next button.
 The next screen displays while queries are performed and locations are geocoded.
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 Press the Next button.
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 The next screen displays the results of your import, including the number of successes
and failures. This allows you to analyze any failures, fix the data file, and re-import if
important locations did not import properly.

 Press the Finish button.
The Map displays.
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Custom Comprehensive Reports and Comprehensive
Reports
You can generate custom comprehensive reports for people or companies where there is enough data to
support the report.
A

icon next to a name indicates a Possible Criminal Record.

 To run a report, click on the

Custom Comprehensive Report icon.

A Report Preferences window displays, enabling you to select the details you want to
appear in the report. Options that you select to include in a report will be remembered for
the next report that you run.

Data and Photo portions of screens in this manual are intentionally blurred.



Select the report type:
Interactive Web Page, Plain Text Web Page, Microsoft Word Document, or PDF.

 Check the boxes for Basic Options want to include
 Specify Neighbor and Relative options.
 Press the OK button.
Tip:

For reports on persons, holding the mouse cursor over the Supplemental Data Sources field
shows a list of all sources included for this option.

Note: Some data is only available to users with appropriate permissions levels.
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You can also choose to run a Comprehensive Report using the rt-click Menu. The options for a Comprehensive Report
are shown below:
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Dynamic Reporting and Printing
Many of the reports have has dynamic display options to facilitate reading the report results.
Expand / Contract

When displaying a report with this capability, you can expand and collapse sections from within the report by
clicking the appropriate links (+/-) buttons. All sections can be expanded or collapsed by clicking the
Expand/Collapse All buttons, which are available below the subject information.
Print Section
Expand/Collapse

Selection Area

Data portions of screens in this manual are intentionally blurred.
Printing Sections

Print icons
within the report allow you to print only one section. When you place your mouse over the
section of interest or the Print Icon, the section of the report is highlighted so you can easily view what you
can select to print.
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Customizing Reports

Custom Comprehensive Person and Business Reports allow you to customize the section order and display
after the report has been generated using the Report Content area.
From the Report Content area on the left, drag and drop sections to rearrange their order. This allows you to
display the information in order of importance.
You can also choose which sections to include or exclude.
Check the boxes of items you want to show and clear the checkboxes of sections you wish to hide. This
allows you to produce a report that only shows relevant information.

Save settings to a
template to reuse
later. You can save
up to four templates.

Drag and drop to change the display order

The numbers show a count of items in a category.

Check to show; clear to hide
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Report Templates

After you have customized a report, you can save it as a template for future use.

 Customize your report by dragging and dropping items and by checking & clearing
checkboxes.
 Press the Save Current Settings button.

 Provide a name, then press the OK button.
The template is now available for use in future reports by selecting a saved template from the drop-list. The
report displays with the selected template’s settings.
You can save up to four templates.
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Add Notes to a Report

You can add notes to any section by clicking on the
icon beneath any section. This opens a text editor.
You can use the formatting buttons to format the text as you would in any word processor.
Press the Add button to save the note and display it on the report.

Data and Photo portions of screens in this manual are intentionally blurred.

You must print the report to retain your notes. Once you close the report tab, the notes are no longer
available.
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Relavint™ Link Analysis
RelavintTM Link Analysis is an easy-to-use visualization and drawing tool specifically designed for creating link
analysis charts—visual relationships between individuals, addresses, vehicles, corporations, and other items..
This tool enables professionals to:



Save time ordinarily spent manually drawing link charts
Effectively present complex case information to colleagues and superiors in a number of different
views

With Relavint , professionals can use the timesaving features to effectively analyze and display complex
information.
Easily draw connections between people, addresses, vehicles, phone numbers, evidence and more
Quickly create and save “index cards” containing specific data behind each node in a chart
Seamlessly display charts in different visual layouts—circle, hierarchical, and circular hierarchical
display options offer flexibility to clearly organize and display entities and their relationships
 Add photos and images into link charts
 Add new data node types using the Relavint Icon library
 Perform “Shortest link” analysis to quickly identify the most direct connections between entities
 Perform Advanced Searches for any item contained within a link chart
 Easily hide or unhide nodes on a chart
 Open, edit, save, and print Relavint charts (*.rel files) created within Relavint, Accurint® for Law
Enforcement and Accurint for Law Enforcement Plus
 Optionally, save the charts to one of several formats, including CSV files.
 Send encrypted charts via email.
Charts can be opened with Accurint for Law Enforcement Plus or Relavint Desktop
You can now easily share Relavint link charts with colleagues and superiors that do not have an Accurint
account. Anyone in your organization can download, install, and use Relavint Desktop—free of charge.
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The Relavint Workspace
Search
Node View
Legend

Properties

The Search palette.
The Node View palette lists objects on your chart. You can also hide or unhide objects by
clicking on the green checkmark (to hide) or the red x (to redisplay).
The Legend tab on the left side contains meanings for each link color.

View Properties for the selected object either by selecting the Properties tab on the left hand
side or by right-clicking on a node and selecting Properties from the popup menu. These
properties can be edited or deleted. New Properties can be added manually.
You can also change the label or color of a line by rt-clicking on a line and selecting
Properties.

Rt-click on the Palette
to open the Palette
Manager. This allows
you to sort Palette
items.

Palette

The palette on the right side of the Relavint screen displays the icons for each object type and
allows you to select whether you want to see that node type in your graph. Drag-and-drop
items from this palette to the chart to add new nodes.
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Palette Manager
Use the Palette Manager to rearrange items in your palette.
Use these buttons to
Add or Remove icons
from the palette.

Use these buttons to
Move icons Up or
Down in the list

Changes made in the Palette Manager affect all Relavint windows.

Work Space Functions


Select a single node for action with a left-CLICK



Use CTRL+CLICK to select multiple nodes.



Use SHIFT+SELECT (hold shift and left click down and draw a box with mouse) to select objects in
an area.



RIGHT-CLICK on an empty area of the Workspace for the following options:

Pin Selected
Unpin Selected
Delete Selected
Merge Selected

Pin the object to its location and prevents movement by the positioning tools.
Remove the pin from an object to allow its movement by the positioning tools.
Remove the selected object from the chart
Merge selected objects into a single container node.

Hide Disconnected
Hide nodes that have no relationship to other nodes on the graph.
Hide Singletons Hide nodes with only one relationship to other nodes on the graph.
Edge Labels
Images
Overview
View
Relavint



Show/hide text labels on the links between nodes.
Show/hide images associated with objects.
Show/hide an overview window of the full chart as a navigational aid.
Show/hide workspace palettes.
Show/hide types of workspace objects.

Use the Save or Save As function to save a graph or to save as one of the many supported file types:
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Relavint Graphs can be saved as a Relavint (.REL) document, an Analyst’s Notebook XML
document, an image (.JPG, .PNG, .GIF, .TIFF, .RLE, or .BMP), or a Comma Separated Value (CSV)
file.
Use the Save as type droplist to select the type.
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Viewer and Node Toolbar Controls
New

Open a new (blank) graph.

Open

Open a previously-saved graph.

Import

Import a data file into a graph

Save

Save a graph to a file.

Print

Print the current graph or index. Select from droplist.

Snapshot

Saves a snapshot of the current chart in your Query History

Timeline

Opens a Timeline Chart

Cut

Cut the selected items (to the Windows Clipboard).

Copy

Copy the selected items (to the Windows Clipboard).

Paste

Paste the cut or copied items to the current chart.

Clear

Delete all objects on chart.

Find

Open the Find panel below the graph.

Query
Selected

Run a query on the selected node and expand the automatically viewable
nodes.

Query All

Run a query on all nodes and expand the automatically viewable nodes.

Zoom Out

Decrease the Zoom level of the chart.

Zoom Level

Use the drop list to select the Zoom level of the chart.

Zoom In

Increase the Zoom level (level of magnification) of the chart.

Fit to Page

Adjust the Zoom level to fit the available screen space.

Zoom
Selected

Zoom a selected area of the graph.

Rotate Left

Rotate the graph to the left.

Rotate Right

Rotate the graph to the right.
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Center Graph

Center the graph in the available screen space.

Stop Layout

Stop any repositioning activity in progress.

Spring

Reposition nodes in the selected layout.

Circle

Reposition graph into a circular layout.

Force
Directed

Reposition graph into a force directed layout.

Hierarchical

Reposition graph into a hierarchical layout.

Circular
Hierarchical

Reposition graph into a circular hierarchical layout.

Force
Directed 2

Reposition graph into a force directed layout.

Clustered

Reposition graph into a clustered layout.

Standard

Change cursor function to standard pointer.

Grab Tool

Change cursor function to hand tool to grab and move nodes

Link Tool

Change cursor function to line drawing tool to manually draw links
between nodes.
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Node View
The Node View displays a list of items (nodes) on your chart (people, vehicles, addresses, corporations, and
telephones, etc).


To the left of each item, is either an green checkmark or red X. Items with a green checkmark are
visible. Items with a red X are hidden. Click on the icon to hide or unhide an item on the chart.



Click on a column header to sort by that column. Click again to sort in the opposite order
(ascending/descending).



Expand or contract merged nodes by clicking on the + or – icon on the left.

Customize Columns in Node View

 Rt-click on the column header area, then select Column Chooser.


The Customization dialog displays.

 Drag items (columns) from the Customization list to a spot on the column header, then
drop to add.
 Drag column headers from the header area to the Customization list, then drop to remove.
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Find and Advanced Find
Press the binoculars button on the main toolbar (or Ctrl+F) to open the search bar.

Search all nodes for a simple string, or use advanced find to search a particular node type or in a certain
property field. Select Search Properties to search all properties, or deselect to search node labels only.
If the value appears in multiple nodes, press Find Next to move to the next object that meets the criteria.
Advanced Find provides additional options. Press the Advanced Find button on the Find toolbar (or
ctrl+shift+F).
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Shortest Link Analysis
In a complex graph, it can be difficult to find the shortest link between two entities. Relavint Desktop allows
you to easily find the shortest path between any two nodes using Shortest Link Analysis.

 Click on the node to be the starting point. This selects the node.
 Hover the mouse cursor over the node to use as the ending point.
The link lines turn red along the shortest path as shown below:
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Adding Manual Nodes and Links
Add nodes to your chart by dragging and dropping a node from the Palette on the right-hand side onto the
graph.
The labels on these nodes display in a different color to distinguish them from automatic or system-generated
nodes.
Like other objects, you can change the label or add manual properties.
You can also draw manual links between system-generated and/or manual nodes, and these also display in a
distinct color.
Use the Line Draw tool, by pressing the
between two nodes.

button on the toolbar, then using the mouse to draw a link
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Merging Nodes
You can merge nodes on your chart to organize and simplify the view. Once merged, you can rename the
container node.
For example, if a subject has addresses in both Florida and Ohio, but you are only interested in Florida, you
could encapsulate all the Ohio Addresses into a merged node.
To merge nodes from the chart area:

 Use CTRL+CLICK to select multiple nodes one by one.
 or
 Use SHIFT+SELECT (hold shift and left click down and draw a box with mouse) to select
objects in an area.



RT-CLICK

on one of the nodes and select Merge from the pop-up menu.

 or


RT-CLICK

on an empty area and select Merge Selected from the pop-up menu.

To merge nodes from the Node List:

 Use CTRL+CLICK to select multiple nodes one by one.
 or
 Use SHIFT+CLICK to select contiguous rows.


RT-CLICK

and select Merge Selected from the pop-up menu.

The items merge and a new row displays.
Expand a Merged
Node by clicking
on the + to view its
contents.

Tip:
For large charts, the node view provides the
easiest means of locating and selecting the
nodes you want to merge. You can sort by any
column header by clicking on the header, then
select the nodes to merge.

 Rename the node (edit the label) to better identify it.
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Adding Images
You can associate up to seven additional images to any object on a chart.
To add an image:

 Rt-click an object, and select Properties from the pop-up menu.
 Select the Images tab.

Photo portions of screens in this manual are intentionally obscured.

 Select an image region.
 Press the Browse button.
 Select the image file from the Windows file dialog, then press the OK button.
 If you want to add more images, press the Apply button, then select another image
region, and follow the previous two steps.
 When you have added all desired images, press the OK button.
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Resizing Images
You can resize images attached to items on your chart. This allies to both images you add manually or those
returned from a query
To resize an image:

 Click on an image.


The “handles” for the image appear as shown below.

 Drag any handle in the direction of the desired resize.

Photo portions of screens in this manual are intentionally obscured.

 To maintain the proportion of the original image (aspect ratio) shift+drag one of the
handles.
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Importing Data
You can import data files into a new or existing graph. Data files can be in one of the following formats:


Microsoft Excel Spreadsheets (.xls, .xlw)



Comma delimited files (.csv)



Tab delimited files (.tsv)



Text Files – where a separator is included. (.txt)

The Import Wizard will detect and use the separator it finds.

Import the data file

To begin the import:

 Press the

on the toolbar or select File ► Import Data… from the menu.

 Press the Open File button.

 Select your file from the file dialog, then press the Open button.


The first few rows display.
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 If your data file has column headers in the first row, check the First row contains
column headers checkbox.

 If you want links automatically created from columns in the same row, Check the Link
the imported nodes checkbox.


In the example above, this will link the addresses in a row to the names in a row.

Map fields

This portion of the process allows you to map or “match up” the fields in your data file to the properties of a
node. For example, your data file may have a column named Surname which you would map to the Last Name
property of a Person node.
To map fields:

 Select the object type from the palette on the left.


This displays the list of properties for that object type.

 Map each property that has a match with its matching field by selecting from the droplist.

 Repeat for each property that has a match.
Accurint for Law Enforcement Plus
User’s Guide | 227
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

 If you are linking imported nodes and this object type is the parent type, check the Use
this node as parent when linking checkbox.
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 Press the Label Fields button.

 Check the boxes next to the fields to use as Node labels, then press the OK button.
 Select the next object type.
 In the example above, the next object type is Address.
 Map the fields for this object.
 If linking, select the type of link from the Link As drop-list.

 Repeat the steps above for each remaining object type.
 Press the Import button.
 The data is imported and nodes now display on the graph.
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Printing
There are two printing options: Print Graph and Print Node List.
A graph can be printed on a single page, or in a larger format tiled across several pages. When you print tiled
pages, you can trim and paste on a display board for a presentation or other collaborative purposes.
A printed index provides you with a list of objects on your chart.
Print Graph

To print a graph:

 Press the

on the toolbar.

 Select Print Graph from the drop-down menu.
The Print Preview window displays.

Use the slider to
adjust the
magnification of the
chart.

 Use the slider to adjust the magnification of the chart.
 Press the

button to print.

Print Node List

To print an Node List

 Press the

on the toolbar.

 Select Print Node List drop-down menu.
The Print Preview window displays.

 Press the

button to print.

Note: Comments added to Node Properties are printed on the Node List.
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Emailing Graphs
You can send charts via email directly from the application. Charts sent in this manner are automatically
encrypted using the password you supply as the encryption key.
We encourage you to follow these steps to ensure emailed graphs (which may contain sensitive information)
are encrypted
To send a graph by Email:

 Select File ► Send by Email
 You are prompted for a password. This encrypts the compressed (.ZIP) file.
 Provide a password and confirm it, then press the OK button.
An email form (from your default email application) opens. This email message contains
the encrypted ZIP file which holds the Relavint chart inside.

 Complete the email form (recipients, subject, body text, etc.) then send the email

Remember to provide the recipient the password for the encrypted ZIP file, but
you should not include it in the same email message.

Accurint for Law Enforcement Plus
User’s Guide | 231
This document contains Confidential and Proprietary Information of LexisNexis Risk Solutions
and shall not be used for purposes other than as intended and disclosed.

Timeline Chart
A timeline chart allows you to create a visual representation of events and durations of events. If you have a
Relavint chart with a person’s address history, you can import that data to visualize the chronological history
of a person’s residences.
You can also add events and durations manually.
Use the mouse to drag items to optimize their positions.
In the example below, you can easily visualize the subject’s current and previous domiciles and a Post Office
Box that he had which was partially concurrent with the last residence.

Use these buttons
to manually add
Topics, Events, or
Durations to the
Timeline.

Adjust the sliders
to increase or
decrease the time
range to view.

To import addresses from an active graph:

 From an active graph, press the

(Timeline) button.

 The Timeline window opens.
 Press the

on the toolbar.

 The Address data from the current graph is imported into the Timeline.
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Timeline Toolbar Controls

New

Open a new (blank) Timeline chart.

Open

Open a previously-saved Timeline chart.

Save

Save a Timeline chart to a file.

Print

Print the current Timeline chart.

Import

Import Address data from current graph into a Timeline chart.

Add Topic

Add a Topic line to the Timeline chart

Add Event

Add an Event to the Timeline chart

Add
Duration

Add a Duration to the Timeline chart

Properties

Edit Properties of the Timeline chart

Link

Add a manual link from a node to a Topic
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Node Properties
You can edit the properties of an Event, Duration, or Topic by double-clicking on it or by selecting it and
pressing the

Properties button.

Topic Properties

Event Properties

Click here to
select a new
icon.

Duration Properties
Adjust the Date by
clicking and
selecting new date
from the calendar.
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Alerts and Notifications
Sex Offender Alerts
This feature allows you to monitor a geographic region and receive notification when a registered sex
offender has moved into that area. Alerts display in Alerts and Notifications window, and if desired, can also
be sent by email.
The easy-to-use wizard walks you through the steps to create an alert. Create as many alerts as you need and
stay informed about movements into regions of interest automatically.

The number of subscriptions allowed is based on your account subscription.
Consult your system administrator for details.

An alert is based on a single ZIP code. When you specify geographical criteria in the wizard, it selects the appropriate ZIP
code(s) and creates a separate alert for each ZIP. In other words, you can specify to monitor an entire city, but the end
result is a set of individual alerts—one for each ZIP code in that city.

Creating a Sex Offender Alert

 From the Administration
the list.

toolbar Menu, select Alerts and Notifications to open

The Alerts and Notifications window displays.

 Press the New button, then select Sex Offender from the menu.
The wizard’s welcome screen displays.

 Press the Next button.
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 Select the Alert Type:
o

City & State

o

Zip Code & Radius

o

Zip code

 Specify the area:
o

For City & State, specify the City and State

o

For radius around a ZIP code, specify the ZIP and the radius (between 1 and
5 miles)

o

For Single ZIP code, specify the ZIP code

 Press the Next button.
The wizard displays a list of ZIP codes within the area you specified. If you selected a
single ZIP code type, skip the following step

 Confirm the list of ZIP codes. Clear the check box for any ZIP codes you do not want
included or uncheck Select All to select Zips individually.

 Press the Next button.
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The Alert Schedule settings window displays.
 Provide a description. This displays in the list.

Tip: You can use <Zip Code> in the description and email subject to allow variable
replacement when creating an alert for multiple Zip codes.

 Select a frequency from the drop-list. You can choose Monthly or Biweekly.
 Specify the time of day in local time.
 Specify the Day of the Month (for Monthly) or Day of the Week (for biweekly)
 If you want the notification to be sent by email, check the Send Email Alert checkbox,
then, provide the email address, and the Subject line to be used in the email.
Tip: You can specify more than one email address by separating each with a comma,
semi-colon, or space.

 If you want a notification to be sent by email when no new results are found, check the
Alert me even if there are no new results checkbox.
 Press the Next button.
The Confirmation window displays.
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 Examine the list displayed, scrolling if necessary. If it is correct, then press the Next
button. If you want to change anything, press the Back button.
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 The Processing Alerts window displays to show the progress of your alerts as they are
created on the Notification Server.

 When the process is complete, press the Finish button.
The Alert now appears in the Alerts and Notifications list. If you have enabled sending
the alert by email, a confirmation email will be sent.
When you sign in to the application, you are notified if you have any new (unread) alerts.
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Person Alerts
Person Alerts automatically notifies you of changes in the data about an individual without having to
repeatedly run the same search. You can create a Person Alert using the Alert Wizard or from any search that
results in an individual person.
In addition, you can specify any of the following items to monitor:







changes to a subject's name
changes to a subject's address
changes to a subject's phone number
changes to a subject's death records
changes to a subject's criminal record status
changes to a subject's sex offender status

This allows you to monitor a person and receive notification when information of interest changes.
Person alerts are run once a week and display in Alerts and Notifications window, and if desired, can also be
sent by email.
The easy-to-use wizard walks you through the steps to create a person alert. Create as many alerts as you need
and stay informed about individuals of interest automatically.
Creating a Person Alert

 From the Administration Toolbar Menu, select Alerts and Notifications to open the list.
The Alerts and Notifications window displays.

 Press the New button, then select Person Alert from the menu.
The wizard’s welcome screen displays.
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 Press the Next button.
 Select the method to use, then press the Next button.

To import a file to use for alerts, follow the steps used in Batch Person Search.
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 Provide your search criteria, then press the Next button.

 Select the person(s) from the results using the check box next to a row. An Alert will be
created for each unique individual in the set of records selected. If you want to try
another search or change search criteria, press the Back button.

Data and Photo portions of screens in this manual are intentionally blurred.

 Press the Next button.
 If the selected records contain duplicates, you are informed of the number of unique
individuals in the set of selected records. An Alert will be created for each of these
individuals.
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Data and Photo portions of screens in this manual are intentionally blurred.

 Press the Next button.
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The Alert Schedule settings window displays.

 Check the box(es) next to criteria of interest. You will be notified if data changes in a
selected section.
 Choose a Duration or specify an End Date.
 Provide a description. This displays in the list.
Tip: You can use <Name> in the Description and email Subject to allow variable
replacement when creating an alert for multiple individuals. If you leave the default
<Name> value in the Description & Subject fields, the name of the individual will
populate automatically.

 If you want the notification to be sent by email, check the Send Email Alert checkbox,
then, provide the email address, and the Subject line to be used in the email.
Tip: You can specify more than one email address by separating each with a comma,
semi-colon, or space.

 If you want a notification to be sent by email when no new results are found, check the
Alert me even if there are no new results checkbox.
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 Press the Next button.
The Confirmation window displays.

 Examine the list displayed, scrolling if necessary. If it is correct, then press the Next
button. If you want to change anything, press the Back button.
The Processing Alerts window displays to show the progress of your alerts as they are
created on the Notification Server.

 When the process is complete, press the Finish button.
The Alert now appears in the Alerts and Notifications list.
When you sign in to the application, you are notified if you have any new (unread) alerts.
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Using the Send To… function to Create a Person Alert

The Send To… function supports sending results to the Alerts Wizard. The result must contain a unique
individual.

 Conduct a search.
 Identify the person of interest in your result list.

 Select the person of interest, then rt-click.
 Select Send To ► People ► Alerts and Notifications.
 Complete the wizard to save your alert. (See Creating a Person Alert on page 240).
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Alerts and Notifications
This window allows you to view and manage your Alerts and Notifications.
Creates a new
Alert

Modifies the
selected Alert

Removes the
selected Alert

Red icon
indicates an
unread Alert

Rt-click on any result
row to use the “Send
To…” function or to
run a Custom
Comprehensive
Report

Displays the Date and
Time the alert was
generated (GMT)
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Public Safety Briefing Room
The
button on the toolbar directs you to the Public Safety Briefing Room, a new way to share thought
leadership with public safety professionals.
The Public Safety Briefing Room offers insightful articles for public safety executives, investigators and
analysts at the federal, state, and local level. Articles on this site offer a variety of viewpoints, from integrating
analysis into a major event planning, to the importance of maximizing handheld device usage at a crime scene
investigation.
LexisNexis will leverage our vast experience and network of public safety professionals to provide you with
valuable information to help you stay safe, make informed policy decisions, and maximize technology
purchases.
The Public Safety Briefing Room can also be accessed at www.lexisnexis.com/publicsafety.
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